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Καλώς ορίσατε! 
 

 

 

 

Σας ευχαριστούµε που επιλέξατε το ABBYY FineReader! 

Το ABBYY FineReader είναι µια εφαρµογή Οπτικής Αναγνώρισης Χαρακτήρων 
(OCR), η οποία δίνει τη δυνατότητα για µετατροπή έντυπων εγγράφων και αρχείων 
PDF σε επεξεργάσιµα αρχεία κειµένου µε ταυτόχρονη διατήρηση της µορφοποίησής 
τους. Το πρόγραµµα αυτό επιτρέπει στους χρήστες να δηµιουργούν ηλεκτρονικό 
αντίγραφο από οποιοδήποτε έγγραφο σε µερικά λεπτά χωρίς να χρειαστεί να το 
δακτυλογραφήσουν. Εκτός από την εκπληκτική ευκολία στη χρήση, το ABBYY 
FineReader παρέχει επίσης τις πλέον σύγχρονες ρυθµίσεις και επιλογές, προκειµένου 
να καλύψει τους επαγγελµατίες χρήστες, που επιθυµούν να προσαρµόσουν την 
λειτουργία του στις δικές τους ανάγκες. 



 

Το Εγχειρίδιο Χρήσης 

Το εγχειρίδιο χρήσης, το οποίο έχετε στα χέρια σας, θα σας βοηθήσει στην κατανόηση 
των βασικών λειτουργιών του ABBYY FineReader. Κάθε κεφάλαιο ξεκινά µε µια 
σύντοµη περιγραφή και µια συνοπτική αναφορά στα περιεχόµενά του.  

Ηλεκτρονική Βοήθεια του προγράµµατος 

Η ηλεκτρονική βοήθεια που περιλαµβάνει το FineReader, παρέχει τόσο βασικές 
πληροφορίες, όσο και προχωρηµένες τεχνικές που αφορούν στα χαρακτηριστικά, στις 
ρυθµίσεις αλλά και στα παράθυρα διαλόγων του FineReader. Η ηλεκτρονική βοήθεια 
διατίθεται σε µορφή HTML και έχει σχεδιαστεί έτσι, ώστε να επιτρέπει τη γρήγορη και 
εύκολη πρόσβαση στις πληροφορίες που θέλετε. 

Το Αρχείο �Readme� 

Το αρχείο �Readme� περιέχει πληροφορίες της τελευταίας στιγµής σχετικά µε το 
πρόγραµµα. 

Τεχνική Υποστήριξη 

Σε περίπτωση που έχετε απορίες σχετικά µε τη χρήση του FineReader, παρακαλούµε 
θερµά να συµβουλευτείτε αρχικώς την τεκµηρίωση που έχετε στη διάθεσή σας (το 
Εγχειρίδιο Χρήσης και το Αρχείο Βοήθειας της εφαρµογής), προτού απευθυνθείτε στην 
υπηρεσία τεχνικής υποστήριξης της εταιρείας µας. Μπορείτε επίσης να συνδεθείτε µε 
την τοποθεσία www.abbyy.com για να βρείτε απαντήσεις σε συνήθη ερωτήµατα 
τεχνικής φύσεως σχετικά µε την εφαρµογή. Εκεί είναι πολύ πιθανό να αντιµετωπισθεί 
το πρόβληµά σας. 

Εάν, παρ' όλα αυτά, δεν καταφέρετε να βρείτε την απάντηση που θέλετε, στείλτε e-mail 
στη διεύθυνση support@abbyy.com. Για να µπορέσει το εξειδικευµένο ανθρώπινο 
δυναµικό του τµήµατος τεχνικής υποστήριξης να σας δώσει µια ολοκληρωµένη 
απάντηση, θα χρειαστεί τις ακόλουθες πληροφορίες: 

! Το serial number του FineReader σας 

! Το µοντέλο του σαρωτή που χρησιµοποιείτε 

! Μια γενική περιγραφή του προβλήµατός σας και το πλήρες κείµενο του 
µηνύµατος λάθους (εφόσον εµφανίστηκε κάποιο µήνυµα λάθους). 

! Την έκδοση του λειτουργικού σας συστήµατος 

! Οποιαδήποτε άλλη πληροφορία πιστεύετε πως θα ήταν χρήσιµη για την 
κατανόηση του προβλήµατος. 

Σηµείωση: Μπορείτε να βρείτε αυτόµατα ορισµένες πληροφορίες, κάνοντας κλικ στο 
κουµπί µε την ένδειξη System Info στο παράθυρο διαλόγου About� (Μενού Help > 
About). 
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Κεφάλαιο 1  
Εγκατάσταση και Εκκίνηση του ABBYY 
FineReader 

Το κεφάλαιο αυτό παρέχει λεπτοµερείς οδηγίες για την διαδικασία εγκατάστασης του 
ABBYY FineReader, δίνει σύντοµη περιγραφή των ελάχιστων απαιτήσεων του 
συστήµατος και παρέχει οδηγίες για την εγκατάσταση σε σταθµούς εργασίας 
(workstations) και δίκτυα (networks). Το ΑΒΒΥΥ FineReader 7.0 περιλαµβάνει ένα 
ειδικό πρόγραµµα αυτόµατης εγκατάστασης. Για να είστε σίγουροι για την σωστή 
εγκατάσταση, χρησιµοποιείτε πάντοτε το CD-ROM του ABBYY FineReader. 

Περιεχόµενα κεφαλαίου 

! Ελάχιστες απαιτήσεις σε λογισµικό (software) και υλικό (hardware) 

! Εγκατάσταση του ABBYY FineReader 

! Εγκατάσταση σε εξυπηρετητή δικτύου και σε σταθµό εργασίας δικτύου 

! Εκκίνηση του ABBYY FineReader 

! Ενεργοποίηση του ABBYY FineReader 
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Απαιτήσεις σε Λογισµικό και Υλικό 

Για την εκτέλεση του ABBYY FineReader βεβαιωθείτε πως ο 
υπολογιστής σας καλύπτει τις ακόλουθες ελάχιστες απαιτήσεις 
συστήµατος: 

1. Υπολογιστής µε επεξεργαστή Intel® Pentium®/ Celeron®/ Xeon�/ AMD K6/ 
Athlon�/ DURON� ή συµβατός. Η ταχύτητα του επεξεργαστή πρέπει να είναι 
200MHz ή ανώτερη. 

2. Microsoft® Windows® XP, Microsoft® Windows® 2000, Windows® NT® 4.0 µε 
Service Pack 6 ή νεώτερο, Windows® Me/98 (για να εργαστείτε µε τους 
διαλόγους της εφαρµογής στην τοπική γλώσσα �όπου υποστηρίζεται- θα πρέπει 
να είναι εγκατεστηµένη η υποστήριξη της γλώσσας αυτής στο λειτουργικό). 

3. 64MB (Windows XP/2000/NT 4.0), 32MB (Windows Me/98), µε επιπλέον 16MB 
µνήµη RAM για κάθε πρόσθετο επεξεργαστή (σε περίπτωση συστήµατος µε 
πολλούς επεξεργαστές). 

4. 150 MB διαθέσιµου χώρου στο σκληρό δίσκο για την τυπική εγκατάσταση. 

5. 70MB διαθέσιµου χώρου στο σκληρό δίσκο για τη λειτουργία του προγράµµατος. 

6. Σαρωτής, ψηφιακή κάµερα ή φαξ modem, συµβατά µε το πρωτόκολλο TWAIN. 

7. Κάρτα γραφικών και οθόνη µε ανάλυση τουλάχιστον 800 x 600. 

8. Πληκτρολόγιο και ποντίκι ή άλλη συµβατή συσκευή κατάδειξης. 

Σηµείωση: Ο Microsoft Internet Explorer 4.0 ή νεότερος είναι απαραίτητος για την 
αναζήτηση στις αναγνωρισµένες σελίδες καθώς και για την ανάγνωση νέων από το 
ABBYY Community new channel (Ισχύει µόνο για το ABBYY FineReader 
Professional Edition)  

Εγκατάσταση του ABBYY FineReader 

Εγκατάσταση του ABBYY FineReader 

Το πρόγραµµα εγκατάστασης θα σας καθοδηγήσει στην διαδικασία εγκατάστασης του 
ABBYY FineReader. Θα σας συνιστούσαµε να κλείσετε όλα τα προγράµµατα, προτού 
εκτελέσετε την εγκατάσταση του ABBYY FineReader. 

Για να εγκαταστήσετε το  ABBYY FineReader: 

1. Βάλτε το CD-ROM του ABBYY FineReader στη µονάδα CD-ROM.  
Το πρόγραµµα της εγκατάστασης θα ξεκινήσει αυτόµατα. 

2. Ακολουθείστε τις οδηγίες εγκατάστασης. 

Αν το πρόγραµµα εγκατάστασης δεν ξεκινήσει αυτόµατα: 

1. Κάντε κλικ στο κουµπί Έναρξη (Start) και επιλέξτε Ρυθµίσεις>Πίνακας 
Ελέγχου (Settings>Control Panel). 
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2. Κάντε διπλό κλικ στο εικονίδιο, Προσθαφαίρεση Προγραµµάτων 
(Add>Remove Programs) 

3. Επιλέξτε την καρτέλα Εγκατάσταση/Κατάργηση (Install/Uninstall) και κάντε 
κλικ στο εικονίδιο Εγκατάσταση (Install) 

4. Ακολουθείστε τις οδηγίες εγκατάστασης 

Επιλογές εγκατάστασης 

Κατά την εγκατάσταση θα σας ζητηθεί να επιλέξετε έναν από τους ακόλουθους τύπους 
εγκατάστασης: 

! Typical installation (συνιστάται) � Τυπική εγκατάσταση. Εγκαθιστά όλα τα 
στοιχεία της εφαρµογής, συµπεριλαµβανοµένων όλων των γλωσσών αναγνώρισης, 
καθώς και µία µόνο γλώσσα για τα µενού και τους διαλόγους της εφαρµογής, την 
οποία θα επιλέξετε κατά την εγκατάσταση. 

! Custom installation � Προσαρµοσµένη εγκατάσταση. Επιτρέπει την επιλογή των 
στοιχείων του ABBYY FineReader που θα εγκατασταθούν, συµπεριλαµβανοµένων 
των διαθέσιµων γλωσσών αναγνώρισης και των διαθέσιµων γλωσσών για τα µενού 
και τους διαλόγους της εφαρµογής. 

Αν το πρόγραµµα εµφανίσει κάποιο µήνυµα λάθους, διαβάστε το αρχείο Readme.htm, 
το οποίο θα βρείτε στον κατάλογο readme στο CD του ABBYY FineReader. 

Σηµείωση: Εάν θέλετε να χρησιµοποιήσετε τα λεξικά (user dictionaries) ή τα 
υποδείγµατα γραµµατοσειρών (user patterns) από προηγούµενη έκδοση, τότε δε 
χρειάζεται να την απεγκαταστήσετε πριν εγκαταστήσετε τη νέα έκδοση. Αφού 
εγκαταστήσετε τη νέα έκδοση, τα υποδείγµατα γραµµατοσειρών και τα λεξικά της 
προηγούµενης έκδοσης θα είναι πλέον διαθέσιµα για να χρησιµοποιηθούν στη νέα. 

Εγκατάσταση σε Εξυπηρετητή ∆ικτύου και σε Σταθµό 
Εργασίας ∆ικτύου 

  

Η εγκατάσταση του FineReader 7.0 Corporate Edition σε εξυπηρετητή δικτύου 
(network server) µπορεί να γίνει µόνο από το διαχειριστή του συστήµατος (system 
administrator). Η εγκατάσταση συντελείται σε δύο στάδια. Πρώτα το πρόγραµµα 
εγκαθίσταται στον εξυπηρετητή δικτύου (server). Από εκεί το πρόγραµµα µπορεί να 
εγκατασταθεί σε σταθµούς εργασίας του δικτύου (workstations) µε µια από τις 
ακόλουθες τέσσερις µεθόδους: 

! χρησιµοποιώντας το Active Directory. 

! χρησιµοποιώντας το Microsoft System Management Service (SMS). 

! από την γραµµή εντολών. 

! µε την κλασική διαδικασία εγκατάστασης µε την επέµβαση του χρήστη. 

Για να εγκαταστήσετε το ABBYY FineReader 7.0 Corporate Edition σε 
εξυπηρετητή δικτύου: 

1. Βάλτε το CD-ROM του ABBYY FineReader στη µονάδα CD-ROM. 

2. Τρέξτε το αρχείο setup.exe από το CD-ROM του FineReader από την 
γραµµή εντολών µε τον διακόπτη /a 
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Το Εγχειρίδιο ∆ιαχειριστή Συστηµάτων (System Administrator�s Guide), το οποίο 
µπορείτε να βρείτε στον σχετικό κατάλογο του εξυπηρετητή, όπου έχει εγκατασταθεί το 
FineReader, περιλαµβάνει πρόσθετες πληροφορίες σχετικά µε την εγκατάσταση του 
FineReader σε σταθµούς εργασίας, τη χρήση του ∆ιαχειριστή Αδειών (License 
Manager) καθώς και την χρήση της εφαρµογής σε περιβάλλον τοπικού δικτύου. 

Εκκίνηση του ABBYY FineReader 

Για την εκκίνηση του ABBYY FineReader: 

! Στο µενού Start>Programs, επιλέξτε το στοιχείο ABBYY FineReader 7.0 
Professional (ή Corporate Edition). 

Σηµείωση: Πριν την εκκίνηση του FineReader, ελέγξτε αν ο σαρωτής σας είναι 
συνδεδεµένος µε τον υπολογιστή, καθώς και αν είναι αναµµένος. Εάν ο σαρωτής σας 
δεν έχει συνδεθεί ακόµα, παρακαλούµε συµβουλευτείτε το εγχειρίδιο χρήσης που τον 
συνοδεύει για περαιτέρω πληροφορίες που αφορούν στην εγκατάστασή του. Εάν δεν 
έχετε κάποιο σαρωτή, µπορείτε να χρησιµοποιήσετε το FineReader, αναγνωρίζοντας 
αρχεία εικόνων σας. Στον κατάλογο ABBYY FineReader\Demo του CD-ROM, 
µπορείτε δείτε δείγµατα αρχείων εικόνων). 

Ενεργοποίηση του ABBYY FineReader 
Η πειρατεία του λογισµικού θίγει τους κατασκευαστές λογισµικού και τους τελικούς 
χρήστες -η χρησιµοποίηση αντιγράφων των προϊόντων δεν είναι ποτέ ασφαλής. Η 
χρήση νόµιµου λογισµικού εξασφαλίζει ότι τρίτες εταιρείες δεν έχουν επιφέρει 
επιζήµιες αλλαγές στον κώδικα. Η ΑBBYY καταβάλλει κάθε προσπάθεια να 
προστατέψει τα πνευµατικά της  δικαιώµατα και την ασφάλεια των πελατών της µέσα 
από µια σειρά µέτρων. 

Το ABBYY FineReader 7.0 έχει ενσωµατωµένη µια εξειδικευµένη τεχνολογία 
ενεργοποίησης, µε την οποία αποτρέπεται η παράνοµη αντιγραφή και διάθεση του 
προγράµµατος. Αυτή η τεχνολογία εµποδίζει τη χρήση των προϊόντων της ABBYY από 
εκείνους που δεν έχουν συµφωνητικό άδειας χρήσης µε την ABBYY. 

Ένα το συµφωνητικό άδειας χρήσης επιτρέπει την εγκατάσταση σε έναν υπολογιστή. Η 
εγκατάσταση του προγράµµατος σε πρόσθετους υπολογιστές παραβιάζει το 
συµφωνητικό άδειας χρήσης καθώς και τους διεθνείς κανονισµούς προστασίας των 
πνευµατικών δικαιωµάτων. Η τεχνολογία της ενεργοποίησης ελέγχει την αντιγραφή του 
προγράµµατος και εµποδίζει την εγκατάσταση ενός αντιγράφου σε πολλούς σταθµούς 
εργασίας. Ταυτόχρονα επιτρέπει στο πρόγραµµα να ξαναεγκατασταθεί όσες φορές είναι 
απαραίτητο σε έναν υπολογιστή που έχει συµφωνητικό. 

Ανάλογα µε την έκδοση του προϊόντος και την περιοχή διανοµής του, η λειτουργία του 
λογισµικού µπορεί να περιορίζεται ως εξής: 

! Το πρόγραµµα δεν αποθηκεύει ή εκτυπώνει αναγνωρισµένα κείµενα σε 
Κυριλλικούς χαρακτήρες (ΑBBYY FineReader 7.0 Professional Edition). 

! Το πρόγραµµα δεν αποθηκεύει ή εκτυπώνει αναγνωρισµένα κείµενα σε καµία 
γλώσσα. (ΑBBYY FineReader 7.0 Professional Edition) 

! Το πρόγραµµα δεν λειτουργεί χωρίς την ενεργοποίηση. (ΑBBYY FineReader 7.0 
Corporate Edition). 
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Οδηγίες Ενεργοποίησης 
Ο ενσωµατωµένος βοηθός ενεργοποίησης (Activation Wizard) θα ενεργοποιήσει το 
πρόγραµµα γρήγορα και αποτελεσµατικά. Το φιλικό παράθυρο διαλόγου συγκεντρώνει 
και στέλνει όλες τις απαραίτητες πληροφορίες κατευθείαν στην ABBYY. Τον βοηθό 
ενεργοποίησης τον χρησιµοποιήσετε επίσης για να εισάγετε τον Κωδικό 
Ενεργοποίησης (Activation Code) �για τη έκδοση Professional-  ή στο Αρχείο 
Ενεργοποίησης (Activation File) �για την έκδοση Corporate- που θα λάβετε από την 
ABBYY κατά τη διάρκεια της ενεργοποίησης. 

Ο βοηθός θα παράγει έναν κωδικό (ονοµαζόµενο Installation ID), που περιέχει όλες τις 
απαραίτητες πληροφορίες συµπεριλαµβανοµένων των παραµέτρων του συστήµατος και 
πληροφοριών του προγράµµατος. Ο κωδικός αυτός δεν περιλαµβάνει προσωπικές 
πληροφορίες για το χρήστη ή το σύστηµα και δεν µπορεί να χρησιµοποιηθεί για να 
εντοπιστεί ο χρήστης. 

Μπορείτε να διαλέξετε µία από τους παρακάτω τρεις µεθόδους 
ενεργοποίησης: 

! Μέσω Internet (συνιστώµενος)   
Εάν έχετε σύνδεση στο Internet µπορείτε να ενεργοποιήσετε στο πρόγραµµα 
αυτόµατα µέσα σε λίγα δευτερόλεπτα.  

! Μέσω ηλεκτρονικού ταχυδροµείου  
Μπορείτε να στείλετε µήνυµα µέσω του ηλεκτρονικού ταχυδροµείου (το οποίο 
δηµιουργείται από το πρόγραµµα και περιέχει όλες τις απαραίτητες πληροφορίες 
της ενεργοποίησης) στην ABBYY. Για να είστε σίγουροι ότι θα πάρετε άµεση 
απάντηση από το αυτόµατο σύστηµα ενεργοποίησης µην αλλάξετε την 
πληροφορία στον κορµό του µηνύµατος ή στα πεδία των περιεχοµένων. Όταν 
λάβετε τον κωδικό ή το αρχείο ενεργοποίησης εισάγετέ το στο αντίστοιχο πεδίο 
του βοηθού ενεργοποίησης. 

! Μέσω fax ή τηλεφώνου (Μόνο για την έκδοση Professional)  
Μπορείτε να τηλεφωνήσετε στο πλησιέστερο γραφείο ή αντιπρόσωπο της 
ABBYY και να δώσετε τον κωδικό εγκατάστασης και το serial number σας. Στις 
περισσότερες χώρες µπορείτε επίσης να στείλετε τα στοιχεία µε fax. Για να 
χρησιµοποιήσετε την µέθοδο αυτή, απλά τυπώστε και στείλτε µε fax το µήνυµα, 
που δηµιουργεί αυτόµατα ο βοηθός, στο πλησιέστερο γραφείο ή αντιπρόσωπο της 
ABBYY. Ο κωδικός ενεργοποίησης θα σας σταλεί µε fax. Εισάγετέ τον στο 
αντίστοιχο πεδίο του βοηθού ενεργοποίησης 

Μετά την ενεργοποίηση το ABBYY FineReader 7, θα είναι πλήρως λειτουργικό στο 
σύστηµα που έχει εγκατασταθεί. Το πρόγραµµα µπορεί να ξαναεγκατασταθεί στον ίδιο 
υπολογιστεί όσο συχνά χρειαστεί χωρίς να γίνει νέα ενεργοποίηση. Ο βοηθός 
εγκατάστασης αναγνωρίζει και δείχνει ανοχή σε αλλαγές της σύνθεσης του υπολογιστή. 
Μικρές αλλαγές δεν χρειάζονται νέα ενεργοποίηση. Σε περίπτωση µεγάλων αλλαγών 
(π.χ. µορφοποίηση του δίσκου ή επανεγκατάσταση του λειτουργικού συστήµατος. 
µπορεί να χρειαστεί νέα ενεργοποίηση. 

Προστασία προσωπικών δεδοµένων 
Η ενεργοποίηση µπορεί να ζητηθεί για να αποκτηθεί η πλήρης λειτουργία του 
FineReader 7.0. Αυτή η διαδικασία επαληθεύει ότι συντελείται εγκατάσταση ενός 
αυθεντικού προϊόντος της ABBYY. Η ABBYY εγγυάται ότι η ενεργοποίηση του 
προϊόντος δεν περιλαµβάνει τη µετάδοση προσωπικών πληροφοριών. Στην 
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πραγµατικότητα η ενεργοποίηση µπορεί να γίνει τελείως ανώνυµα εάν αυτό είναι 
επιθυµητό. 

Κατά την ενεργοποίηση, ο Βοηθός Ενεργοποίησης (Activation Wizard) δηµιουργεί ένα 
µοναδικό Κωδικό Εγκατάστασης (Installation ID), οποίος αντιστοιχεί στην σύνθεση 
του υπολογιστή κατά την στιγµή της ενεργοποίησης. Ο κωδικός ενεργοποίησης δεν 
περιλαµβάνει: προσωπικές πληροφορίες για τον χρήστη, πληροφορίες για άλλο 
λογισµικό ή δεδοµένα που τυχόν βρίσκονται στον υπολογιστή, πληροφορίες για τον 
κατασκευαστή ή το µοντέλο του υπολογιστή. Ο κωδικός αυτό χρησιµοποιείται 
αποκλειστικά για την ενεργοποίηση του FineReader. Ο Βοηθός Ενεργοποίησης στέλνει 
περιορισµένες πληροφορίες στον ABBYY Activation Server. Οι πληροφορίες αυτές 
περιλαµβάνουν: τον Κωδικό Εγκατάστασης, το όνοµα, τον σειριακό αριθµό και την 
γλώσσα επικοινωνίας του FineReader. Οι πληροφορίες αυτές χρησιµοποιούνται για την 
επιλογή της γλώσσας του προγράµµατος και για την δηµιουργία του απαντητικού 
µηνύµατος που θα σας αποσταλεί για την ενεργοποίηση. Κανένα από αυτά τα στοιχεία 
δεν θα χρησιµοποιηθεί για οποιοδήποτε άλλο σκοπό. 
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Κεφάλαιο 2  
Γνωριµία µε το ABBYY FineReader 

Το κεφάλαιο αυτό ασχολείται µε την εισαγωγή ενός εγγράφου στον υπολογιστή, χωρίς 
να είναι απαραίτητες περαιτέρω γνώσεις για τον τρόπο λειτουργίας του ABBYY 
FineReader! 

Εάν έχετε ήδη αποκτήσει κάποια εµπειρία µε προηγούµενες εκδόσεις του FineReader, 
µπορείτε να παρακάµψετε όλες τις ενότητες µέχρι το κοµµάτι που αφορά στα «Νέα 
Χαρακτηριστικά του ABBYY FineReader 7.0». 

Περιεχόµενα κεφαλαίου 

! Πως θα εισάγετε ένα έγγραφο µέσα σε ένα λεπτό 

! Το βασικό παράθυρο του ABBYY FineReader 

! Οι γραµµές εργαλείων του ABBYY FineReader 
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Πως θα εισάγετε ένα έγγραφο µέσα σε ένα λεπτό 
1. Ενεργοποιήστε το σαρωτή, πριν ξεκινήσετε την εφαρµογή του FineReader. 

(Πολλά µοντέλα σαρωτών πρέπει να ενεργοποιούνται πριν την έναρξη του 
υπολογιστή). Ενεργοποιήστε τον υπολογιστή και εκτελέστε το πρόγραµµα του 
FineReader (Start>Programs>ABBYY FineReader 7.0 Professional Edition ή 
Corporate Edition). Θα εµφανιστεί το βασικό παράθυρο του FineReader.  

2. Τοποθετήστε στο σαρωτή τη σελίδα που θέλετε να ψηφιοποιήσετε. 

3. Κάντε κλικ στο βέλος που βρίσκεται δεξιά από το κουµπί Scan&Read. Στο µενού 
συντόµευσης που εµφανίζεται, επιλέξτε το Scan&Read Wizard. 

Το κουµπί Scan&Read Wizard αντιστοιχεί σε µια ειδική 
λειτουργία σάρωσης & ανάγνωσης / ανοίγµατος & ανάγνωσης 
(scan&read / open&read mode). Στον κατάλογο Demo, 
µπορείτε να βρείτε ένα δείγµα αρχείου εικόνας. Ο κατάλογος 

αυτός, βρίσκεται µέσα στον κατάλογο που έχετε εγκαταστήσει το FineReader.   

4. Ακολουθήστε τις οδηγίες του Scan&Read Wizard. 

Η διαδικασία εισαγωγής εγγράφου αποτελείται από τέσσερα βήµατα: σάρωση 
(scanning), ανάγνωση (reading), ορθογραφικό έλεγχο (spell checking) και αποθήκευση 
(saving) του αναγνωρισµένου κειµένου. Όταν τελειώσει η ψηφιοποίηση του εγγράφου, 
στο παράθυρο Εικόνας (Image window) εµφανίζεται η «φωτογραφία» της πρωτότυπης 
σελίδας. Στη συνέχεια, η εφαρµογή σας ζητά να ορίσετε τις παραµέτρους αναγνώρισης. 
Όταν τις ορίσετε, το πρόγραµµα αρχίζει την αναγνώριση της εικόνας, αναλύοντας, 
ταυτόχρονα, τη µορφοποίηση της σελίδας. Τα ήδη επεξεργασµένα τµήµατα της 
εικόνας, σηµειώνονται µε γαλάζιο χρώµα. Το αναγνωρισµένο κείµενο, εµφανίζεται στο 
παράθυρο Κειµένου (Text window). Μετά τον έλεγχο του εγγράφου, το Scan&Read 
Wizard θα σας καθοδηγήσει, να στείλετε το αναγνωρισµένο κείµενο στην εφαρµογή, 
που θα του υποδείξετε, είτε να το αποθηκεύσετε σε κάποιο αρχείο ή, τέλος, να αρχίσετε 
την επεξεργασία ενός άλλου εγγράφου. 

Το Βασικό Παράθυρο του ABBYY FineReader 
Το FineReader πραγµατοποιεί την επεξεργασία εγγράφων δουλεύοντας πάντα σε 
κάποια δεσµίδα αρχείων (batch). Μια δεσµίδα αρχείων είναι ένας κατάλογος που 
περιέχει εικόνες, αναγνωρισµένα αρχεία κειµένου και άλλα αρχεία πληροφοριών του 
FineReader. Κάθε ψηφιοποιηµένη εικόνα αποτελεί µια ξεχωριστή σελίδα της δεσµίδας 
αρχείων. Εάν υπάρχουν αρκετές εικόνες σε ένα µοναδικό αρχείο εικόνας (για 
παράδειγµα, όταν έχετε να κάνετε µε ένα πολυσέλιδο αρχείο TIFF), κάθε εικόνα αυτού 
του αρχείου θα αποτελέσει µια ξεχωριστή σελίδα της δεσµίδας.  

Το FineReader ξεκινώντας δηµιουργεί µια νέα δεσµίδα. Το πρόγραµµα σας δίνει τη 
δυνατότητα να εργασθείτε µε την δεσµίδα αυτή ή να ανοίξετε µια υπάρχουσα δεσµίδα. 
Για αναλυτικότερες πληροφορίες, ανατρέξτε στην ενότητα «Γενικά για την Εργασία µε 
∆εσµίδες Αρχείων (batches)». 
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Στην κορυφή του βασικού παραθύρου του προγράµµατος, υπάρχει το βασικό µενού του 
FineReader, το οποίο περιλαµβάνει τις ακόλουθες τέσσερις γραµµές εργαλείων: τη 
Βασική γραµµή (Standard Bar), τη γραµµή Μορφοποίησης (Formatting Bar) και 
τη γραµµή WizardBar. Μπορείτε, κατά βούληση, να εµφανίσετε ή να αποκρύψετε 
οποιαδήποτε από τις παραπάνω γραµµές εργαλείων κάνοντας κλικ στο στοιχείο 
Toolbar (Γραµµή Εργαλείων) στο µενού View (Εµφάνιση) ή κάνοντας δεξί κλικ στο 
στοιχείο που θέλετε να εµφανίσετε/αποκρύψετε. 

Για να επιλέξετε τον τρόπο εµφάνισης των σελίδων στο παράθυρο 
∆εσµίδας: 

! Κάντε κλικ στο εικονίδιο  ή  της Βασικής γραµµής εργαλείων 

! Κάντε δεξί κλικ στο παράθυρο ∆εσµίδας και επιλέξτε τον επιθυµητό τρόπο 
εµφάνισης από την επιλογή View του αναδυόµενου µενού 

Στο κάτω µέρος του βασικού παραθύρου του FineReader, υπάρχει µια γραµµή 
κατάστασης, η οποία περιλαµβάνει πληροφορίες που αφορούν στην κατάσταση και στις 
τρέχουσες λειτουργίες της εφαρµογής, καθώς και συνοπτικές πληροφορίες σχετικά µε 
τα στοιχεία του µενού και τα κουµπιά που έχετε επιλέξει. 

Το παράθυρο της ∆εσµίδας Αρχείων (Batch), εµφανίζεται πάντα στο Βασικό 
παράθυρο του προγράµµατος. Επιπλέον, µπορεί να εµφανιστούν και τα ακόλουθα τρία 
παράθυρα: το παράθυρο Εικόνας (Image), Μεγέθυνσης (Zoom), και Κειµένου 
(Text). 

Τα παράθυρα Εικόνας (Image), Μεγέθυνσης (Zoom), και Κειµένου (Text) είναι 
λειτουργικά συνδεδεµένα µεταξύ τους. Αν κάνετε διπλό κλικ σε κάποια περιοχή στο 
παράθυρο εικόνας, η περιοχή αυτή θα εµφανιστεί και στο παράθυρο µεγέθυνσης, ενώ ο 
δροµέας του παραθύρου κειµένου θα µετακινηθεί στο αντίστοιχο σηµείο του κειµένου 
(εφόσον υπάρχει αναγνωρισµένο κείµενο για την σελίδα). 

Κεντρικό µενού 

Βασική γραµµή εργαλείων 
 
Wizard Bar 
Προσφέρει εργαλεία για την 
εκτέλεση των εργασιών: Σάρωση, 
αναγνώριση, έλεγχο και 
αποθήκευση. 
 
Γραµµή εργαλείων 
Μορφοποίησης 
 
Παράθυρο Κειµένου 
Εµφανίζει το αναγνωρισµένο 
κείµενο για έλεγχο και διόρθωση 
 
Παράθυρο Εικόνας 
Εµφανίζει την σαρωµένη εικόνα για 
επισκόπηση και σχεδιασµό µπλοκ 
 
 
 
 
Παράθυρο µεγέθυνσης 
Εµφανίζει σε µεγέθυνση το τµήµα 
της εικόνας που αντιστοιχεί στην 
γραµµή του κειµένου ή στο σηµείο 
της σαρωµένης εικόνας πάνω στο 
οποίο εργάζεστε 

Παράθυρο ∆εσµίδας 
Εµφανίζει τις σελίδες της ενεργής δεσµίδας, 
είτε υπό την µορφή εικονιδίων (όπως εδώ), 
είτε µε λεπτοµέριες 

Γραµµή εργαλείων εικόνας 
Προσφέρει εργαλεία για τον ορισµό και την 
τροποποίηση των µπλοκ, για µεγέθυνση/σµίκρυνση ή 
επεξεργασία της εικόνας 
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 Έχετε, επίσης, τη δυνατότητα να αλλάξετε την ταξινόµηση των παραθύρων στην 
οθόνη: 

! Στο µενού View επιλέξτε ένα από τα παρακάτω στοιχεία: Batch Window, Image 
and Text Windows, Zoom Window. 

 

Μερικές προτεινόµενες ταξινοµήσεις παραθύρων: Χρήσιµες όταν� 

Το Παράθυρο ∆εσµίδας στα αριστερά. Προβολή 
∆εσµίδας: Συνοπτική· τα παράθυρα Εικόνας, 
Κειµένου και Μεγέθυνσης 

�δεν υπάρχουν πολλές σε-
λίδες στη δεσµίδα 

Το παράθυρο ∆εσµίδας στην κορυφή. Προβολή 
∆εσµίδας: Λεπτοµερειακή· τα παράθυρα Εικόνας, 
Κειµένου και Μεγέθυνσης 

�υπάρχουν πολλές σελίδες 
στη δεσµίδα 

Το παράθυρο ∆εσµίδας στην κορυφή. Προβολή 
∆εσµίδας: Λεπτοµερειακή· τα παράθυρα Εικόνας 
και Μεγέθυνσης 

�εκτελείτε την µορφολο-
γική ανάλυση του κειµένου 
και την αναγνώριση 

Το παράθυρο ∆εσµίδας στην κορυφή. Προβολή 
∆εσµίδας: Λεπτοµερειακή· τα παράθυρα Κειµένου 
και Μεγέθυνσης 

�διορθώνετε το αναγνωρι-
σµένο κείµενο 

Χρήσιµες εντολές πληκτρολογίου: 

! Πατήστε CTRL+TAB για να µετακινηθείτε µεταξύ των παραθύρων. 

! Πατήστε ALT+1 για να ενεργοποιήσετε το παράθυρο ∆εσµίδας Αρχείων. 

! Πατήστε ALT+2 για να ενεργοποιήσετε το παράθυρο Εικόνας. 

! Πατήστε ALT+3 για να ενεργοποιήσετε το παράθυρο Κειµένου. 

Οι Γραµµές Εργαλείων του ABBYY FineReader 
Στο FineReader υπάρχουν τέσσερις γραµµές εργαλείων: η Βασική (Standard), τα 
Εργαλεία Εικόνας (Image Tools), η γραµµή Μορφοποίησης (Formatting) και η 
γραµµή WizardBar. Τα κουµπιά συντόµευσης, που περιλαµβάνονται στις γραµµές 
εργαλείων, είναι σίγουρα η πιο αποτελεσµατική λύση για την άµεση πρόσβαση στις 
διάφορες λειτουργίες τις εφαρµογής. Επιπλέον, οι λειτουργίες αυτές µπορεί να γίνουν 
άµεσα προσπελάσιµες, µέσω των µενού και των πλήκτρων συντόµευσης, που διαθέτει 
το πρόγραµµα. Αν θέλετε να µάθετε ποιο πλήκτρο συντόµευσης αντιστοιχεί σε κάποια 
λειτουργία της γραµµής εργαλείων, εναποθέστε το βελάκι του ποντικιού πάνω σε αυτό. 
Μετά από λίγο, στην οθόνη εµφανίζεται η ηλεκτρονική συµβουλή του συγκεκριµένου 
κουµπιού και παράλληλα στη γραµµή κατάστασης εµφανίζονται µερικές επιπλέον 
λεπτοµέρειες. 

Η γραµµή εργαλείων WizardBar 

  
Τα κουµπιά συντόµευσης της γραµµής εργαλείων WizardBar, περιλαµβάνουν τις 
βασικές λειτουργίες του FineReader: Ψηφιοποίηση (Scan), Ανάγνωση (Read), 
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Ορθογραφικός Έλεγχος (Check Spelling) και Αποθήκευση (Save) των 
αποτελεσµάτων αναγνώρισης. Οι αριθµοί που βρίσκονται πάνω στα κουµπιά 
συντόµευσης, υποδεικνύουν τη σειρά µε την οποία πρέπει να γίνουν οι αντίστοιχες 
ενέργειες για την εισαγωγή των εγγράφων. Μπορείτε να εκτελέσετε τις ενέργειες αυτές   
καθεµία ξεχωριστά, είτε να τις εκτελέσετε µε µια κίνηση, κάνοντας κλικ στο κουµπί 
Scan&Read. Το κουµπί αυτό, εκτελεί αυτόµατα όλη τη διαδικασία της επεξεργασίας 
ενός εγγράφου.  

Κάθε κουµπί, περιλαµβάνει διάφορους τρόπους λειτουργίας. Κάντε κλικ στο βελάκι 
που βρίσκεται στη δεξιά πλευρά του κάθε κουµπιού και επιλέξτε την κατάσταση 
λειτουργίας από το εµφανιζόµενο µενού. Στο εικονίδιο του κουµπιού εµφανίζεται 
πάντα, η τελευταία επιλεγµένη κατάσταση λειτουργίας. Κάντε κλικ πάνω στο κουµπί 
για να ενεργοποιήσετε ξανά τη συγκεκριµένη λειτουργία. 

Scan&Read 
(Ψηφιοποίση&Ανάγνωση) 

 

Scan&Read � θέτει σε λειτουργία την 
ψηφιοποίηση και την ανάγνωση εγγράφων, 
χρησιµοποιώντας τις ενεργές επιλογές.  

Scan&Read Multiple Images � ψηφιοποιεί και 
διαβάζει πολλές εικόνες στη σειρά. 

Open&Read � ανοίγει και διαβάζει τις εικόνες που 
έχουν επιλεχθεί στο παράθυρο διαλόγου Open.  

Scan&Read Wizard � εκτελεί την ειδική λειτουρ-
γία scan&read. Το FineReader σας καθοδηγεί καθ� 
όλη τη διάρκεια της διαδικασίας  επεξεργασίας 
εγγράφου και σας συµβουλεύει για το τι πρέπει να 
κάνετε στη συνέχεια, για να έχετε το ένα ή το άλλο 
αποτέλεσµα. 

1-Scan (Ψηφιοποίηση) 

 

Open Image � προσθέτει εικόνα(ες) στη δεσµίδα 
αρχείων. Κάθε νέα εικόνα, αντιγράφεται στον 
κατάλογο της δεσµίδας αρχείων. 

Scan Image � ψηφιοποιεί µια εικόνα. 

Scan Multiple Images � ψηφιοποιεί εικόνες, µέχρι 
εσείς να τερµατίσετε τη διαδικασία σάρωσης. Για 
να σταµατήσετε την ψηφιοποίηση, στο µενού File, 
επιλέξτε το στοιχείο Stop.  

Hot Folder (µόνο στην έκδοση Corporate Edition) 
� ξεκινά τη λειτουργία παρακολούθησης ενός 
φακέλου (όλες οι εικόνες που εισάγονται στον 
συγκεκριµένο φάκελο ανοίγονται αυτόµατα από το 
ABBYY FineReader). Για να διακόψετε την 
λειτουργία παρακολούθησης του φακέλου, επιλέξτε 
από το µενού File την επιλογή Disable Hot Folder  

Options � ενεργοποιεί στο παράθυρο διαλόγου 
Options την καρτέλα Scan/Open Image, όπου 
µπορείτε να ορίσετε τις επιλογές ψηφιοποίησης. 
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2-Read (Ανάγνωση) 

 

Read � διαβάζει την ενεργή σελίδα της δεσµίδας 
αρχείων. 

Read All � διαβάζει όλες τις µη αναγνωρισµένες 
σελίδες της δεσµίδας αρχείων. 

Options � ενεργοποιεί στο παράθυρο διαλόγου 
Options, την καρτέλα Recognition, όπου µπορείτε 
να ορίσετε τις επιλογές αναγνώρισης του εγγράφου. 

3-Check Spelling 
(Ορθογραφικός Έλεγχος) 

 

Check Spelling � αναζητεί µέσα στο κείµενο τις 
ανορθόγραφες λέξεις καθώς και τις λέξεις που 
αναγνωρίστηκαν µε κάποια αµφιβολία από το 
πρόγραµµα.  

Options � ενεργοποιεί στο παράθυρο διαλόγου 
Options την καρτέλα Check spelling, όπου 
µπορείτε να ορίσετε τις επιλογές που αφορούν τον 
ορθογραφικό έλεγχου. 

 

4-Save (Αποθήκευση) 

 

Save Wizard � ανοίγει το Βοηθό Αποθήκευσης 
για να επιλέξετε την εφαρµογή στην οποία θα 
αποθηκεύσετε το αναγνωρισµένο κείµενο.  

Save Text to File � αποθηκεύει το αναγνωρισµένο 
κείµενο σε κάποιο αρχείο στο δίσκο.  

Send Selected Pages to � εάν θέλετε να εξάγετε 
µόνο τις επιλεγµένες σελίδες της δεσµίδας αρχείων, 
επιλέξτε τις σελίδες που επιθυµείτε να εξάγετε, 
ενεργοποιήστε το στοιχείο Send Selected Pages to 
και στη συνέχεια, επιλέξτε την εφαρµογή που 
θέλετε να γίνει η αποστολή των εγγράφων σας. Το 
FineReader θα εξάγει τις σελίδες στην εφαρµογή 
που επιλέξατε, χωρίς να αποθηκεύσει το κείµενο 
στο σκληρό δίσκο. 

Send All Pages to � εξάγει όλες τις αναγνω-
ρισµένες σελίδες στην εφαρµογή που θα επιλέξετε, 
χωρίς να αποθηκεύσει το κείµενο στο σκληρό 
δίσκο. 

Options � ενεργοποιεί στο παράθυρο διαλόγου 
Options την καρτέλα Formating, όπου µπορείτε να 
ορίσετε τις επιλογές αποθήκευσης. 

Η Βασική Γραµµή Εργαλείων (Standard) 

 
 
Νέα  
δεσµίδα 

 
 
Άνοιγµα 
δεσµίδας 

Αποκοπή 

 
Αντιγραφή 

 
 
Επικόληση 

 
 
 
Αναίρεση 

Επανάληψη 

Προηγούµενη 
σελίδα 

 
 

Επώµενη 
σελίδα 

 
 
∆εξιόστροφη 
περιστροφή 

Αριστερόστροφη 
περιστροφή 

 
Κλίµακα 

Μεγέθυνση 

 
 
 
Σµίκρυνση 

 
 

Γλώσσα 
αναγνώρισης 

Εµφάνιση
παραθύρων
εικόνας και

κειµένου

 
Εµφάνιση 
παραθύρου 
κειµένου 

Λεπτοµέριες 
δεσµίδας 

 
 
Εκπαιδευτική 
παρουσίαση 

Εµφάνιση 
παραθύρου 
εικόνας 

 
 
Εικονίδια 
δεσµίδας 

Παράθυρο 
ρυθµίσεων 



 20

Η Βασική (Standard) γραµµή εργαλείων περιλαµβάνει τα κουµπιά συντόµευσης που 
αφορούν στα εργαλεία αρχείου και εικόνας (αναίρεση και ακύρωση αναίρεσης µιας 
ενέργειας, µετακίνηση στις σελίδες της δεσµίδας αρχείων, καθαρισµός και περιστροφή 
της εικόνας), καθώς επίσης και τη λίστα των υποστηριζόµενων γλωσσών αναγνώρισης.  

Η Γραµµή Εργαλείων Μορφοποίησης (Formatting) 

Η γραµµή εργαλείων Μορφοποίησης (Formatting), περιλαµβάνει τα κουµπιά 
συντόµευσης που αφορούν στα διάφορα εργαλεία µορφοποίησης κειµένου. Έτσι, 
µπορείτε να διορθώσετε το κείµενο και να πραγµατοποιήσετε τη µορφοποίηση του 
κειµένου στο παράθυρο Κειµένου (Text). 

Η Γραµµή Εργαλείων Εικόνας (Image) 
 

Η γραµµή εργαλείων Εικόνας 
(Image) περιλαµβάνει τα κουµπιά 
συντόµευσης που αφορούν στα 
εργαλεία ανάλυσης της διάταξης της 
σελίδας (π.χ. δηµιουργία και επε-
ξεργασία των µπλοκ), καθώς επίσης 
και τα εργαλεία για την αύξη-
ση/µείωση της κλίµακας της εικόνας 
και την επεξεργασία της εικόνας (π.χ. 
καθάρισµα της εικόνας, κ.ά). 

Σηµείωση: Τα κουµπιά, τα οποία 
επιτρέπουν την δηµιουργία ή 
τροποποίηση των µπλοκ, µπορούν να 
χρησιµοποιηθούν τόσο στο παράθυρο 
Εικόνας, όσο και στο παράθυρο 
Μεγέθυνσης 

∆ιαµόρφωση των Γραµµών Εργαλείων 

Σηµείωση: Η εµφάνιση του βασικού παραθύρου του FineReader ή για να είµαστε πιο 
ακριβείς, ο αριθµός των κουµπιών συντόµευσης που εµφανίζονται στις γραµµές 
εργαλείων του FineReader, εξαρτάται από την ανάλυση της οθόνης σας. Για να δείτε 
όλα τα διαθέσιµα κουµπιά συντόµευσης, αυξήστε την ανάλυση της οθόνης σας. Αυτό 
δεν σηµαίνει ότι µειώνεται η λειτουργικότητα του FineReader, επειδή µερικά κουµπιά 
δεν είναι ορατά � τα κουµπιά συντόµευσης δίνουν πρόσβαση σε ένα µέρος µόνο των 

Γραµµατοσειρά 

Μέγεθος γραµµατοσειράς 

Έντονα 

Πλάγια

Υπογράµµιση

Εκθέτης

∆είκτης

Αριστερή στοίχ.

Στοίχ. στο 
κέντρο 

∆εξιά στοίχ. 

Πλήρης 
στοίχ. 

Επώµενο λάθος

Προηγούµενο λάθος

Εµφάνιση µη εκτυπώσιµων χαρακτήρων 

Μορφολογική ανάλυση 

Περιοχή αναγνώρισης 

Μπλοκ κειµένου 

Μπλοκ πίνακα 

Μπλοκ εικόνας 

Επιλογέας αντικειµένων 

Προσθήκη τµήµατος µπλοκ 

Αφαίρεση τµήµατος µπλοκ 

∆ιαγραφή µπλοκ 

Επανα-αρίθµηση µπλοκ 

Προσθήκη κατακόρυφου διαχωριστικού 

Προσθήκη οριζόντιου διαχωριστικού 

∆ιαγραφή διαχωριστικού 

Σµίκρυνση 

Μεγέθυνση 

Γόµα 
 

Εργαλεία
σχεδιασµού

µπλοκ

Εργαλεία
επεξεργασίας

µπλοκ

Εργαλεία
πινάκων

Εργαλεία
εικόνας
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διαθέσιµων λειτουργιών του FineReader και σε κάθε κουµπί αντιστοιχεί πάντα κάποια 
επιλογή στο µενού. 

Το FineReader σας επιτρέπει να διαµορφώσετε τις εξής γραµµές εργαλείων: Βασική, 
Μορφοποίησης και Εικόνας. Σ' αυτές τις γραµµές εργαλείων έχετε την δυνατότητα να 
προσθέσετε ή να αφαιρέσετε κουµπιά, τα οποία δίνουν πρόσβαση σε οποιαδήποτε 
εντολή της εφαρµογής. 

Κάθε εντολή των µενού συνδέεται µε ένα εικονίδιο. Μπορείτε να δείτε την πλήρη λίστα 
των εντολών και των αντίστοιχων κουµπιών στον διάλογο Customize (µενού 
Tools>Customize) στην λίστα Commands. 

Για να προσθέσετε ένα κουµπί σε µια γραµµή εργαλείων: 

1. ∆ιαλέξτε την κατάλληλη κατηγορία από το πεδίο Categories  
Σηµείωση: Στη λίστα οι εντολές είναι οµαδοποιηµένες σύµφωνα µε τις κύριες 
επιλογές του µενού. Η επιλογή µιας κατηγορίας αλλάζει το σύνολο των εντολών 
που εµφανίζονται στην λίστα Commands. 

2. Επιλέξτε την γραµµή εργαλείων στην οποία θέλετε να προσθέσετε το κουµπί από 
το πεδίο Toolbars 

3. Επιλέξτε την επιθυµητή εντολή από την λίστα Commands και πατήστε το 
πλήκτρο  

Η εντολή που επιλέξατε θα προστεθεί στην λίστα εντολών της επιλεγµένης γραµµής 
εργαλείων και θα εµφανιστεί στην γραµµή εργαλείων στο κυρίως παράθυρο το 
FineReader. 

Για να αφαιρέσετε ένα κουµπί από µια γραµµή εργαλείων: 

! Επιλέξτε το κουµπί που θέλετε να αφαιρέσετε από την λίστα Toolbar buttons και 
πατήστε το πλήκτρο  

Σηµείωση:  

1. Η σειρά των κουµπιών στην λίστα καθορίζει την σειρά τους στη γραµµή 
εργαλείων. Για να αλλάξετε την σειρά των κουµπιών, επιλέξτε την εντολή που 
θέλετε να µετακινήσετε από την τρέχουσα λίστα εντολών της γραµµής εργαλείων 
και πατήστε το πλήκτρο µε την ένδειξη Up (Down) για την µετακινήσετε.  

2. Έχετε την δυνατότητα να οµαδοποιήσετε τις εντολές της γραµµής εργαλείων. Για 
τον σκοπό αυτό διαλέξτε την επιλογή µε την ένδειξη Separator από την λίστα 
Commands και πατήστε το πλήκτρο Add. Ένα διαχωριστικό θα προστεθεί στην 
λίστα των κουµπιών της τρέχουσας γραµµής εργαλείων. Μπορείτε να κινείτε το 
διαχωριστικό. 

3. Για να επαναφέρετε µια γραµµή εργαλείων στην κατάσταση που ήταν κατά την 
εγκατάσταση του FineReader, επιλέξτε την και πατήστε το πλήκτρο Reset. 
Πατώντας το πλήκτρο Reset All µπορείτε να επαναφέρετε όλες τις γραµµές 
εργαλείων στην αρχική τους κατάσταση. 
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Κεφάλαιο 3  
Γενικά Χαρακτηριστικά του ABBYY 
FineReader 

Το πρόγραµµα ABBYY FineReader επιτρέπει την αυτόµατη εισαγωγή εγγράφων στον 
υπολογιστή. Η λειτουργία του είναι εξαιρετικά απλή: κάντε κλικ στο κουµπί 
Scan&Read και τα υπόλοιπα θα τεθούν αυτόµατα σε λειτουργία από το FineReader. 
Έτσι, δεν θα χρονοτριβήσετε µε τις πολύπλοκες λεπτοµέρειες τις εφαρµογής. Επιπλέον, 
έχετε τη δυνατότητα να εξάγετε το αναγνωρισµένο κείµενο στην εφαρµογή 
επεξεργασίας κειµένου ή στο πρόγραµµα λογιστικών φύλλων της αρεσκείας σας ή να 
το αποθηκεύσετε σε µια από τις υποστηριζόµενες µορφές αρχείων. 

Περιεχόµενα κεφαλαίου: 

! Τι είναι ένα πρόγραµµα OCR; 

! Νέα χαρακτηριστικά του ABBYY FineReader 7.0 

! Υποστηριζόµενες µορφές αρχείων εγγράφων 

! Υποστηριζόµενες µορφές αρχείων εικόνων 
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Τι είναι ένα Πρόγραµµα OCR 
Η Οπτική Αναγνώριση Χαρακτήρων (OCR � Optical Character Recognition) είναι η 
διαδικασία µετατροπής των εικόνων τυπωµένων χαρακτήρων, οι οποίοι έχουν σαρωθεί 
σε κωδικούς χαρακτήρων (π.χ. σύµφωνα µε τον κώδικα ASCII). Μια εφαρµογή OCR 
είναι ένας αποδοτικός τρόπος µε τον οποίο µπορείτε να µετατρέψετε σαρωµένα 
έγγραφα, εικόνες και αρχεία PDF σε αρχεία, τα οποία θα µπορείτε να τροποποιήσετε ή 
να κάνετε αναζητήσεις στα περιεχόµενά τους και γενικά να τα επεξεργαστείτε µε 
διάφορους τρόπους σε ένα υπολογιστή. 

Το FineReader είναι ένα φιλικό πρόγραµµα, που µπορεί να αναγνωρίσει κείµενα 
τυπωµένα -σχεδόν- µε κάθε είδους γραµµατοσειρά. Στα βασικά χαρακτηριστικά του 
FineReader είναι η υψηλή ακρίβεια στην αναγνώριση και η χαµηλή του ευαισθησία  
στην ύπαρξη τυπογραφικών ατελειών. Τα χαρακτηριστικά αυτά πηγάζουν από µια 
ειδική τεχνολογία αναγνώρισης, η οποία είναι βασισµένη στις αρχές της τεχνολογίας 
της Ενότητας, της Σκοπιµότητας και της Προσαρµοστικότητας (IPA). 

H τεχνολογία IPA της ABBYY: 

Η διαδικασία αναγνώρισης του FineReader , βασίζεται στις αρχές της τεχνολογίας που 
ονοµάζεται Integral Purposeful Adaptive perception (IPA). Υπάρχουν τρεις αρχές που 
καθορίζουν τη συµπεριφορά του προγράµµατος: 

! Ενότητα (Integrity) � το αντικείµενο της αναγνώρισης περιγράφεται ως µια 
ξεχωριστή οντότητα, η οποία περιλαµβάνει ένα σύνολο στοιχείων και το 
συσχετισµό αυτών. 

! Σκοπιµότητα (Purposefulness) � η αναγνώριση είναι µια διαδικασία παραγωγής 
και προσπάθειας επαλήθευσης υποθέσεων. 

! Προσαρµοστικότητα (Adaptability) � οι ικανότητες εκµάθησης και εκπαίδευσης 
του συστήµατος. 

Η διαδικασία της εισαγωγής εγγράφου µπορεί να χωριστεί σε δύο 
στάδια: 

1. Ψηφιοποίηση (Scanning). Κατά τη διάρκεια του πρώτου µέρους της διαδικασίας, 
ο σαρωτής διαβάζει την εικόνα και τη µεταφέρει στον υπολογιστή. Η εικόνα αυτή 
δεν είναι τίποτα άλλο από µια φωτογραφία, ένα σύνολο µαύρων, λευκών και 
έγχρωµων κουκίδων που η επεξεργασία τους είναι αδύνατο να γίνει µέσω κάποιας 
εφαρµογής επεξεργασίας κειµένου. 

2. Αναγνώριση (Recognition). Κατά τη διάρκεια του δεύτερου µέρους της 
διαδικασίας, το FineReader εκτελεί την εργασία της οπτικής αναγνώρισης των 
χαρακτήρων που υπάρχουν στην εικόνα.  

Το σύστηµα δηµιουργεί µία υπόθεση σχετικά µε το αντικείµενο αναγνώρισης (ένα 
χαρακτήρα, ένα µέρος του χαρακτήρα, πολλούς κολληµένους χαρακτήρες) και έπειτα, 
είτε τη δέχεται, είτε την απορρίπτει ανάλογα µε το αν µπορεί να εντοπίσει τα συνθετικά 
στοιχεία και τους συσχετισµούς τους, που η εκάστοτε υπόθεση συνεπάγεται. Αυτά τα 
συνθετικά στοιχεία αποτελούν τα ηλεκτρονικά ισοδύναµα που αντιστοιχούν στα µέρη 
των χαρακτήρων, κρίσιµα για την ανθρώπινη αντίληψη (τόξα, κύκλοι, τελείες, κ.λπ.). 
Στη συνέχεια, η εφαρµογή προσαρµόζεται από µόνη της στο κείµενο  χρησιµοποιώντας 
την θετική εµπειρία που έχει αποκτήσει από τους πρώτους χαρακτήρες που 
αναγνωρίσθηκαν µε βεβαιότητα. Η αναζήτηση και χρήση πληροφοριών µέσα από το 
κείµενο, επιτρέπουν στο σύστηµα να αναγνωρίζει ακόµα και κοµµένους ή 



 24

παραµορφωµένους χαρακτήρες. Εποµένως, το πρόγραµµα δίνει υψηλής πιστότητας 
αποτελέσµατα, ακόµα και όταν στο πρωτότυπο υπάρχουν τυπογραφικές ατέλειες. Το 
τελικό αποτέλεσµα είναι το αναγνωρισµένο κείµενο, το οποίο εµφανίζεται στο 
παράθυρο Κειµένου του FineReader και εφεξής µπορείτε να το επεξεργαστείτε και να 
το αποθηκεύετε σε οποιαδήποτε µορφή επιλέξετε και είναι κατάλληλη για εσάς. 

Νέα Χαρακτηριστικά του ABBYY FineReader 7.0 

Ακρίβεια στην αναγνώριση 

! Έχει βελτιωθεί σε ποσοστό 25% η ακρίβεια της αναγνώρισης σε σχέση µε την 
προηγούµενη έκδοση. Η ανάλυση και η αναγνώριση εγγράφων µε πολυπλοκότητα 
στη µορφοποίησή τους έχει βελτιωθεί, ειδικά σε έγγραφα που έχουν κείµενο 
επάνω σε έγχρωµο ή ράστερ φόντο και πολύπλοκους πίνακες (συµπερι-
λαµβανοµένων πινάκων µε λευκό πλέγµα και πίνακες µε έγχρωµα κελιά) 

! Έχουν προστεθεί εξειδικευµένα Αγγλικά και Γερµανικά λεξικά, που διαθέτουν 
την πιο συχνή ορολογία της ιατρικής και της δικονοµίας και παρέχουν 
απαράµιλλη ακρίβεια στην αναγνώριση ιατρικών και νοµικών κειµένων. 

! Έχει βελτιωθεί η αναγνώριση barcodes και έχει προστεθεί υποστήριξη για τον 
τύπο barcodes δύο διαστάσεων PDF � 417 2D. 

Υποστήριξη XML και ολοκλήρωση µε το Microsoft Office. 

! Τώρα τo ABBYY FineReader υποστηρίζει αρχεία µορφής Microsoft Word XML 

! Το πρόγραµµα είναι πλήρως συµβατό µε Microsoft Word 2003 και σας επιτρέπει 
να κάνετε έλεγχο και να επεξεργάζεστε τα έγγραφά σας χρησιµοποιώντας τα 
εργαλεία του Microsoft Word. Ταυτόχρονα οι χρήστες έχουν τη δυνατότητα να 
συγκρίνουν τα αποτελέσµατα που έχουν εξάγει στο Microsoft Word µε την 
πρωτότυπη εικόνα, από το παράθυρο µεγέθυνσης του FineReader, το οποίο 
εµφανίζεται µέσα στο Microsoft Word. 

! Το ABBYY FineReader µπορεί να εισάγει αναγνωρισµένα κείµενα απευθείας 
µέσα από το  Microsoft Word. Αυτό σας παρέχει την ευχέρεια να συλλέγετε και 
να µετατρέπετε πληροφορίες από εφηµερίδες ή αρχεία µε µορφή PDF σε ένα  
ηλεκτρονικό έγγραφο. 

Βελτιωµένη µετατροπή αρχείων PDF 

! Η ποιότητα της αναγνώρισης εγγράφων σε µορφή PDF έχει βελτιωθεί δραστικά 
στην έκδοση 7.0. Το ABBYY FineReader µπορεί να εξάγει και να αναγνωρίσει το 
κείµενα που βρίσκεται στο παρασκήνιο PDF αρχείων. 

! Τα αναγνωρισµένα έγγραφα σε αρχεία PDF µπορούν να τροποποιηθούν στον 
επεξεργαστή του FineReader. Τα αποτελέσµατα µπορούν να αποθηκευτούν σε 
οποιοδήποτε µορφή αρχείου αποθήκευσης συµπεριλαµβανοµένης και της µορφής 
PDF. 

! Τα έγγραφα σε PDF µορφή που δηµιουργούνται από το ABBYY FineReader είναι 
βελτιστοποιηµένα για δηµοσίευση στο ∆ιαδίκτυο. Με τον τρόπο αυτό, η πρώτη 
σελίδα του εγγράφου µπορεί να εµφανιστεί πριν «κατέβει» ολόκληρο το έγγραφο. 
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Νέες ρυθµίσεις αποθήκευσης 

! Μια νέα µορφή αποθήκευσης, η µορφή Microsoft PowerPoint, επιτρέπει τη 
γρήγορη δηµιουργία καινούριων παρουσιάσεων ή την επεξεργασία υπαρχόντων 
εγγράφων από διαφάνειες (slides) ή σηµειώσεις για το ακροατήριο (handouts) που 
έχουν τυπωθεί από το PowerPoint. 

! Τα αρχεία, που δηµιουργούνται κατά την αποθήκευση των αποτελεσµάτων σε 
µορφή Microsoft Word, είναι µικρότερα σε µέγεθος από ότι στις παλιότερες 
εκδόσεις. Το πρόγραµµα διατηρεί µε µεγαλύτερη ακρίβεια την µορφοποίηση των 
εγγράφων µε διάφορα διαχωριστικά. Ακόµη έχουν προστεθεί νέες επιλογές για 
την διαχείρισης των εικόνων µέσα στα αρχεία Word. 

! Το πρόγραµµα διατηρεί µε µεγαλύτερη ακρίβεια την µορφοποίηση του 
πρωτότυπου εγγράφου, κατά την αποθήκευση σε µορφή HTML (ειδικά 
πολύπλοκων στοιχείων, όπως την αναδίπλωση κειµένου γύρω από µη ορθογώνιες 
εικόνες. Τα αρχεία που δηµιουργούνται είναι µικρότερα σε µέγεθος, έτσι ώστε να 
είναι πιο αποδοτικά για την δηµοσίευση στο ∆ιαδίκτυο. 

Επικοινωνία µε το χρήστη 

! Τα παράθυρα διαλόγου του προγράµµατος έχουν βελτιωθεί και είναι πιο φιλικά 
στο χρήστη. Οι χρήστες µπορούν να προσαρµόσουν τις γραµµές εργαλείων. Νέες 
εργαλείων επιτρέπουν την λεπτοµερή ρύθµιση και την εξατοµίκευση των 
παραθύρων του ABBYY FineReader. Για παράδειγµα, η ρύθµιση της µεγέθυνσης 
µπορεί να εφαρµοστεί σε κάθε λειτουργικό παράθυρο ξεχωριστά. 

! Η νέα Εκπαιδευτική Παρουσίαση (Tutorial) δίνει στους αρχάριους οδηγίες για 
να εύκολο και γρήγορο ξεκίνηµα στη χρήση του ABBYY FineReader. Ταυτό-
χρονα, οι έµπειροι χρήστες θα βρουν εκεί προχωρηµένες συµβουλές,  για να 
αυξήσουν την ποιότητα της αναγνώρισης και την παραγωγικότητα. 

Πρόσθετα χαρακτηριστικά 

Οι νέες ικανότητες του FineReader 7.0 Professional Edition περιλαµβάνουν: 

! Το εργαλείο διαχωρισµού των εικόνων σας επιτρέπει να χωρίζετε µια εικόνα σε 
διάφορες περιοχές και να τις αποθηκεύετε σαν ξεχωριστές σελίδες. Αυτή η 
µέθοδος είναι χρήσιµη για την αναγνώριση επαγγελµατικών καρτών (σάρωση 
πολλών µαζί), για βιβλία (σάρωση αντικριστών σελίδων) και εκτυπώσεις από 
Powerpoint (σάρωση σηµειώσεων ακροατηρίου 2 ή περισσότερες διαφάνειες ανά 
σελίδα). 

! Έρευνα µε µορφολογική υποστήριξη. Κάθε δεσµίδα αρχείων που έχει δηµιουρ-
γηθεί στο FineReader αποτελεί µια µικρή βάση δεδοµένων, στην οποία µπορούν 
να γίνουν αναζητήσεις πλήρους κειµένου. Μπορείτε ψάξετε για λέξεις, ανεξάρ-
τητα από την γραµµατική µορφή τους. (Αυτή η λειτουργία υπάρχει για τις 34 
γλώσσες οι οποίες διαθέτουν υποστηριζόµενα λεξικά). 

! Υποστήριξη για την τεχνολογία Intel Hyper-Threading, η οποία βελτιώνει 
σηµαντικά την παραγωγικότητα κατά την αναγνώριση µεγάλων δεσµίδων. 

! Σάρωση διπλής όψης (duplex scanning). Εάν ψηφιοποιήσετε ένα έγγραφο 
διπλής όψης χρησιµοποιώντας έναν σαρωτή µε δυνατότητα σάρωσης σε διπλή 
όψη, το πρόγραµµα δηµιουργεί δύο διαφορετικές εικόνες. Η επιλογή αυτή µπορεί 
να αναιρεθεί εάν δεν χρειάζεστε σάρωση διπλής όψης. 

! Υποστηρίζεται το άνοιγµα και η αποθήκευση αρχείων εικόνων JPEG 2000. 
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∆ικτυακές λειτουργίες στην έκδοση ABBYY FineReader Corporate Edition 

! ∆ικτυακή εγκατάσταση. Το FineReader Corporate Edition υποστηρίζει την 
εγκατάσταση εξυπηρετητές σε σταθµούς εργασίας, µε την χρήση των µηχανισµών 
Active Directory ή Microsoft System Manager Server ή από την γραµµή εντολών. 

! Υποστήριξη για πολύ-συσκευές. Οι πολυ-συσκευές, που  συνδυάζουν την 
λειτουργικότητα ενός σαρωτή, ενός εκτυπωτή, ενός αντιγραφικού και ενός φαξ σε 
µια συσκευή, γίνονται ολοένα και πιο δηµοφιλείς.   
Το FineReader µπορεί να συνεργαστεί µε τις συσκευές αυτές, είτε είναι 
συνδεδεµένες στον σταθµό εργασίας είτε στο δίκτυο. Ειδικές ρυθµίσεις 
επιτρέπουν στους χρήστες να ανοίγουν και να αναγνωρίζουν αυτόµατα εικόνες 
από οπουδήποτε στο δίκτυο ή από έναν FTP server. 

! ∆ιαχειριστής Αδειών (License Manager). Το εργαλείο αυτό διαχειρίζεται τις 
άδειες χρήσης στο δικτύου. Με αυτό οι διαχειριστές µπορούν να παρακολουθούν 
την χρήση του FineReader Corporate Edition στους σταθµούς εργασίας, να 
δεσµεύουν άδειες για χρήση σε συγκεκριµένους σταθµούς εργασίας και να 
προσθέτουν άδειες χρήσης. 

Για περισσότερες πληροφορίες σχετικά µε την εγκατάσταση του FineReader σε 
σταθµούς εργασίας, την χρήση του License Manager, καθώς και για τη χρήση του 
προγράµµατος σε τοπικό δίκτυο, δείτε το «System Administrator�s Guide» στον 
αντίστοιχο κατάλογο στον εξυπηρετητή όπου έχει γίνει η εγκατάσταση του FineReader. 

Υποστηριζόµενες Μορφές Αρχείων Εγγράφων 

Το ABBYY FineReader µπορεί να αποθηκεύσει τα αποτελέσµατα 
της αναγνώρισης σε µια από τις ακόλουθες µορφές: 

! Έγγραφο του Microsoft Word (*.DOC) 

! Αρχείο Εµπλουτισµένου Κειµένου (*.RTF) 

! Αρχείο XML (*.XML) (Μόνο για MS Word 2003) 

! Αρχείο Adobe Acrobat (*.PDF) 

! Αρχείο HTML 

! Αρχείο Microsoft Power Point (*.PPT) 

! Αρχείο Comma Separated Values (*.CSV) 

! Απλό Κείµενο (*.TXT). Το ABBYY FineReader υποστηρίζει διάφορες κωδικο-
σελίδες (Windows, DOS, Mac, ISO) καθώς και Unicode. 

! Λογιστικά Φύλλα του Microsoft Excel (*.XLS) 

! Αρχείο βάσης δεδοµένων (*.DBF) 
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Υποστηριζόµενες Μορφές Αρχείων Εικόνων 

Το ABBYY FineReader υποστηρίζει τις ακόλουθες µορφές αρχείων 
εικόνων: 

PDF: 
Αρχεία σε µορφή PDF (έκδοσης 1.4 ή προγενέστερης) 

BMP: 
2-bit � ασπρόµαυρο 
4- και 8- bit � µε παλέτα χρωµάτων 
16-bit � µε µάσκα 
24-bit � µε παλέτα χρωµάτων και µε πραγµατικό χρώµα 
32-bit � µε µάσκα 

PCX, DCX: 
2-bit � ασπρόµαυρο 
4- και 8-bit � µε παλέτα χρωµάτων 
24-bit � µε πραγµατικό χρώµα 

JPEG: 
Σε τόνους του γκρι, έγχρωµα 

JPEG 2000: 
Σε τόνους του γκρι, έγχρωµα 

TIFF: 
Ασπρόµαυρα � ασυµπίεστα, CCITT3, CCITT3FAX, CCITT4, Packbits  
Σε τόνους του γκρι � ασυµπίεστα, Packbits, JPEG 
Σε πραγµατικό χρώµα � ασυµπίεστα, Packbits 
Αρχεία TIFF µε πολλές εικόνες σε ένα αρχείο (multipage ή multiimage) 

PNG: 
Ασπρόµαυρα, σε τόνους του γκρι, έγχρωµα 

Το FineReader µπορεί να αποθηκεύσει αρχεία εικόνας σε µια από 
τις ακόλουθες µορφές: 

BMP: 
Ασπρόµαυρα, σε τόνους του γκρι, έγχρωµα 

PCX: 
Ασπρόµαυρα, σε τόνους του γκρι 

JPEG: 
Σε τόνους του γκρι, έγχρωµα  

JPEG 2000: 
Σε τόνους του γκρι, έγχρωµα 

TIFF: 
Ασπρόµαυρα � ασυµπίεστα, CCITT3, CCITT3FAX, CCITT4, Packbits 
Σε τόνους του γκρι � ασυµπίεστα, Packbits, JPEG 
Έγχρωµα � ασυµπίεστα και JPEG 

PNG: 
Ασπρόµαυρα, σε τόνους του γκρι, έγχρωµα 
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Κεφάλαιο 4  
Ψηφιοποίηση της Εικόνας 

Η ποιότητα της αναγνώρισης εξαρτάται σηµαντικά από την ποιότητα της πρωτότυπης 
εικόνας. Στο κεφάλαιο αυτό, θα µάθετε πώς να ψηφιοποιείτε σωστά ένα έγγραφο, πώς 
να ανοίγετε και να διαβάζετε µια εικόνα που έχετε στον υπολογιστή σας (ανατρέξτε στη 
λίστα υποστηριζόµενων αρχείων εικόνας στην ενότητα «Υποστηριζόµενες Μορφές 
Αρχείων Εικόνων»), πώς να επεξεργάζεστε εικόνες και να τις µετατρέπετε έτσι, ώστε 
να είναι έτοιµες για τη διαδικασία αναγνώρισης (να µειώσετε το «θόρυβο» που 
δηµιουργείται µετά την ψηφιοποίηση, κ.ά.). 

Περιεχόµενα Κεφαλαίου: 

! Ψηφιοποίηση 

! Ορισµός των παραµέτρων ψηφιοποίησης 

! Συµβουλές για τη ρύθµιση της φωτεινότητας 

! Ψηφιοποίηση πολυσέλιδων εγγράφων 

! Άνοιγµα αρχείων εικόνας 

! Ψηφιοποίηση αρχείων εικόνων από τον Hot Folder 

! Ψηφιοποίηση διπλών σελίδων 

! Προσθήκη εικόνων από επαγγελµατικές κάρτες 

! Αρίθµηση σελίδων  

! Εργασίες πάνω στις εικόνες 

! Ρυθµίσεις δεσµίδας αρχείων 
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Ψηφιοποίηση 
Το FineReader επικοινωνεί µε τους σαρωτές, µέσω του πρωτοκόλλου TWAIN. Το 
πρωτόκολλο TWAIN είναι ένα γενικό πρότυπο που καθιερώθηκε το 1992 για την 
τυποποίηση της αλληλεπίδρασης µεταξύ των διαφόρων συσκευών που παρέχουν τη 
δυνατότητα εισαγωγής εικόνας στον υπολογιστή (όπως οι σαρωτές), και των διαφόρων 
εφαρµογών, που επεξεργάζονται εικόνες. Υπάρχουν δύο τρόποι µε τους οποίους το 
FineReader επικοινωνεί µε έναν σαρωτή µέσω του οδηγού TWAIN: 

! χρησιµοποιώντας το παράθυρο διαλόγου του FineReader: στην περίπτωση 
αυτή, θα χρησιµοποιήσετε το παράθυρο διαλόγου Scanner settings (Ρυθµίσεις 
σαρωτή) του FineReader, για να ορίσετε τις παραµέτρους σάρωσης. η αντίστοιχη 
επιλογή είναι: Use FineReader Interface (Χρήση ∆ιασύνδεσης του 
FineReader). 

! χρησιµοποιώντας το σχετικό παράθυρο διαλόγου του οδηγού TWAIN του 
σαρωτή: στην περίπτωση αυτή, θα ενεργοποιήσετε το παράθυρο διαλόγου που 
παρέχεται µε τον οδηγό TWAIN του σαρωτή για να ορίσετε τις παραµέτρους 
σάρωσης. η αντίστοιχη επιλογή είναι: Use TWAIN-Source Interface (Χρήση 
∆ιασύνδεσης Οδηγού-TWAIN). 

Και οι δύο προαναφερθέντες τρόποι λειτουργίας έχουν τα πλεονεκτήµατα, αλλά και τα 
µειονεκτήµατά τους:  

Με την επιλογή διασύνδεσης Use TWAIN-Source Interface, συνήθως διατίθεται 
παράλληλα και η δυνατότητα προεπισκόπησης της εικόνας. Η προεπισκόπηση σας δίνει 
τη δυνατότητα ορισµού της περιοχής σάρωσης καθώς και της ακριβούς ρύθµισης της 
φωτεινότητας. Το µειονέκτηµα είναι πως κάθε σαρωτής έχει διαφορετικό οδηγό 
TWAIN. Συµβουλευτείτε σχετικά το εγχειρίδιο του σαρωτή σας. 

Με την επιλογή Use FineReader interface, έχετε στη διάθεσή σας τα εξής πρόσθετα 
χαρακτηριστικά: α) µπορείτε να ψηφιοποιήσετε πολυσέλιδα έγγραφα σε σαρωτές που 
δε διαθέτουν αυτόµατο τροφοδότη (ADF) και β) µπορείτε να αποθηκεύσετε τις 
παραµέτρους σάρωσης σε ένα υπόδειγµα δεσµίδας αρχείων (*.fbt) και να τις 
χρησιµοποιήσετε αργότερα για άλλες δεσµίδες αρχείων. 

Μπορείτε εύκολα να εναλλαχθείτε από την µια κατάσταση λειτουργίας στην άλλη: 

! Στο παράθυρο διαλόγου Options (µενού Tools>Options), επιλέξτε την καρτέλα 
Scan/Open Image και κάντε επιλέξτε τον τρόπο λειτουργίας που επιθυµείτε � είτε 
τo Use TWAIN-Source interface, είτε το Use FineReader interface. 

Σηµείωση:    

1. Ορισµένοι σαρωτές δεν υποστηρίζουν την επιλογή Use FineReader interface, 
(δηλ. µπορεί να είναι απενεργοποιηµένη).  

2. Εάν θέλετε να εµφανίσετε το παράθυρο διαλόγου Scanner Settings σε κατάσταση 
λειτουργίας Use FineReader interface, επιλέξτε το στοιχείο Display options 
dialog before scanning, στην καρτέλα Scan/Open Image.  

Σηµαντικό: Συµβουλευτείτε την τεκµηρίωση που παρέχεται µε τον σαρωτής σας, για 
να µπορέσετε να κάνετε σωστή σύνδεση. Αφού έχετε συνδέσει τον σαρωτή µε τον 
υπολογιστή σας, µην ξεχάσετε να εγκαταστήσετε έναν οδηγό-TWΑIN και/ή µια 
εφαρµογή ψηφιοποίησης. 
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Για την έναρξη της ψηφιοποίησης: 

Κάντε κλικ στο εικονίδιο 1-Scan ή ενεργοποιήστε την αντίστοιχη επιλογή από το µενού 
File. Το παράθυρο Εικόνας (Image), µε την εικόνα της ψηφιοποιηµένης σελίδας, 
εµφανίζεται στο κεντρικό παράθυρο του FineReader. Εάν επιθυµείτε να ψηφιοποιήσετε 
πολλές σελίδες, κάντε κλικ στο δείκτη που βρίσκετε στη δεξιά πλευρά του εικονιδίου 1-
Scan και επιλέξτε το στοιχείο Scan Multiple Images. 

Εάν η διαδικασία ψηφιοποίησης δεν ενεργοποιηθεί άµεσα, θα εµφανιστεί ένα από τα 
ακόλουθα δύο παράθυρα διαλόγου: 

! Το παράθυρο διαλόγου του οδηγού TWAIN του σαρωτή. Ελέγξτε τις 
παραµέτρους σάρωσης και κάντε κλικ στο κουµπί OK για να ξεκινήσετε την 
ψηφιοποίηση.  

! Το παράθυρο διαλόγου, Scanner Settings. Ελέγξτε τις παραµέτρους σάρωσης και 
κάντε κλικ στο κουµπί OK για να ξεκινήσετε την ψηφιοποίηση.  

Συµβουλή: Εάν, µετά την ψηφιοποίηση των εικόνων θέλετε να ξεκινήσετε άµεσα την 
διαδικασία αναγνώρισης, µπορείτε να χρησιµοποιήσετε τις επιλογές Scan&Read ή 
Scan&Read Multiple Images:  

Κάντε κλικ στο δείκτη που βρίσκεται δεξιά από το κουµπί Scan&Read και από το 
µενού συντόµευσης που εµφανίζεται, επιλέξτε είτε το Scan&Read, είτε το 
Scan&Read Multiple Images. Η εικόνα της ψηφιοποιηµένης σελίδας θα εµφανιστεί 
στο παράθυρο Εικόνας, ενώ στο παράθυρο Κειµένου θα εµφανιστούν τα 
αποτελέσµατα της αναγνώρισης. Το αναγνωρισµένο κείµενο µπορεί να εξαχθεί σε µια 
από τις συνεργαζόµενες εφαρµογές ή να αποθηκευθεί σε διάφορες µορφές αρχείων. 

Ορισµός των Παραµέτρων Σάρωσης 
Η ποιότητα των αποτελεσµάτων αναγνώρισης έγκειται κυρίως στην ποιότητα της 
ψηφιοποιηµένης εικόνας. Η ποιότητα της εικόνας όµως, µπορεί να προσαρµοστεί σε 
µεγάλο βαθµό, ορίζοντας τις βασικές παραµέτρους σάρωσης: ανάλυση, λειτουργία 
σάρωσης και φωτεινότητα. 

Οι βασικές παράµετροι σάρωσης είναι οι εξής: 

! Ανάλυση (Resolution) � ορίστε την ανάλυση στα 300dpi για κανονικά κείµενα 
(µέγεθος γραµµατοσειράς 10pt. ή µεγαλύτερες) και στα 400-600 dpi για κείµενα 
µε µικρότερο µέγεθος γραµµατοσειράς (9pt.ή µικρότερες). 

! Λειτουργία σάρωσης � σε τόνους του γκρι (graycale).  
Ψηφιοποιώντας σε τόνους του γκρι είναι ο ιδανικός τρόπος σάρωσης για την 
διαδικασία αναγνώρισης. Εάν µπορείτε να ψηφιοποιήσετε τις εικόνες σας σε 
τόνους του γκρι, το πρόγραµµα θα ρυθµίσει αυτόµατα την φωτεινότητα. 

! Λειτουργία σάρωσης � σε άσπρο και µαύρο (black & white).  
Η λειτουργία αυτή επιτρέπει στο σύστηµα να ψηφιοποιεί σελίδες µε µεγαλύτερη 
ταχύτητα. Από την άλλη όµως, κάποια πληροφορία της εικόνας µπορεί να χαθεί 
στην πορεία. Αυτό µπορεί να έχει αρνητική επίδραση στην ποιότητα και ακρίβεια 
της αναγνώρισης, κυρίως σε έγγραφα µέτριας και κακής τυπογραφικής ποιότητας. 

! Λειτουργία σάρωσης � έγχρωµη (color).    
Εάν έχετε έγχρωµα έγγραφα τα οποία περιέχουν φωτογραφίες, έγχρωµους 
χαρακτήρες και φόντο, πιθανώς να θέλετε να διατηρήσετε τα χρώµατα αυτά και 
στο ηλεκτρονικό σας έγγραφο. Σε αυτή την περίπτωση, µπορείτε να 
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χρησιµοποιήσετε τη λειτουργία color αλλιώς, χρησιµοποιήστε τη λειτουργία 
ψηφιοποίησης gray (σε τόνους του γκρι).  

! Φωτεινότητα (Brightness) � στις περισσότερες περιπτώσεις, η µέση τιµή 
φωτεινότητας (50%), είναι ικανοποιητική. Πολλά έγγραφα, τα οποία 
ψηφιοποιούνται µε ασπρόµαυρη σάρωση, µπορεί να απαιτήσουν µια επιπλέον 
ρύθµιση της φωτεινότητας. 

Σηµείωση: Ψηφιοποιώντας στα 400-600 dpi (αντί της προεπιλεγµένης ανάλυσης, που 
είναι τα 300 dpi) ή ψηφιοποιώντας σε λειτουργία σάρωσης έγχρωµη ή σε τόνους του 
γκρι (αντί για ασπρόµαυρη), µπορεί να καθυστερήσει σηµαντικά την όλη διαδικασία. 
Σε ορισµένα µοντέλα σαρωτών, η ψηφιοποίηση µε ανάλυση 600 dpi, χρειάζεται τον 
τετραπλάσιο χρόνο από ότι η ψηφιοποίηση µε ανάλυση 300 dpi. 

Για να ρυθµίσετε τις παραµέτρους σάρωσης: 

! Εάν θέλετε να ψηφιοποιήσετε τις εικόνες σας χρησιµοποιώντας το FineReader 
TWAIN interface, στο µενού Tools (Εργαλεία), επιλέξτε το στοιχείο Scanner 
Settings (Ρυθµίσεις Σαρωτή). Εµφανίζεται το παράθυρο διαλόγου Scanner 
Settings, στο οποίο µπορείτε να ρυθµίστε τις παραµέτρους ψηφιοποίησης.  

! Εάν θέλετε να ψηφιοποιήσετε τις εικόνες σας µέσω του διαλόγου του οδηγού  
TWAIN του σαρωτή, κάντε κλικ πάνω στο κουµπί συντόµευσης 1-Scan. 
Εµφανίζεται αυτόµατα το παράθυρο διαλόγου TWAIN του σαρωτή σας, στο 
οποίο µπορείτε να ορίσετε τις παραµέτρους ψηφιοποίησης. Οι παράµετροι 
ψηφιοποίησης µπορεί να έχουν διαφορετικές ονοµασίες ανάλογα µε το µοντέλο 
του σαρωτή. για παράδειγµα, ο έλεγχος της φωτεινότητας µπορεί να εµφανίζεται 
χαρακτηριστικά σαν ένας "ήλιος" ή σαν ένας ασπρόµαυρος κύκλος. Οι εκάστοτε 
ρυθµίσεις περιγράφονται στο εγχειρίδιο χρήσης του σαρωτή σας.  

Συµβουλές για τη Ρύθµιση της Φωτεινότητας 
Η ψηφιοποιηµένη εικόνα πρέπει να είναι ευδιάκριτη. Για να µπορέσετε να την 
ελέγξετε, δείτε την εικόνα στο παράθυρο Μεγέθυνσης. 

Αυτό είναι ένα παράδειγµα ευδιάκριτης εικόνας  
(από την άποψη του OCR) 

Εάν διαπιστώσετε πως η ποιότητα της ψηφιοποιηµένης εικόνας δεν είναι καθόλου καλή 
(π.χ. οι χαρακτήρες είναι κολληµένοι ή κοµµένοι), συµβουλευτείτε τον παρακάτω 
πίνακα για την βελτιστοποίηση της ποιότητάς της.  

Οι εικόνες σας εµφανίζονται ως εξής: Πιθανή διόρθωση/βελτίωση: 

 
οι χαρακτήρες είναι "κοµµένοι" ή δεν 
είναι αρκετά ευδιάκριτοι 

! Προσπαθήστε να µειώσετε τη φωτει-
νότητα (έτσι, η εικόνα θα γίνει πιο 
σκούρα). 

! Προσπαθήστε να τη ψηφιοποιήσετε σε 
λειτουργία grayscale (σε τόνους του 
γκρι). Στην περίπτωση αυτή, χρησιµο-
ποιείται η αυτόµατη ρύθµιση της φωτει-
νότητας. 
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Οι εικόνες σας εµφανίζονται ως εξής: Πιθανή διόρθωση/βελτίωση: 

 
οι χαρακτήρες είναι παραµορφωµένοι ή 
κολληµένοι  

! Προσπαθήστε να µειώσετε τη φωτει-
νότητα (έτσι, η εικόνα θα γίνει πιο 
φωτεινή). 

! Προσπαθήστε να τη ψηφιοποιήσετε σε 
λειτουργία grayscale (σε τόνους του 
γκρι). Στην περίπτωση αυτή, χρησιµο-
ποιείται η αυτόµατη ρύθµιση της φωτει-
νότητας. 

Σάρωση Πολυσέλιδων Εγγράφων 
Το FineReader υποστηρίζει µια ειδική λειτουργία ψηφιοποίησης για την σάρωση 
πολυσέλιδων εγγράφων: Scan Multiple Images (Ψηφιοποίηση Πολυσέλιδων 
Εικόνων). Μέσω αυτής της λειτουργίας, µπορείτε να ψηφιοποιήσετε όσες σελίδες εσείς 
θέλετε. Παρ' όλα αυτά, σηµειώστε τα εξής: 

! Εάν ψηφιοποιήσετε τις εικόνες σας µέσω του FineReader TWAIN interface, ο 
σαρωτής δεν θα σταµατήσει µετά την ψηφιοποίηση της πρώτης σελίδας, αλλά θα 
συνεχίσει αυτόµατα µε την επόµενη.  

! Εάν ψηφιοποιήσετε τις εικόνες σας µέσω του TWAIN-Source interface, το 
παράθυρο διαλόγου TWAIN του σαρωτή σας δεν θα απενεργοποιηθεί µετά τη 
σάρωση µιας σελίδας. Έτσι, µπορείτε να συνεχίσετε την ψηφιοποίηση 
τοποθετώντας µια-µια τις επόµενες σελίδες στον σαρωτή σας. 

Υπάρχουν δύο τρόποι για να ψηφιοποιήσετε πολυσέλιδα έγγραφα: µπορείτε να 
χρησιµοποιήσετε έναν σαρωτή µε Αυτόµατο Τροφοδότη Σελίδας (ADF: Automatic 
Document Feeder) ή έναν απλό σαρωτή! 

Ψηφιοποιόντας µε έναν σαρωτή µε ADF: 

1. Στην περίπτωση που έχετε ενεργοποιηµένη την επιλογή Use FineReader 
interface, ενεργοποιήστε την επιλογή Use ADF (χρήση αυτόµατου τροφοδότη) 
στον διάλογο Scanner Setting (µενού Tools>Scanner Settings) και στη συνέχεια 
επιλέξτε από το µενού File>Scan Multiple Images για να ξεκινήσετε την σάρωση 
του πολυσέλιδου εγγράφου. 

2. Στην περίπτωση που έχετε ενεργοποιηµένη την επιλογή Use TWAIN-source 
interface, ενεργοποιήστε την επιλογή Use ADF στον αντίστοιχο διάλογο του 
σαρωτή σας. Να θυµάστε ότι η συγκεκριµένη επιλογή µπορεί ονοµάζεται 
διαφορετικά στο µοντέλο σαρωτή που έχετε. Θα χρειαστεί να συµβουλευτείτε τον 
εγχειρίδιο χρήσης του σαρωτή σας για να βρείτε την ακριβή διαδικασία). Για να 
ξεκινήσετε την διαδικασία σάρωσης θα πρέπει να επιλέξετε από το µενού 
File>Scan Multiple Images. 
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Ψηφιοποιώντας µε έναν σαρωτή χωρίς ADF: 

Στην περίπτωση που χρησιµοποιείτε το FineReader TWAIN interface επιλέξτε το 
στοιχείο Scan Multiple Images από το µενού File.  

Στην περίπτωση που χρησιµοποιείτε επίπεδο σαρωτή (flatbed scanner) χωρίς ADF, 
υπάρχουν δύο τρόποι για να αυξήσετε την άνεση και την αποτελεσµατικότητα µε την 
οποία θα ψηφιοποιήσετε πολυσέλιδα έγγραφα:  

! Ορίστε ένα χρόνο παύσης (pause) � είναι ο χρόνος, που θέλετε να µεσολαβεί, 
µεταξύ της στιγµής που ο σαρωτής έχει τελειώσει την ψηφιοποίηση µιας σελίδας 
και της στιγµής που θα ξεκινήσει την ψηφιοποίηση της επόµενης. Στο παράθυρο 
διαλόγου Scanner Settings (µενού Tools>Scanner Settings�), επιλέξτε Pause 
between pages (Παύση µεταξύ των σελίδων) και ορίστε τον χρόνο παύσης (σε 
δευτερόλεπτα). Σε αυτήν την κατάσταση λειτουργίας, ο σαρωτής δεν θα αρχίσει 
να ψηφιοποιεί την επόµενη σελίδα, αν πρώτα δεν περάσει το χρονικό διάστηµα, 
που έχουµε ορίσει. Έτσι, υπάρχει αρκετός χρόνος για να βάλετε την επόµενη 
σελίδα στον σαρωτή σας. Μετά την παύση αυτή, η διαδικασία ψηφιοποίησης 
συνεχίζεται αυτόµατα. 

! Στο παράθυρο διαλόγου Scanner Settings (µενού Tools>Scanner Settings), 
ενεργοποιήστε την επιλογή Stop between pages (∆ιακοπή µεταξύ των σελίδων). 
Κάθε φορά που ο σαρωτής ψηφιοποιεί µια σελίδα, θα εµφανίζεται ένα παράθυρο 
διαλόγου που θα ζητά την έγκρισή σας για την συνέχιση της ψηφιοποίησης. Κάντε 
κλικ στο κουµπί Yes (Ναι) για να συνεχίσετε ή στο No (Όχι) για να τερµατίσετε 
την ψηφιοποίηση. 

! Όταν τελειώσετε την ψηφιοποίηση των σελίδων σας, επιλέξτε Stop Scanning 
(Τερµατισµός Ψηφιοποίησης) από το µενού File.  

 

Στην περίπτωση που χρησιµοποιείτε το TWAIN-Source interface 

! Στο µενού File, επιλέξτε Scan Multiple Images. Εµφανίζεται το παράθυρο 
διαλόγου TWAIN του σαρωτή σας. Κάντε κλικ στο κουµπί Scan (ή σε όποιο 
κουµπί έχει την αντίστοιχη λειτουργία � ανάλογα µε το µοντέλο σαρωτή που 
διαθέτετε) για την εκκίνηση της διαδικασίας ψηφιοποίησης. 

! Ψηφιοποιήστε τη σελίδα σας, βάλτε την επόµενη σελίδα στον σαρωτή σας και στο 
παράθυρο διαλόγου TWAIN του σαρωτή σας, κάντε κλικ στο κουµπί Scan. 

! Όταν τελειώσετε την ψηφιοποίηση των σελίδων σας, στο παράθυρο διαλόγου 
TWAIN του σαρωτή σας, κάντε κλικ στο κουµπί Close (ή σε όποιο κουµπί έχει 
την αντίστοιχη λειτουργία � ανάλογα µε το µοντέλο σαρωτή που διαθέτετε ). 

Συµβουλή: Για να ελέγξετε, άµεσα, την ποιότητα των ψηφιοποιηµένων εικόνων σας, 
ενεργοποιήστε την επιλογή Open image during scanning (Άνοιγµα εικόνας κατά τη 
διάρκεια της ψηφιοποίησης) από την καρτέλα Scan/Open Image (µενού 
Tools>Options). Με την ενεργοποίηση της επιλογής αυτής, κάθε ψηφιοποιηµένη 
σελίδα εµφανίζεται στο παράθυρο Εικόνας αµέσως µετά την ψηφιοποίησή της. Εάν 
πιστεύετε ότι η εικόνα σας δεν έχει ψηφιοποιηθεί σωστά, σταµατήστε τη διαδικασία 
ψηφιοποίησης επιλέγοντας το Stop Scanning στο µενού File και ψηφιοποιήστε ξανά 
την εικόνα.  



 34

Άνοιγµα Αρχείων Εικόνας 
Ακόµα κι αν δεν έχετε στη διάθεσή σας κάποιο σαρωτή, µπορείτε να αναγνωρίσετε 
αρχεία εικόνας (ανατρέξτε στην ενότητα «Υποστηριζόµενες Μορφές Αρχείων 
Εικόνων» και δείτε τη λίστα υποστηριζόµενων µορφών αρχείων εικόνας). 

Για να ανοίξετε µια εικόνα: 

! Κάντε κλικ στο δείκτη που βρίσκεται δεξιά από το εικονίδιο 1-Scan και στο µενού 
συντόµευσης, επιλέξτε το στοιχείο Open Image (Άνοιγµα Εικόνας). Το εικονίδιο 
1-Scan θα αλλάξει ονοµασία - από Scan (Ψηφιοποίηση) θα µετονοµαστεί σε 
Open (Άνοιγµα). 

! Στο µενού File (Αρχείο), ενεργοποιήστε την επιλογή Open Image (Άνοιγµα 
Εικόνας).  

! Στην Εξερεύνηση των Windows κάντε δεξί κλικ στο αρχείο εικόνας που θέλετε να 
ανοίξετε και από το αναδυόµενο µενού επιλέξτε Open with FineReader. Αν το 
FineReader εκτελείται ήδη, η εικόνα θα προστεθεί στην τρέχουσα δεσµίδα. Στην 
αντίθετη περίπτωση το FineReader θα ξεκινήσει και θα ανοίξει την δεσµίδα µε την 
οποία εργαζόσασταν τελευταία. 

! Στο Microsoft Outlook ή στην Εξερεύνηση των Windows κάντε κλικ στο αρχείο 
της εικόνας που θέλετε να ανοίξετε  και µετακινήστε το στο λειτουργικό 
παράθυρο του FineReader. Η εικόνα θα προστεθεί στην τρέχουσα δεσµίδα και θα 
ανοιχτεί στο λειτουργικό παραθυρο Image.  

Στο παράθυρο διαλόγου Open (Άνοιγµα), επιλέξτε µια ή περισσότερες εικόνες. Οι 
επιλεγµένες εικόνες θα εµφανιστούν στο παράθυρο ∆εσµίδας Αρχείων και η τελευταία 
επιλεγµένη εικόνα θα εµφανιστεί στα παράθυρα Εικόνας και Μεγέθυνσης του 
FineReader. Όλες οι επιλεγµένες εικόνες αντιγράφονται στον κατάλογο της δεσµίδας 
αρχείων. Για περισσότερες πληροφορίες σχετικά µε την οργάνωση µιας δεσµίδας 
αρχείων και µε την εµφάνιση των σελίδων µέσα σε αυτή, ανατρέξτε στην ενότητα 
«Γενικά για την Εργασία µε ∆εσµίδες Αρχείων (Batches)». 

Συµβουλή: Για να συντοµεύσετε τη διαδικασία αναγνώρισης των ενεργών εικόνων, 
ενεργοποιήστε τη λειτουργία Open&Read (Άνοιγµα&Ανάγνωση):  

1. Στο µενού Process (Επεξεργασία), επιλέξτε το στοιχείο Open&Read ή απλά 
πατήστε συνδυαστικά τα λειτουργικά κουµπιά CTRL+Shift+D. Τότε, 
εµφανίζεται το παράθυρο διαλόγου Open (Άνοιγµα).  

2. Στο παράθυρο διαλόγου Open, επιλέξτε τις εικόνες που θέλετε να 
αναγνωρισθούν. 

Παρακολούθηση φακέλου (Hot Folder)  
(Μόνο για το Corporate Edition) 

Οι πολυ-συσκευές, που συνδυάζουν την λειτουργικότητα του σαρωτή, του εκτυπωτή, 
του φωτοτυπικού και -συχνά- του φαξ, µπορούν να χρησιµοποιηθούν για την προσθήκη 
εικόνων στο FineReader µε αυτόµατο τρόπο. 

Οι συσκευές αυτές συνδέονται στο δίκτυο και ρυθµίζονται να αποθηκεύουν τις 
σαρωµένες εικόνες σε ένα φάκελο του δικτύου. Το FineReader, µε την λειτουργία 
παρακολούθησης φακέλου µπορεί να παρακολουθεί έναν συγκεκριµένο φάκελο (Hot 
folder), ο οποίος βρίσκεται τοπικά, στο δίκτυο ή σε έναν FTP server, για νέα αρχεία. Σε 
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αυτή την κατάσταση λειτουργίας, το πρόγραµµα ανοίγει αυτόµατα όλες τις εικόνες, τα 
φαξ και τα αρχεία PDF, που τοποθετούνται στον hot folder. Τα νέα αυτά στοιχεία 
προστίθενται στην δεσµίδα του FineReader και διαγράφονται από τον hot folder. 

Για να ενεργοποιήσετε την παρακολούθηση φακέλου: 

! Επιλέξτε το στοιχείο Hot Folder� από το µενού File. 

! Επιλέξτε το στοιχείο Hot Folder από το µενού συντόµευσης του κουµπιού 
Scan&Read. 

Όταν ενεργοποιηθεί η παρακολούθηση φακέλου το εικονίδιο το Scan&Read θα 
αντικατασταθεί από το εικονίδιο του Hot Folder ( ). Αν παρουσιαστεί κάποιο 
πρόβληµα, το εικονίδιο θα αλλάξει στο ( ). Κάντε διπλό κλικ στο εικονίδιο για να 
δείτε το µήνυµα λάθους. 

Για να ενεργοποιήσετε την παρακολούθηση φακέλου: 

! Επιλέξτε το στοιχείο Disable Hot Folder από το µενού File. 

! Επιλέξτε το στοιχείο Disable Hot Folder από το µενού συντόµευσης του 
κουµπιού Scan&Read. 

Σάρωση ∆ιπλών Σελίδων 
Στην περίπτωση που θέλετε να ψηφιοποιήσετε ένα βιβλίο, είναι πιο εύκολο να 
ψηφιοποιήσετε την αριστερή και τη δεξιά σελίδα ταυτόχρονα (εµείς εδώ τις 
ονοµάζουµε διπλές σελίδες). Παρ' όλα αυτά, η ποιότητα της αναγνώρισης είναι πολύ 
καλύτερη εάν η διπλή σελίδα διασπαστεί σε δύο ξεχωριστές σελίδες µετά την 
ψηφιοποίηση έτσι ώστε, κάθε σελίδα της δεσµίδας αρχείων να αντιστοιχεί σε µια 
σελίδα του βιβλίου. Οι διαδικασίες αναγνώρισης και µορφολογικής ανάλυσης της 
σελίδας γίνονται για κάθε σελίδα ξεχωριστά. Εάν χρειαστεί, µπορεί να γίνει διόρθωση 
της κλίσης της κάθε σελίδας ξεχωριστά 

Εάν επιθυµείτε να γίνεται διαχωρισµός των διπλών σελίδων: 

! Πριν την ψηφιοποίηση, ενεργοποιήστε την επιλογή Split dual pages 
(∆ιαχωρισµός διπλών σελίδων) στην καρτέλα Scan/Open Image (µενού 
Tools>Options). 

Αν ενεργοποιήσετε τη συγκεκριµένη επιλογή, κάθε διπλή σελίδα θα διαχωριστεί σε δύο 
σελίδες της δεσµίδας αρχείων. Για περισσότερες πληροφορίες σχετικά µε τις δεσµίδες 
αρχείων, ανατρέξτε στην ενότητα «Γενικά για την Εργασία µε ∆εσµίδες Αρχείων 
(Batches)». 

Σηµείωση: Αν ο χωρισµός µιας διπλής σελίδας σε δύο δεν έγινε σωστά, τότε από-
επιλέξτε το κουτάκι Split dual pages και ξανασαρώστε ή ξαναπροσθέστε την σελίδα 
στην δεσµίδα. Στην συνέχεια χωρίστε την σελίδα "µε το χέρι" µέσω του διαλόγου Split 
Image (µενού Image>Split Image). 

Προσθήκη εικόνων επαγγελµατικών καρτών 
Στην περίπτωση που θελήσετε να ψηφιοποιήσετε επαγγελµατικές κάρτες, θα ήταν πιο 
πρακτικό να συλλάβετε την εικόνα περισσότερων από µια καρτών µε µία σάρωση -όσες 
περισσότερες χωρούν στον σαρωτή σας, τόσο το καλύτερο. Από την άλλη µεριά η 
ποιότητα της αναγνώρισης θα ήταν καλύτερη (π.χ. λόγω της αυτόµατης διόρθωσης 
κλίσης) αν κάθε κάρτα αντιµετωπιζόταν σαν ξεχωριστή σελίδα. Επιδιώκοντας να 



 36

συνδυάσει το καλύτερο και από τις δύο καταστάσεις το FineReader προσφέρει 
εργαλεία που επιτρέπουν τον αυτόµατο ή χειρωνακτικό διαχωρισµό καρτών που έχουν 
σαρωθεί σε συγκεκριµένη διάταξη.  

Για να χωρίσετε µια εικόνα: 

1. Επιλέξτε την σελίδα που θέλετε στο παράθυρο ∆εσµίδας 

2. Κάντε κλικ στην επιλογή Image>Split image. Ο διάλογος Split Image θα 
εµφανιστεί 

3. Πατήστε το πλήκτρο Split business cards 

Σηµείωση:  

1. Η σελίδα που µόλις χωρίσατε θα αφαιρεθεί από την δεσµίδα και την θέση της θα 
πάρουν τα επιµέρους τµήµατά της. Για περισσότερες λεπτοµέρειες αναφερθείτε 
στο υποκεφάλαιο «Γενικά για την εργασία µε δεσµίδες αρχείων» 

2. Αν ο χωρισµός της εικόνας δεν έγινε σωστά, δοκιµάστε να την χωρίσετε "µε το 
χέρι" προσθέτοντας διαχωριστικά µε τα πλήκτρα Add vertical seperator/Add 
horizontal seperator. 

3. Για να διαγράψετε όλα τα διαχωριστικά, πατήστε το πλήκτρο Remove all 
seperators 

4. Για να µετακινήσετε ένα διαχωριστικό, µπείτε σε κατάσταση επιλογής 
διαχωριστικών (πατώντας το πλήκτρο ) και στην συνέχεια επιλέξτε και 
µετακινήστε το διαχωριστικό 

5. Για να διαγράψετε ένα διαχωριστικό, µπείτε σε κατάσταση επιλογής 
διαχωριστικών (πατώντας το πλήκτρο ) και στην συνέχεια επιλέξτε και 
µετακινήστε το διαχωριστικό έξω από την εικόνα. 

Αρίθµηση των Σελίδων 
Κάθε ψηφιοποιηµένη σελίδα φέρει έναν αριθµό. Η αρίθµηση κατ� αρχήν γίνεται 
αυτόµατα δίνοντας σε κάθε νέα σελίδα τον επόµενο ακέραιο από αυτόν της τελευταίας 
σελίδας της δεσµίδας αρχείων. 

Η αρίθµηση των σελίδων µπορεί να οριστεί και από τον χρήστη. Για παράδειγµα, εάν 
θέλετε να διατηρήσετε την αρχική αρίθµηση των σελίδων ή όταν θέλετε να 
ψηφιοποιήσετε µια οµάδα σελίδων ταξινοµηµένων κατά αύξοντα αριθµό: 

! Στην καρτέλα Scan/Open Image (µενού Tools>Options), επιλέξτε το Ask for 
page number before adding page to the batch (Ζήτησε αριθµό σελίδας πριν 
την εισαγωγή σελίδας στη δεσµίδα αρχείων).  

Εάν ψηφιοποιείτε πολλές σελίδες διπλής όψεως ταξινοµηµένες κατά αριθµό: 

1. Στην καρτέλα Scan/Open Image (µενού Tools>Options), ενεργοποιήστε την 
επιλογή Ask for page number before adding page to the batch.  

2. Στο παράθυρο διαλόγου Page Number (Αριθµός Σελίδας), ορίστε τον αριθµό 
της πρώτης ψηφιοποιηµένης σελίδας και στη συνέχεια, στο πεδίο Page 
numbering (Αρίθµηση σελίδων), ενεργοποιήστε την επιλογή Odd and even 
separately (Μονές και ζυγές ξεχωριστά). Επιλέξτε την σειρά της αρίθµησης: 
ascending (αύξουσα) ή descending (φθίνουσα), ανάλογα µε τον τρόπο που 
τοποθετείτε τις διπλής όψεως σελίδες στον αυτόµατο τροφοδότη σελίδων, π.χ. εάν 
ο µεγαλύτερος ή ο µικρότερος αριθµός είναι στην αρχή.  
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Εργασίες πάνω στις Εικόνες 
! Καθαρισµός εικόνας (Despeckle image) 

! Αρνητικό εικόνας (Invert image) 

! Περιστροφή ή αναποδογύρισµα εικόνας (Rotate or flip image) 

! Καθαρισµός µπλοκ (Clear Block) 

! Μεγέθυνση/Σµίκρυνση της εικόνας (Increase/Decrease the image scale) 

! Πληροφορίες που αφορούν στην εικόνα (Get image information) 

! Εκτύπωση της εικόνας 

! Αναίρεση της τελευταίας ενέργειας (Undo the last action) 

 

1. Καθαρισµός Εικόνας (Despeckle image) 

Η αναγνωρισµένη εικόνα µπορεί να περιέχει πολύ "θόρυβο". Ο υπερβολικός αυτός 
αριθµός των κουκίδων, προέρχεται συνήθως από την ψηφιοποίηση µέτριας και κακής 
ποιότητας εγγράφων. Οι κουκίδες που βρίσκονται κοντά στο περίγραµµα των 
χαρακτήρων µπορεί να επηρεάσουν αρνητικά την ποιότητα των αποτελεσµάτων της 
αναγνώρισης. Για να ελαχιστοποιήσετε τον αριθµό των κουκίδων αυτών: 

! Στο µενού Image , ενεργοποιήστε την επιλογή Despeckle Image (Καθαρισµός 
Εικόνας).  

Εάν θέλετε να καθαρίσετε ένα συγκεκριµένο µπλοκ:  

! Στο µενού Image, ενεργοποιήστε την επιλογή Despeckle Μπλοκ (Καθαρισµός 
Μπλοκ). 

Σηµείωση: Στην περίπτωση που το πρωτότυπο είναι αχνό ή η γραµµατοσειρά του 
είναι πολύ λεπτή, ο καθαρισµός της εικόνας µπορεί να προκαλέσει την απώλεια 
ορισµένων σηµείων στίξεως (τελείες, κόµµατα, κ.ά.), καθώς και των πολύ µικρών και 
λεπτών χαρακτήρων, µε αποτέλεσµα την επιδείνωση της ποιότητας της αναγνώρισης. 

Εάν θέλετε να ψηφιοποιήσετε ή να ανοίξετε εικόνες που περιέχουν "θόρυβο", 
ενεργοποιήστε το στοιχείο Despeckle image (Καθαρισµός Εικόνας) από τη λίστα 
επιλογών Image preprocessing (Προεπεξεργασία Εικόνας), στην καρτέλα 
Scan/Open Image (µενού Tools>Options), για να καθαρίσετε τις εικόνες πριν την 
προσθήκη τους στη δεσµίδα αρχείων. 

2. Αρνητικό εικόνας (Invert image) 

Μερικοί σαρωτές αντιστρέφουν τα χρώµατα της εικόνας (µετατρέπουν το µαύρο χρώµα 
σε λευκό και το αντίστροφο) κατά τη διάρκεια της ψηφιοποίησης. 

Τότε ίσως θελήσετε να ενεργοποιήσετε την επιλογή Invert image (Αρνητικό Εικόνας) 
για να δώσετε στην εικόνα σας τη σωστή όψη, δηλ. µαύρη γραµµατοσειρά σε λευκό 
φόντο. Για να εφαρµόσετε τη συγκεκριµένη λειτουργία: 

! Στο µενού Image, επιλέξτε το στοιχείο Invert Image. 

Σηµείωση: Εάν πρόκειται να ψηφιοποιήσετε ή να ανοίξετε εικόνες που έχουν 
µετατραπεί, επιλέξτε το στοιχείο Invert Image από τη λίστα επιλογών Image 
preprocessing, στην καρτέλα Scan/Open Image (µενού Tools>Options), προτού 
προσθέσετε τις εικόνες αυτές στη δεσµίδα αρχείων. 
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3. Περιστροφή ή αναποδογύρισµα της εικόνας (Rotate or Flip image) 

Η ποιότητα των αποτελεσµάτων της αναγνώρισης εξαρτάται από το αν η εικόνα έχει 
τον καθιερωµένο προσανατολισµό (το κείµενο θα πρέπει να διαβάζεται από πάνω προς 
τα κάτω και οι γραµµές να είναι οριζόντιες). Το FineReader, εντοπίζει αυτόµατα την 
φορά της σελίδας κατά τη διάρκεια της αναγνώρισης. Εάν το FineReader εντοπίσει 
λανθασµένα την φορά της σελίδας, στην καρτέλα Scan/Open Image, απενεργοποιήστε 
την επιλογή Detect image orientation (during recognition) και περιστρέψτε την 
εικόνα, έτσι ώστε να έχει σωστό προσανατολισµό: 

! Κάντε κλικ στο κουµπί , ή επιλέξτε Rotate Clockwise (∆εξιά Περιστροφή), 
στο µενού Image για να περιστρέψετε την εικόνα κατά 90° µε την φορά των 
δεικτών του ρολογιού. 

! Κάντε κλικ στο κουµπί , ή επιλέξτε Rotate Counter-Clockwise (Αριστερή 
Περιστροφή), στο µενού Image, για να περιστρέψετε την κατά εικόνα 90° µε την 
αντίθετη φορά από αυτή των δεικτών του ρολογιού. 

! Στο µενού Image, επιλέξτε Rotate Upside Down (Αντιστροφή), για να 
περιστρέψετε την εικόνα κατά 180°. 

Για να αναποδογυρίσετε (flip) την εικόνα: 

! Οριζόντια (γύρω από τον κατακόρυφο άξονα) � στο µενού Image, επιλέξτε Flip 
Horizontal. 

! Κάθετα (γύρω από τον οριζόντιο άξονα) � στο µενού Image, επιλέξτε Flip 
Vertical.  

4. Καθαρισµός των µπλοκ (Clear Block) 

Εάν θέλετε να αναγνωρίσετε κάποιο τµήµα της εικόνας ή εάν υπάρχουν µεγάλα 
κοµµάτια της εικόνας που περιέχουν "θόρυβο", µπορείτε απλά να τα διαγράψετε. Για 
να γίνει αυτό: 

! Επιλέξτε το εργαλείο  και στη συνέχεια, επιλέξτε εκείνο το τµήµα της εικόνας 
που επιθυµείτε να διαγράψετε, κρατώντας πατηµένο το αριστερό πλήκτρο του 
ποντικιού. Αφήστε ελεύθερο το ποντίκι και το επιλεγµένο τµήµα της εικόνας θα 
διαγραφεί. 

5. Μεγέθυνση/Σµίκρυνση της εικόνας (Increase/Decrease the image scale) 

! Στη γραµµή εργαλείων Image Tools, επιλέξτε το εργαλείο /  και κάντε κλικ 
στην εικόνα. Τότε, η εικόνα διπλασιάζεται/µειώνεται κατά το ήµισυ.  

! Κάντε δεξί κλικ πάνω στην εικόνα και επιλέξτε Scale (Κλίµακα). Στη συνέχεια, 
επιλέξτε από το µενού συντόµευσης, την κλίµακα µεγέθους που επιθυµείτε. 

6. Πληροφορίες που αφορούν στην εικόνα (Get image information) 

Μπορείτε να έχετε τις ακόλουθες πληροφορίες: ύψος και πλάτος της εικόνας σε pixel, 
κατακόρυφη και οριζόντια ανάλυση σε dpi, τύπος εικόνας. 

! Κάντε δεξί κλικ πάνω στην εικόνα και από το εµφανιζόµενο µενού, επιλέξτε το 
στοιχείο Properties (Ιδιότητες). Εµφανίζεται ένα παράθυρο διαλόγου, το οποίο 
εµφανίζει τις παραπάνω πληροφορίες στην καρτέλα Image (Εικόνα).  

7. Εκτύπωση της εικόνας 

Μπορείτε να τυπώσετε την εικόνα που είναι ανοιχτή στο παράθυρο Εικόνας, τις 
εικόνες που είναι επιλεγµένες στο παράθυρο ∆εσµίδας ή ακόµη και όλες τις εικόνες 
της δεσµίδας: 
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! Επιλέξτε το Print Image από το µενού File. Στον διάλογο που θα εµφανιστεί 
ορίστε τις κατάλληλες παραµέτρους (εκτυπωτή, αριθµό σελίδων προς εκτύπωση, 
πλήθος αντιγράφων κ.λπ) και πατήστε το πλήκτρο ΟΚ. 

8. Αναίρεση της τελευταίας ενέργειας (Undo the last action) 

! Για να αναιρέσετε την τελευταία ενέργεια, κάντε κλικ στο κουµπί αναίρεσης 
Undo , στη Βασική γραµµή εργαλείων. 

Συµβουλή: Για να ακυρώσετε την αναίρεση µιας ενέργειας στη Βασική γραµµή 
εργαλείων (Standard), κάντε κλικ στο κουµπί ακύρωσης αναίρεσης Redo . 

Ρυθµίσεις ∆εσµίδας Εικόνων 
Μετατροπή των έγχρωµων και σε τόνους του γκρι εικόνων σε ασπρόµαυρες (µενού 
Tools>Options, καρτέλα Scan/Open Image) 

Eπιλέξτε Convert color and gray images to black and white, όταν θέλετε να 
ψηφιοποιήσετε τις εικόνες σας σε λειτουργία grayscale (σε τόνους του γκρι) 
χρησιµοποιώντας το TWAIN-Source interface, στις οποίες δεν υπάρχουν έγχρωµες 
φωτογραφίες, έγχρωµες γραµµατοσειρές και φόντο, ή δεν ενδιαφέρεστε να τα 
διατηρήσετε. Ενεργοποιώντας την επιλογή αυτή, οι εικόνες ψηφιοποιούνται σε τόνους 
του γκρι και στη συνέχεια µετατρέπονται σε ασπρόµαυρες, µε αποτέλεσµα  να 
καταλαµβάνουν λιγότερο χώρο στο σκληρό δίσκο. 
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Κεφάλαιο 5  
Μορφολογική Ανάλυση Σελίδας 

Πριν την εκκίνηση της διαδικασίας αναγνώρισης, το ABBYY FineReader πρέπει να 
«γνωρίζει» πια τµήµατα της εικόνας θα αναγνωριστούν. Η «ανάγκη» αυτή του 
προγράµµατος, καλύπτεται από τη λειτουργία µορφολογικής ανάλυσης της σελίδας. Η 
λειτουργία αυτή ορίζει µπλοκ κειµένων, µπλοκ φωτογραφιών, µπλοκ πινάκων και 
µπλοκ µε barcodes.  

Στο κεφάλαιο αυτό θα ενηµερωθείτε για το πότε µπορεί να είναι χρήσιµη η επέµβαση 
του χρήστη στη µορφολογική ανάλυση της σελίδας, ποιοι τύποι µπλοκ υπάρχουν, πώς 
µπορείτε να επεξεργασθείτε τα µπλοκ που έχουν σχηµατιστεί µέσω της διαδικασίας της 
αυτόµατης µορφολογικής ανάλυσης της σελίδας, καθώς επίσης και πώς µπορεί να γίνει 
πιο εύκολη η διαδικασία µορφολογικής ανάλυσης της σελίδας χρησιµοποιώντας 
υποδείγµατα µπλοκ. 

Περιεχόµενα Κεφαλαίου:  

! Γενικά για τη µορφολογική ανάλυση των σελίδων 

! Κατηγορίες µπλοκ 

! Αυτόµατη µορφολογική ανάλυση 

! Ορισµός των µπλοκ από τον χρήστη 

! Ορισµός της δοµής ενός πίνακα από το χρήστη 

! Χρήση υποδειγµάτων µπλοκ 
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Γενικά για την Μορφολογική Ανάλυση των Σελίδων 
Η µορφολογική ανάλυση των σελίδων µπορεί να γίνει, είτε αυτόµατα, είτε µε τη 
βοήθεια του χρήστη. Στις περισσότερες περιπτώσεις, το FineReader αναλαµβάνει από 
µόνο του να διεκπεραιώσει την πολύπλοκη διαδικασία της µορφολογικής ανάλυσης της 
σελίδας. Κάνοντας κλικ πάνω στο κουµπί 2-Read. η µορφολογική ανάλυση της σελίδας 
θα πραγµατοποιηθεί ταυτόχρονα µε την αναγνώρισή της.  

Σηµείωση: Επιπλέον, το πρόγραµµα διαθέτει µια αυτόνοµη (stand-alone) λειτουργία 
ανάλυσης σελίδας (µενού Process>Analyze Layout). Αν χρειαστεί µπορείτε να 
ενεργοποιήσετε τη συγκεκριµένη λειτουργία. Πρέπει, όµως, να λάβετε υπόψη σας πως 
στην περίπτωση αυτή, η ποιότητα της µορφολογικής ανάλυσης της σελίδας µπορεί να 
είναι κατώτερη. Αυτό συµβαίνει, διότι κατά τη διπλή διαδικασία �µορφολογική 
ανάλυση και αναγνώριση της σελίδας� που εκτελείται µέσω του προαναφερθέντος 
λειτουργικού κουµπιού, χρησιµοποιούνται επιπλέον πληροφορίες, οι οποίες 
συλλέγονται κατά τη διάρκεια της αναγνώρισης, και αποσκοπούν στη βελτίωση της 
µορφολογική ανάλυση της σελίδας. 

Ο ορισµός των µπλοκ από τον χρήστη µπορεί να φανεί χρήσιµος 
στις ακόλουθες περιπτώσεις: 

1. Εάν θέλετε να αναγνωρίσετε µόνο ένα τµήµα της σελίδας 

2. Όταν ο ορισµός των µπλοκ µέσω της αυτόµατης µορφολογικής ανάλυσης δεν 
γίνεται σωστά. 

Συµβουλή:   

! Σε µερικές περιπτώσεις, η ποιότητα των αποτελεσµάτων της µορφολογικής 
ανάλυσης µπορεί να βελτιωθεί, προσαρµόζοντας ανάλογα τις ρυθµίσεις της 
µορφολογικής ανάλυσης της σελίδας. Ελέγξτε τις ενεργές ρυθµίσεις της 
µορφολογικής ανάλυσης (στην καρτέλα Recognition, µενού Tools>Options).  

! Στην περίπτωση που το πρόγραµµα σχεδιάσει λανθασµένα µερικά µπλοκ, 
συνήθως είναι πιο αποτελεσµατικό να τροποποιήσετε τα λανθασµένα µπλοκ µε τη 
βοήθεια των εργαλείων επεξεργασίας των µπλοκ, αντί να διαγράψετε όλα τα 
µπλοκ και να τα σχεδιάσετε µόνοι σας από την αρχή. 

Κατηγορίες Μπλοκ 
Τα µπλοκ είναι τµήµατα της εικόνας, τα οποία περικλείονται από πλαίσια. Τα µπλοκ 
ενηµερώνουν το σύστηµα για τα τµήµατα της εικόνας που πρέπει να αναγνωρισθούν 
και τη σειρά µε την οποία πρέπει να γίνει η αναγνώριση. Επιπλέον, τα µπλοκ 
επηρεάζουν τον τρόπο µε τον οποίο διατηρείται η πρωτότυπη µορφοποίηση της 
σελίδας. Τα µπλοκ διαφορετικού τύπου περικλείονται από πλαίσια διαφορετικού 
χρώµατος. Εάν θέλετε να αλλάξετε το χρώµα των πλαισίων των µπλοκ, ενεργοποιήστε 
την καρτέλα View (Εµφάνιση) στο παράθυρο διαλόγου Options (µενού 
Tools>Options) µέσα από τη οµάδα επιλογών Appearance (Εµφάνιση). Στο πεδίο 
Item, επιλέξτε τον επιθυµητό τύπο µπλοκ και στο πεδίο Color, επιλέξτε το χρώµα που 
θέλετε. 
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Το πρόγραµµα υποστηρίζει τους ακόλουθους τύπους µπλοκ: 

Recognition area (Περιοχή αναγνώρισης) � ο συγκεκριµένος τύπος µπλοκ 
χρησιµοποιείται για τη διαδικασία αυτόµατης αναγνώρισης και ανάλυσης. Αφού κάνετε 
κλικ πάνω στο κουµπί συντόµευσης 2-Read, όλα τα µπλοκ αυτού του τύπου θα µπουν 
αυτόµατα στη διαδικασία αναγνώρισης και ανάλυσης.  

Text  (Κείµενο) � αυτός ο τύπος µπλοκ χρησιµοποιείται για αυτά τα τµήµατα της 
εικόνας που περιέχουν κείµενο. Το µπλοκ θα πρέπει να περιέχει µόνο κείµενο, το οποίο 
να είναι δοµηµένο σε µια στήλη. Στην περίπτωση που υπάρχουν φωτογραφίες µέσα στο 
κείµενο, σχεδιάστε ξεχωριστά µπλοκ για κάθε ένα από αυτά. 

Table (Πίνακας) � ο συγκεκριµένος τύπος µπλοκ χρησιµοποιείται για τα τµήµατα της 
εικόνας που περιέχουν εικόνες και κείµενο δοµηµένο µέσα σε ένα πίνακα. Όταν το 
πρόγραµµα διαβάζει µπλοκ τέτοιου είδους, ορίζει κάθετα και οριζόντια διαχωριστικά 
µέσα στο ίδιο το µπλοκ, µε σκοπό να δηµιουργήσει ένα πίνακα. Αυτό το µπλοκ 
αντιστοιχεί σε ένα πίνακα στο τελικό κείµενο. Η επεξεργασία και ο ορισµός των κελιών 
µέσα στον πίνακα µπορεί να γίνουν και από τον χρήστη. 

Picture (Φωτογραφία) � αυτός ο τύπος µπλοκ χρησιµοποιείται για τα τµήµατα της 
εικόνας που περιέχουν φωτογραφίες. Ότι περιέχεται µέσα σε ένα τέτοιο µπλοκ θα 
µεταφερθεί στο τελικό κείµενο ως εικόνα (µπορεί να είναι πράγµατι µια φωτογραφία ή 
οποιοδήποτε άλλο αντικείµενο π.χ. ένας σύνθετος µαθηµατικός τύπος που δεν µπορεί 
να αναγνωριστεί σωστά από το FineReader). 

Barcode (διαθέσιµο µόνο στην έκδοση Corporate Edition) � αυτός ο τύπος µπλοκ 
χρησιµοποιείται για τα τµήµατα της εικόνας που περιέχουν στοιχεία barcode. Εάν το 
έγγραφό σας περιέχει κάποιο τυπωµένο barcode και δεν θέλετε να εµφανίζεται στο 
αποτέλεσµα σαν φωτογραφία, αλλά σαν µια σειρά από γράµµατα και αριθµούς, 
σχεδιάστε ένα ξεχωριστό µπλοκ για το barcode αυτό και ορίστε ως τύπο του µπλοκ το 
barcode. 

Σηµείωση: Υπάρχει µια επιλογή που επιτρέπει την αυτόµατη ανάλυση και 
αναγνώριση των barcode, η οποία δεν είναι προεπιλεγµένη. Για να τη επιλέξετε, 
ενεργοποιήστε την επιλογή Look for barcodes (Αναζήτηση barcode), στην καρτέλα 
Recognition (µενού Tolls>Options).  

Αυτόµατη Μορφολογική Ανάλυση 
Η διαδικασία της αυτόµατης µορφολογικής ανάλυσης σελίδων ορίζει τους παρακάτω 
τύπους µπλοκ: µπλοκ για κείµενο, µπλοκ για πίνακες, µπλοκ για φωτογραφίες και 
µπλοκ για barcode (το τελευταίο είναι διαθέσιµο µόνο στην έκδοση Corporate Edition). 

Η διαδικασία της αυτόµατης µορφολογικής ανάλυσης της σελίδας (σε συνδυασµό µε 
την αναγνώριση κειµένου), τίθεται σε λειτουργία κάνοντας κλικ στο κουµπί 2-Read. 
Πριν ενεργοποιήσετε το συγκεκριµένο κουµπί, θα πρέπει να ρυθµίσετε τις βασικές 
παραµέτρους µορφολογικής ανάλυσης: τον τύπο εγγράφου και τις ρυθµίσεις για την 
ανάλυση των πινάκων. 

Τύπος εγγράφου 

Στις περισσότερες περιπτώσεις, η µορφοποίηση του κειµένου εντοπίζεται αυτόµατα. Η 
αυτόµατη ανίχνευση πραγµατοποιείται όταν έχει, ήδη, ενεργοποιηθεί η Autodetect 
layout (Αυτόµατη ανίχνευση µορφοποίησης) στην καρτέλα Recognition, από τη 
λίστα επιλογών Document Type (Τύπος Εγγράφου) (µενού Tools>Options). Η 
επιλογή αυτή, είναι η προεπιλεγµένη. 
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Στην περίπτωση που θέλετε να την ενεργοποιήσετε εσείς οι ίδιοι: 

! Στο παράθυρο διαλόγου Options (µενού Tools>Options), ενεργοποιήστε την 
καρτέλα Recognition και επιλέξτε το αντίστοιχο στοιχείο από τη λίστα επιλογών 
Document Type.  

Υποστηριζόµενοι τύποι εγγράφων: 

Autodetect layout  
(Αυτόµατη ανίχνευση 
µορφοποίησης) 

! δηλώνει ότι η µορφοποίηση του κειµένου θα 
ανιχνεύεται αυτόµατα. Η λειτουργία αυτή είναι 
η προεπιλεγµένη. Όταν ενεργοποιηθεί η συγκε-
κριµένη λειτουργία, η αναγνώριση όλων των 
τύπων κειµένου, συµπεριλαµβανοµένων των 
πολύστηλων κειµένων, κειµένων µε πίνακες και 
φωτογραφίες, πραγµατοποιείται αυτόµατα. 

Single column 
(Μονή στήλη) 

! δηλώνει ότι το κείµενο δοµείται σε µια στήλη. Η 
ρύθµιση αυτή χρησιµοποιείται όταν η αυτόµατη 
µορφοποίηση της σελίδας έχει αναγνωρίσει, 
λανθασµένα, τον τύπο κειµένου ως πολύστηλο. 

Plain text formatted with 
spaces 
(Απλό κείµενο 
µορφοποιηµένο µε κενά) 

! δηλώνει ότι το κείµενο είναι µονόστηλο, µε 
γραµµατοσειρά µονού διαστήµατος (monospa-
ced) του ίδιου µεγέθους. Στο αναγνωρισµένο 
κείµενο τα αριστερά περιθώρια αναπαριστώνται 
µε κενά, κάθε γραµµή εµφανίζεται σαν µια 
ξεχωριστή παράγραφος και οι πρωτότυπες 
παράγραφοι διαχωρίζονται µεταξύ τους από 
κενές γραµµές. Η συγκεκριµένη λειτουργία 
µπορεί να χρησιµοποιηθεί, για παράδειγµα, όταν 
έχετε να αναγνωρίσετε εκτυπώσεις µε κώδικα 
C++ ή εκτυπώσεις από παλιό υπολογιστή. 

Ρυθµίσεις ανάλυσης πινάκων 

Στις περισσότερες των περιπτώσεων, το πρόγραµµα διαιρεί αυτόµατα τον πίνακα σε 
γραµµές και στήλες. Εάν επιθυµείτε να γίνουν επέµβαιτε στις ρυθµίσεις, που αφορούν 
την ανάλυση πινάκων, µπορείτε να το κάνετε στην οµάδα επιλογών Tables (Πίνακες), 
της καρτέλας Recognition. Μπορείτε να προσαρµόστε ανάλογα τις ρυθµίσεις αυτές, 
όταν: 

! Κατά τη διάρκεια της αυτόµατης ανάλυσης της µορφοποίησης των σελίδων οι 
γραµµές και οι στήλες των πινάκων έχουν σχηµατιστεί λανθασµένα. 

! Το έγγραφο περιέχει πολύ απλούς πίνακες του ίδιου τύπου (π.χ. µέσα στον πίνακα 
δεν υπάρχουν συγχωνευµένα κελιά ή υπάρχει µόνο µια γραµµή κειµένου ανά 
κελί). 

1. Ενεργοποιήστε την επιλογή One line of text per cell (Μια γραµµή κειµένου ανά 
κελί), κάθε φορά που αντιµετωπίζετε την περίπτωση ενός πίνακα που δεν περιέχει 
καθόλου (ή περιέχει ελάχιστα) διαχωριστικά και στον οποίο κάθε κελί περιέχει 
µόνο µια γραµµή κειµένου. Ένα παράδειγµα:   
 

Kilometers Miles 

1 0,62 

5 3,1 

! ο συγκεκριµένος πίνακας περιέχει µόνο 
µια γραµµή κειµένου ανά κελί 
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Physical 
Phenomenon 

t, degrees 
centigrade 

Water boiling 
point 100 

Water freezing 
point 0 

! ο συγκεκριµένος πίνακας περιέχει περισ-
σότερες από µια γραµµές κειµένου ανά 
κελί 

2. Χρησιµοποιείστε την επιλογή No merged cells in table (Μη συγχωνευµένα 
κελιά µέσα στον πίνακα), στην περίπτωση που έχετε πίνακες, οι οποίοι δεν 
περιέχουν συγχωνευµένα κελιά. Ένα παράδειγµα πίνακα µε συγχωνευµένα κελιά:  
 

Temperature 

Degrees 
centigrade 

Degrees 
Kelvin 

-273 0 

100 373 

! το κελί Temperature είναι ένα συγχω-
νευµένο κελί 

Σηµείωση: Εάν µέσα στο κείµενό σας υπάρχουν πίνακες διαφορετικής δοµής από τα 
παραπάνω παραδείγµατα, µην θέσετε σε λειτουργία τις επιλογές One line of text per 
cell και No merged cells in table. Με την επιλογή των στοιχείων αυτών µπορεί να 
προκληθούν λάθη στην µορφολογική ανάλυση της σελίδας και επιπλέον, να επηρεαστεί 
αρνητικά η ποιότητα των αποτελεσµάτων της αναγνώρισης.  

Ορισµός και Επεξεργασία των Μπλοκ από τον Χρήστη 

 

 

Μορφολογική ανάλυση 

Περιοχή αναγνώρισης 

Μπλοκ κειµένου 

Μπλοκ πίνακα 

Μπλοκ εικόνας 

Επιλογέας αντικειµένων 

Προσθήκη τµήµατος µπλοκ 

Αφαίρεση τµήµατος µπλοκ 

∆ιαγραφή µπλοκ 

Επανα-αρίθµηση µπλοκ 

Προσθήκη κατακόρυφου διαχωριστικού 

Προσθήκη οριζόντιου διαχωριστικού 

∆ιαγραφή διαχωριστικού 

Σµίκρυνση 

Μεγέθυνση 

Γόµα 

 

Εργαλεία
σχεδιασµού

µπλοκ

Εργαλεία
επεξεργασίας

µπλοκ
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Για τη δηµιουργία ενός νέου µπλοκ: 

1. Επιλέξτε ένα από τα ακόλουθα εργαλεία:  

 - για να ορίσετε µια περιοχή αναγνώρισης 

 - για να ορίσετε ένα µπλοκ κειµένου 

 - για να ορίσετε ένα µπλοκ φωτογραφίας 

 - για να ορίσετε ένα µπλοκ πίνακα. 

2. Τοποθετήστε το ποντίκι σας στο σηµείο όπου θέλετε να δηµιουργηθεί η µια γωνία 
του µπλοκ. Κρατήστε πατηµένο το αριστερό πλήκτρο του ποντικιού σας και 
σύρετε το δείκτη έως το σηµείο όπου επιθυµείτε να δηµιουργηθεί η αντι-
διαµετρική γωνία του µπλοκ. 

3. Αφήστε ελεύθερο το πλήκτρο του ποντικιού. 

Ένα πλαίσιο θα σχηµατιστεί γύρω από την περιοχή της εικόνας που επιλέξατε. 

Στη συνέχεια, µπορείτε να αλλάξετε τον τύπο του µπλοκ. Το τύπος του µπλοκ που 
ορίσθηκε µπορεί να είναι ένας από τους ακόλουθους: Recognition Area (Περιοχή 
Αναγνώρισης), Text (Κείµενο), Table (Πίνακας), Φωτογραφία (Picture) ή Barcode. 
Για να τροποποιήσετε τον τύπο του µπλοκ: 

! Κάντε δεξί κλικ πάνω στο µπλοκ και επιλέξτε το στοιχείο Block Type (Τύπος 
Μπλοκ) και στη συνέχεια, επιλέξτε τον αντίστοιχο τύπο µπλοκ στο µενού 
συντόµευσης. 

Τροποποίηση των Μπλοκ 

Για να µετακινήσετε τα περιθώρια του µπλοκ: 

1. Κάντε κλικ πάνω στο περιθώριο του µπλοκ και κρατήστε πατηµένο το αριστερό 
πλήκτρο του ποντικιού. Ο δείκτης του ποντικιού θα γίνει ένα διπλό βέλος. 

2. Σύρετε το δείκτη του ποντικιού στην κατεύθυνση που επιθυµείτε. 

3. Αφήστε ελεύθερο το πλήκτρο του ποντικιού. 

Σηµείωση: Εάν κάνετε κλικ πάνω σε µια γωνία του µπλοκ, θα σύρετε ταυτόχρονα το 
οριζόντιο και το κάθετο περιθώριο του µπλοκ. 

Για να προσθέσετε ένα ορθογώνιο τµήµα στο µπλοκ: 

1. Επιλέξτε το εργαλείο . 

2. Κάντε κλικ πάνω στο µπλοκ στο οποίο θέλετε να προσθέσετε ένα συγκεκριµένο 
κοµµάτι. Πιέστε και κρατήστε πατηµένο το αριστερό πλήκτρο του ποντικιού και 
έπειτα, σύρετε το δείκτη του ποντικιού διαγωνίως. Επιλέξτε το τµήµα της εικόνας 
που θέλετε να προσθέσετε στο µπλοκ και αφήστε ελεύθερο το πλήκτρο του 
ποντικιού. Το ορθογώνιο τµήµα που έχετε σχηµατίσει θα προστεθεί στο µπλοκ. 

3. Εάν χρειαστεί, µετακινήστε τα περιθώρια του µπλοκ. 

Για να αποκόψετε ένα ορθογώνιο τµήµα του µπλοκ:  

1. Επιλέξτε το εργαλείο . 

2. Κάντε κλικ πάνω στο µπλοκ από το οποίο θέλετε να αφαιρέσετε ένα τµήµα. 
Πιέστε και κρατήστε πατηµένο το αριστερό πλήκτρο του ποντικιού και στη 
συνέχεια, σύρετε το δείκτη του ποντικιού διαγωνίως. Επιλέξτε εκείνο το κοµµάτι 



 46

της εικόνας που επιθυµείτε να αποκόψετε και αφήστε ελεύθερο το πλήκτρο του 
ποντικιού. Το επιλεγµένο ορθογώνιο τµήµα του µπλοκ θα αφαιρεθεί. 

3. Εάν χρειαστεί, µετακινήστε τα περιθώρια του µπλοκ. 

Σηµείωση:  

1. Μπορείτε να αλλάξετε τα περιθώρια των µπλοκ, προσθέτοντας νέους κόµβους 
(σηµεία τοµής) σε αυτά. Με την βοήθεια του ποντικιού µπορείτε να µετακινήσετε 
τα κοµµάτια που θα προκύψουν µε τον τρόπο αυτό όπως σας βολεύει. 
Για να προσθέσετε ένα νέο κόµβο κάντε κλικ στο επιθυµητό σηµείο του 
περιθωρίου του µπλοκ, έχοντας πατηµένο το πλήκτρο Shift. 

2. Το FineReader θέτει ορισµένους περιορισµούς στο σχήµα των µπλοκ. Οι 
περιορισµοί αυτοί προκύπτουν από το γεγονός ότι οι γραµµές του κειµένου πρέπει 
να είναι ενιαίες, γιατί αλλιώς δεν είναι δυνατή η αναγνώρισή τους. Για τον σκοπό 
αυτό το FineReader είτε διορθώνει τα όρια των µπλοκ αυτόµατα είτε εµποδίζει 
κάποιες ενέργειες, κατά την µετακίνηση των ορίων των µπλοκ. Π.χ. εάν 
αποκόψετε τµήµα από το πάνω ή το κάτω µέρος ενός µπλοκ, τότε θα αφαιρέσετε 
αναγκαστικά µια γωνία του µπλοκ ή εάν προσπαθήσετε να αφαιρέσετε ένα 
κοµµάτι µεταξύ των δύο γωνιών που βρίσκονται είτε στην πάνω, είτε στην κάτω 
πλευρά του µπλοκ, η εφαρµογή θα ενεργήσει σαν να είχατε αφαιρέσει τη δεξιά 
γωνία του µπλοκ (από την πάνω ή την κάτω µεριά του µπλοκ, αντίστοιχα).  

Για να επιλέξετε ένα ή περισσότερα µπλοκ: 

! Επιλέξτε το εργαλείο  και κάντε κλικ πάνω στο αντίστοιχο µπλοκ ή πατήστε το 
αριστερό πλήκτρο του ποντικιού και σύρετε το δείκτη πάνω από τα µπλοκ που 
επιθυµείτε να επιλέξετε. 

Σηµείωση: Μπορείτε να επιλέξετε ένα ή περισσότερα µπλοκ χρησιµοποιώντας τα 
συνήθη εργαλεία σχεδίασης. Για να επιλέξετε µερικά µπλοκ µαζί, κρατήστε πατηµένο 
το πλήκτρο Shift, έχοντας επιλεγµένο ένα από τα παρακάτω εργαλεία: , ,  ή  

 και σύρετε το δείκτη του ποντικιού πάνω από τα µπλοκ που επιθυµείτε να 
επιλέξετε. Για να αναστρέψετε την επιλογή (για την προσθήκη µη επιλεγµένων µπλοκ ή 
για την αναίρεση ενός επιλεγµένου µπλοκ), κρατήστε πατηµένο το πλήκτρο CTRL σε 
συνδυασµό µε ένα από τα παρακάτω εργαλεία: , ,  ή   και σύρετε το δείκτη 
του ποντικιού πάνω από τα αντίστοιχα µπλοκ. 

Για να µετακινήσετε µπλοκ: 

! Κρατήστε πατηµένο το πλήκτρο ALT µαζί µε ένα από τα παρακάτω εργαλεία, 
κατ� επιλογή: , , ,  ή   και µετακινήστε τα µπλοκ. 

Για να αλλάξετε την αρίθµηση των µπλοκ: 

1. Επιλέξτε το εργαλείο . 

2. Κάντε κλικ πάνω στα µπλοκ µε τη σειρά που θέλετε. Τα περιεχόµενα των µπλοκ 
θα εµφανιστούν στο αποτέλεσµα του κειµένου µε την ίδια σειρά. 

Σηµείωση: Εάν αλλάξετε την αρίθµηση των µπλοκ µέσα σε µια, ήδη, αναγνωρισµένη 
εικόνα, το αναγνωρισµένο κείµενο που εµφανίζεται στο παράθυρο Κειµένου, θα 
ταξινοµηθεί αντίστοιχα.  

Για να διαγράψετε ένα µπλοκ: 

! Επιλέξτε το εργαλείο  και κάντε κλικ πάνω στο µπλοκ που επιθυµείτε να 
διαγράψετε. 

! Εναλλακτικά επιλέξτε τα µπλοκ που θέλετε και πατήστε το πλήκτρο DEL. 
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Σηµείωση: Εάν διαγράψετε ένα, ήδη, αναγνωρισµένο κείµενο, θα διαγραφεί 
αντίστοιχα και το κείµενο που εµφανίζεται στο παράθυρο Κειµένου. 

Για να διαγράψετε όλα τα µπλοκ από την εικόνα: 

! Στο µενού Batch (∆εσµίδα Αρχείων), επιλέξτε το στοιχείο Delete Blocks and 
Text (∆ιαγραφή των Μπλοκ και του Κειµένου).  

Σηµείωση: Εάν το κείµενο από το οποίο έχετε διαγράψει τα µπλοκ έχει, ήδη, 
αναγνωριστεί, θα διαγραφεί αντίστοιχα και όλο το αναγνωρισµένο κείµενο που 
εµφανίζεται στο παράθυρο Κειµένου. 

Ορισµός της ∆οµής ενός Πίνακα από τον Χρήστη 
Συµβουλή: Εάν η αυτόµατη ανάλυση της δοµής του πίνακα δεν έχει ορίσει σωστά τις 
γραµµές και τις στήλες του πίνακα, προσπαθήστε να επεξεργασθείτε τα αποτελέσµατα 
της αυτόµατης ανάλυσης, παρά να διαγράψετε όλα τα µπλοκ και να σχεδιάσετε µόνοι 
σας ένα καινούργιο. Έτσι, στις περισσότερες περιπτώσεις, εξοικονοµείτε περισσότερο 
χρόνο. 

Για να γίνει επεξεργασία ενός πίνακα από το χρήστη: 

Χρησιµοποιείστε τα ακόλουθα εργαλεία από την γραµµή εργαλείων Εικόνας (Image 
toolbar) για να κάνετε τις απαραίτητες αλλαγές στον πίνακα: 

  - Για να προσθέστε ένα κάθετο διαχωριστικό 

  - Για να προσθέστε ένα οριζόντιο διαχωριστικό 

  - Για να αφαιρέστε ένα διαχωριστικό 

Εάν το κελί του πίνακα περιλαµβάνει µόνο µια εικόνα, στο παράθυρο διαλόγου Block 
Properties (Ιδιότητες του Μπλοκ) (µενού View>Properties), επιλέξτε τη λειτουργία 
Treat cell as a picture (Μεταχείριση του κελιού σαν εικόνα). Εάν το κελί του πίνακα 
περιλαµβάνει και κείµενο και φωτογραφία, ορίστε ένα (ή περισσότερα) ξεχωριστά 
µπλοκ εικόνας µέσα στο κελί. 

Για να συγχωνεύσετε κελιά και γραµµές του πίνακα: 

! Στο µενού Edit (Επεξεργασία), επιλέξτε το στοιχείο Merge Table Cells 
(Συγχώνευση Κελιών του Πίνακα) ή Merge Table Rοws (Συγχώνευση 
Γραµµών του Πίνακα).  

Σηµείωση:    

1. Εάν θέλετε, µπορείτε να διαχωρίσετε συγχωνευµένα κελιά, µε την εντολή Split 
Table Cells (∆ιαµερισµός Κελιών του Πίνακα) στο µενού Edit. Η επιλογή 
Merge Table Rows (Συγχώνευση Γραµµών του Πίνακα) δεν επηρεάζει τη 
διάσπαση του πίνακα σε στήλες.  

2. Για την αποφυγή του ορισµού οριζόντιων και κάθετων διαχωριστικών από το 
χρήστη, ορίστε ένα ξεχωριστό µπλοκ για τον πίνακα και στη συνέχεια, κάντε δεξί 
κλικ πάνω σε αυτό και επιλέξτε από το αναδυόµενο µενού τη λειτουργία Analyse 
Table Structure (Ανάλυση ∆οµής Πίνακα). Το πρόγραµµα θα ορίσει από µόνο 
του όλα τα διαχωριστικά που θεωρεί ότι είναι απαραίτητα. Στη συνέχεια, εσείς 
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µπορείτε να διορθώσετε τα διαχωριστικά που τυχόν έχουν οριστεί λανθασµένα 
από το πρόγραµµα. 

Χρήση Υποδειγµάτων Μπλοκ 
Εάν θέλετε να επεξεργαστείτε ένα µεγάλο αριθµό εγγράφων που περιέχουν το ίδιο στυλ 
µορφοποίησης, όπως για παράδειγµα φόρµες, ερωτηµατολόγια, σίγουρα θα χρειασθείτε 
πολύ χρόνο να αναλύσετε ξεχωριστά τη µορφοποίηση κάθε σελίδας. Μπορείτε να 
εξοικονοµίσετε χρόνο αν δηµιουργήσετε ένα υπόδειγµα µπλοκ, δηλαδή ένα σύνολο από 
µπλοκ, που θα αντιπροσωπεύει το στυλ µορφοποίησης των σελίδων σας. Έπειτα, 
µπορείτε να το εφαρµόσετε σε όλες τις σελίδες που θέλετε να αναγνωρίσετε και 
περιέχουν το ίδιο στυλ µορφοποίησης. 

Σηµείωση: Κάθε υπόδειγµα µπλοκ που δηµιουργείτε µπορεί να χρησιµοποιηθεί µόνο 
µε έγγραφα τα οποία έχουν σαρωθεί µε την ίδια ανάλυση µε το έγγραφο πάνω στο 
οποίο βασίστηκαν. 

Για να δηµιουργήσετε ένα υπόδειγµα µπλοκ: 

1. Ανοίξτε µια εικόνα και ορίστε τα µπλοκ, είτε αυτόµατα, είτε µόνοι σας. 

2. Στο µενού Image, επιλέξτε το στοιχείο Save Blocks (Αποθήκευση Μπλοκ). 
Εµφανίζεται το παράθυρο διαλόγου Save Blocks as (Αποθήκευση Μπλοκ ως), 
στο οποίο θα πρέπει να πληκτρολογήσετε ένα όνοµα αρχείου για το συγκεκριµένο 
υπόδειγµα µπλοκ. 

Για να φορτώσετε ένα υπόδειγµα µπλοκ: 

1. Κάντε κλικ πάνω στο παράθυρο ∆έσµης Αρχείων (Batch) και επιλέξτε τις 
σελίδες πάνω στις οποίες θέλετε να εφαρµόσετε το υπόδειγµα του µπλοκ. 

2. Στο µενού Image, επιλέξτε το στοιχείο Load Blocks (Φόρτωση Μπλοκ). 
Εµφανίζεται το παράθυρο διαλόγου Open Blocks (Άνοιγµα Μπλοκ). 

3. Στο παράθυρο διαλόγου, επιλέξτε το αρχείο εκείνο, που περιέχει το υπόδειγµα 
µπλοκ που χρειάζεστε. 

4. Επιλέξτε από την κατηγορία επιλογών Apply to (Εφαρµογή σε) τις σελίδες στις 
οποίες θα εφαρµοστεί το υπόδειγµα. Η επιλογή All pages (Όλες τις Σελίδες), 
εφαρµόζει το υπόδειγµα του µπλοκ σε όλες τις σελίδες της δεσµίδας αρχείων, ενώ 
η επιλογή Selected pages (Επιλεγµένες σελίδες), εφαρµόζει το υπόδειγµα του 
µπλοκ µόνο στις επιλεγµένες σελίδες. 

5. Κάντε κλικ στο κουµπί Open. 
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Κεφάλαιο 6  
Αναγνώριση Κειµένου 

Σκοπός ενός προγράµµατος Οπτικής Αναγνώρισης Χαρακτήρων (OCR) είναι να 
διαβάζει το κείµενο από αρχεία εικόνων και επιπλέον, να διατηρεί τη µορφοποίηση του 
πρωτότυπου εγγράφου. Για να επιτευχθεί αυτό, θα πρέπει να ορίσουµε τις βασικές 
παραµέτρους �τη γλώσσα αναγνώρισης, το είδος της γραµµατοσειράς και τον τύπο του 
εγγράφου� πριν αρχίσουµε τη διαδικασία της αναγνώρισης. Το κεφάλαιο αυτό 
ασχολείται µε τις προαναφερθείσες παραµέτρους, αναφέρεται σε σηµαντικά ζητήµατα 
που αφορούν στη διαδικασία αναγνώρισης και επιπλέον, παρουσιάζει τη χρήση των 
διαφορετικών ρυθµίσεων για την αναγνώριση κειµένου, κ.ά. 

Περιεχόµενα κεφαλαίου: 

! Γενικά για την αναγνώριση κειµένου 

! Γλώσσα αναγνωριζόµενου κειµένου 

! Είδος εκτύπωσης του πρωτοτύπου 

! Άλλες επιλογές αναγνώρισης 

! Αναγνώριση κειµένου στο παρασκήνιο 

! Αναγνώριση κειµένου µε εκπαίδευση 

! Εκπαίδευση ενός υποδείγµατος γραµµατοσειράς (user pattern) 

! Επεξεργασία ενός υποδείγµατος γραµµατοσειράς (user pattern) 

! Oριζµός γλωσσών και οµάδων γλωσσών (user languages και language groups) 
από τον χρήστη 

! Πώς ορίζεται µια νέα γλώσσα χρήστη 

! Πώς ορίζεται µια οµάδα γλωσσών 
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Γενικά για την Αναγνώριση Κειµένου 
Σηµείωση: Πριν τη διαδικασία αναγνώρισης, ελέγξτε τις παρακάτω ρυθµίσεις: 
γλώσσα αναγνωριζόµενου κειµένου, είδος ποιότητας εκτύπωσης και τύπος εγγράφου. 

Το πρόγραµµα σας επιτρέπει: 

1. Να αναγνωρίσετε ένα ή περισσότερα µπλοκ που έχουν ορισθεί πάνω στην εικόνα. 

2. Να αναγνωρίσετε την ενεργή σελίδα ή όλες τις επιλεγµένες σελίδες που 
εµφανίζονται στο παράθυρο της ∆εσµίδας Αρχείων. 

3. Να αναγνωρίσετε όλες τις µη αναγνωρισµένες σελίδες της δεσµίδας αρχείων. 

4. Να πραγµατοποιήσετε την αναγνώριση των σελίδων στο παρασκήνιο. Η 
λειτουργία αυτή δίνει τη δυνατότητα ταυτόχρονης αναγνώρισης και επεξεργασίας 
των σελίδων. 

5. Να εκπαιδεύσετε το πρόγραµµα στην αναγνώριση ορισµένων σελίδων. Τις 
περισσότερες φορές, η λειτουργία αυτή χρησιµοποιείται για την αναγνώριση 
κειµένων που περιέχουν διακοσµητικές γραµµατοσειρές ή για την αναγνώριση 
µεγάλου όγκου σελίδων (περισσότερες από εκατό σελίδες) µέσης και κακής 
ποιότητας εκτύπωσης. 

6. Να αναγνωρίσετε την ίδια δεσµίδα αρχείων από διαφορετικούς σταθµούς 
εργασίας (δικτυακά). 

Για την εκκίνηση της διαδικασίας αναγνώρισης υπάρχουν δύο επιλογές: 

! Στη γραµµή εργαλείων WizardBar, κάντε κλικ πάνω στο κουµπί 2-Read, ή  

! Στο µενού Process (Επεξεργασία), επιλέξτε ένα από τα ακόλουθα στοιχεία: 

Read (Ανάγνωση) � για την αναγνώριση της ενεργής σελίδας ή όλων των 
επιλεγµένων σελίδων που εµφανίζονται στο παράθυρο Batch. 

Read all pages (Ανάγνωση Όλων των Σελίδων) � για την αναγνώριση όλων των 
µη αναγνωρισµένων σελίδων της δεσµίδας αρχείων. 

Read Block (Ανάγνωση του Μπλοκ) � για την αναγνώριση ενός ή περισσότερων 
µπλοκ που έχουν ορισθεί µέσα στην εικόνα. 

Start Background Recognition (Έναρξη Αναγνώρισης Παρασκήνιο) � για την 
εκκίνηση της αναγνώρισης στο παρασκήνιο.  

Το κουµπί 2-Read είναι προεπιλεγµένο να αναγνωρίζει την ενεργή σελίδα. Για να 
τροποποιήσετε τη λειτουργία του κουµπιού, κάντε κλικ στο βελάκι που βρίσκεται στα 
δεξιά του κουµπιού και επιλέξτε την ανάλογη λειτουργία από το µενού συντόµευσης. 

Σηµείωση: Όταν επιχειρήσετε να αναγνωρίσετε ένα µπλοκ που έχει, ήδη, 
αναγνωριστεί, τότε η όλη λειτουργία του OCR θα εφαρµοστεί µόνο στα τροποποιηµένα 
µπλοκ και στα µπλοκ που έχουν προστεθεί εκ των υστέρων. 

Γλώσσα Αναγνώρισης  
Το FineReader µπορεί να αναγνωρίσει κείµενα γραµµένα σε µια µόνο γλώσσα, αλλά 
και πολυγλωσσικά (π.χ. Ελληνικά-Αγγλικά-Γαλλικά) κείµενα. Για την περίπτωση της 
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Αγγλικής και της Γερµανικής γλώσσας µπορείτε επίσης να χρησιµοποιείσετε τα 
αντίστοιχα εξειδικευµένα νοµικά και ιατρικά λεξικά. 

Για να ορίσετε τη γλώσσα αναγνώρισης του κειµένου, µπορείτε να την επιλέξετε από 
τη λίστα συντόµευσης στη βασική γραµµή εργαλείων (Standard toolbar). 

Για την αναγνώριση πολυγλωσσικού κειµένου: 

1. Στη βασική γραµµή εργαλείων, επιλέξετε τη λειτουργία Select multiple 
languages (Επιλογή πολλαπλών γλωσσών) από τη λίστα υποστηριζόµενων 
γλωσσών. Εµφανίζεται το παράθυρο διαλόγου Recognition language (Γλώσσα 
αναγνώρισης). 

2. Στο παράθυρο διαλόγου Recognition language, επιλέξτε τις γλώσσες που θέλετε. 

Σηµείωση:    

1. Αν διαπιστώσετε ότι συχνά χρησιµοποιείτε έναν συγκεκριµένο συνδυασµό 
γλωσσών κατά την αναγνώριση, τότε θα µπορούσατε να δηµιουργήσετε µια 
οµάδα γλωσσών, που να περιλαµβάνει τις γλώσσες που χρησιµοποιείτε 
συχνότερα. 

2. Εάν επιλέξετε ταυτόχρονα πολλές γλώσσες µαζί, αυτό µπορεί να επηρεάσει την 
ποιότητα των αποτελεσµάτων της αναγνώρισης. Ένας λογικός αριθµός γλωσσών 
που θα µπορούσατε να επιλέξετε, είναι 2-3 γλώσσες.  

3. Πριν ξεκινήσετε την αναγνώριση των εγγράφων σας, ελέγξετε τις επιλεγµένες 
γραµµατοσειρές στην καρτέλα Formatting (Μορφοποίηση): οι γραµµατοσειρές 
αυτές θα πρέπει να υποστηρίζουν όλους τους χαρακτήρες που χρησιµοποιούνται 
στις γλώσσες αναγνώρισης που θα επιλέξετε. Αλλιώς, τα αποτελέσµατα του 
αναγνωρισµένου κειµένου θα εµφανίζονται λανθασµένα (θα εµφανίζονται 
σύµβολα τύπου �?�, �_� ή ���, αντί για γράµµατα). Για περισσότερες 
πληροφορίες δείτε στην ηλεκτρονική βοήθεια του FineReader, το θέµα "Fonts for 
Recognition Languages that may be displayed in the Text Editor incorrectly". 

Πολλές φορές, ίσως συναντήσετε δυσκολία προσπαθώντας να βρείτε τη γλώσσα 
αναγνώρισης που χρειάζεστε µέσα από τη λίστα γλωσσών. Τότε, µπορεί να συντρέχει 
κάποιος από τους ακόλουθους λόγους: 

1. Η συγκεκριµένη γλώσσα δεν υποστηρίζεται από το FineReader. Ανατρέξτε στην 
ενότητα, «Υποστηριζόµενες Γλώσσες» της βοήθειας του ABBYY FineReader και 
συµβουλευτείτε την πλήρη λίστα γλωσσών αναγνώρισης. 

2. Η συγκεκριµένη γλώσσα δεν περιλαµβάνεται στη λίστα γλωσσών αναγνώρισης 
που εµφανίζεται στη γραµµή εργαλείων Αναγνώρισης. Για να προσθέσετε τη 
γλώσσα που θέλετε, επιλέξτε το Choose more languages (Επιλογή 
περισσότερων γλωσσών) από την λίστα υποστηριζόµενων γλωσσών της βασικής 
γραµµής εργαλείων. Θα εµφανιστεί το παράθυρο διαλόγου Recognition language 
(Γλώσσα αναγνώρισης) από το οποίο µπορείτε να επιλέξετε τη γλώσσα που 
θέλετε. 

3. Η γλώσσα αυτή δεν επιλέχθηκε κατά τη διάρκεια της Προσαρµοσµένης (Custom) 
εγκατάστασης. Για την εγκατάσταση επιπλέον γλωσσών αναγνώρισης, θέστε σε 
λειτουργία το πρόγραµµα εγκατάστασης του FineReader και πραγµατοποιήστε 
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την προσαρµοσµένη εγκατάσταση. Σβήστε όλα τα στοιχεία εκτός από τις γλώσσες 
αναγνώρισης (Recognition languages) και κάντε κλικ στο κουµπί Details 
(Λεπτοµέρειες). Τότε, θα εµφανιστεί µια λίστα υποστηριζόµενων γλωσσών από 
το FineReader. Επιλέξτε τις γλώσσες που χρειάζεστε. 

Σηµείωση: Σιγουρευτείτε ότι ως κατάλογο εγκατάστασης έχετε ορίσει τον ίδιο 
κατάλογο, όπου έχετε εγκαταστήσει το FineReader. 

Για να εµφανίσετε ή να αποκρύψετε µια γλώσσα από τη λίστα συντόµευσης στη 
γραµµή εργαλείων: 

! Στο παράθυρο διαλόγου Language Editor (∆ιόρθωση γλώσσας) (µενού 
Tools>Language editor), επιλέξτε την επιθυµητή γλώσσα και στη συνέχεια, 
επιλέξτε ή διαγράψτε τη λειτουργία Show this language in the drop-down list on 
the toolbar (Εµφάνιση της γλώσσας αυτής από τη λίστα της γραµµής 
εργαλείων). 

Συµβουλή: Επιπλέον, µπορείτε να ορίσετε µια γλώσσα αναγνώρισης για ένα 
συγκεκριµένο µπλοκ! Για να γίνει αυτό, κάντε δεξί κλικ πάνω στο µπλοκ, για το οποίο 
θέλετε να ορίσετε µια άλλη γλώσσα αναγνώρισης και στη συνέχεια, στο εµφανιζόµενο 
µενού, επιλέξτε το στοιχείο Properties (Ιδιότητες) Στο παράθυρο διαλόγου Properties 
που εµφανίζεται, επιλέξτε το στοιχείο Block και στη συνέχεια, στο πεδίο Languages 
(Γλώσσες), επιλέξτε τη γλώσσα αναγνώρισης για το συγκεκριµένο µπλοκ. 

Είδος Τύπου Εκτύπωσης Κειµένου 
Στις περισσότερες περιπτώσεις, ο τύπος εκτύπωσης του εγγράφου διακρίνεται 
αυτόµατα. Για να ενεργοποιήσετε την αυτόµατη ανίχνευση του τύπου εκτύπωσης, στην 
οµάδα επιλογών Print Type (µενού Toοls>Options, καρτέλα Recognition), επιλέξτε 
τη λειτουργία Autodetect. 

Για να βελτιώσετε την ποιότητα των αποτελεσµάτων της αναγνώρισης που αφορούν σε 
κείµενα πρόχειρης εκτύπωσης από εκτυπωτή ακίδων (dot matrix) ή από παλιά 
γραφοµηχανή, ορίστε το αντίστοιχο είδος εκτύπωσης (print type) για το έγγραφο: 

! Εάν θέλετε να αναγνωρίσετε κείµενο εκτυπωµένο σε γραφοµηχανή, ενεργοποιεί-
στε την επιλογή Typewriter. 

! Εάν θέλετε να αναγνωρίσετε κείµενο εκτυπωµένο σε dot matrix εκτυπωτή, 
ενεργοποιείστε την επιλογή Dot Matrix Printer. 

Παράδειγµα πρόχειρης εκτύπωσης σε dot matrix εκτυπωτή. Οι γραµµές των 
χαρακτήρων αποτελούνται από ένα σύνολο µεµονωµένων κουκίδων.  

Παράδειγµα εκτύπωσης από γραφοµηχανή. Όλα τα γράµµατα έχουν το ίδιο 
πλάτος (συγκρίνετε, για παράδειγµα, το γράµµα �w� µε το �a�). 

Για να αλλάξετε τον τύπο εκτύπωσης: 

! Στο παράθυρο διαλόγου Options (µενού Tools>Options), επιλέξτε το στοιχείο 
που θέλετε στην καρτέλα Recognition. 

Σηµείωση: Τελειώνοντας την αναγνώριση των κειµένων που είναι εκτυπωµένα είτε 
σε dot matrix εκτυπωτή, είτε σε γραφοµηχανή, µη ξεχάσετε να ενεργοποιήσετε ξανά 
την αυτόµατη ανίχνευση (Autodetect), για να αναγνωριστούν σωστά τα κανονικά 
κείµενα. 
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Πρόσθετες Ρυθµίσεις για την Αναγνώριση Κειµένων 
Εµφάνιση εικόνας κατά τη διάρκεια της αναγνώρισης 

Η διαδικασία αναγνώρισης σε έγγραφα µε µεγάλο πλήθος σελίδων, µπορεί να 
επιταχυνθεί, όταν η σελίδα υπό επεξεργασία δεν εµφανίζεται στο παράθυρο. Για να 
θέσετε σε λειτουργία την αναγνώριση χωρίς την εµφάνιση της σελίδας: 

! Στην καρτέλα General (Γενικά) (µενού Tools>Options), απενεργοποιήστε την 
επιλογή Show image during recognition (Εµφάνιση εικόνας κατά τη διάρκεια 
της αναγνώρισης). 

Κατεύθυνση κειµένου 

Αν το FineReader δεν αναγνωρίσει σωστά κάποιο µπλοκ ή κελί πίνακα. Το οποίο 
περιέχει κατακόρυφο κείµενο: 

! Κάντε δεξί κλικ στο µπλοκ ή το κελί µε το κατακόρυφο κείµενο και επιλέξτε 
Properties από το µενού συντόµευσης. Θα εµφανιστεί ο διάλογος Block 
properties (Ιδιότητες Μπλοκ). ∆ιαλέξτε την κατάλληλη επιλογή από την λίστα 
Text Direction (Κατεύθυνση κειµένου) και ξανααναγνωρίστε την σελίδα. 

Αρνητικό ή ανεστραµµένο µπλοκ 

Αν συναντήσετε πρόβληµα κατά την αναγνώριση τµηµάτων της εικόνας µε αρνητικά 
χρώµατα (λευκή γραµµατοσειρά σε µαύρο φόντο) ή ανεστραµµένο κείµενο � ένα 
µπλοκ κειµένου, ένα κελί ή ένα ολόκληρο πίνακα: 

! Κάντε διπλό κλικ πάνω στο επιθυµητό µπλοκ και επιλέξτε το στοιχείο Properties 
από το µενού συντόµευσης. Στο παράθυρο διαλόγου Block Properties (Ιδιότητες 
Μπλοκ) που εµφανίζεται, επιλέξτε το στοιχείο Inverted (Αρνητικό) ή Flipped 
(ανεστραµµένο) ανάλογα µε την περίσταση και ξανααναγνωρίστε την σελίδα.  

Αναγνώριση Κειµένου στο Παρασκήνιο 
Στην περίπτωση που θέλετε να επεξεργασθείτε τις ήδη αναγνωρισµένες σελίδες και 
ταυτόχρονα, να συνεχίσετε την αναγνώριση των υπόλοιπων σελίδων, θα βρείτε τη 
λειτουργία αναγνώρισης κειµένου στο παρασκήνιο πολύ χρήσιµη. Για την εκκίνηση της 
αναγνώρισης στο παρασκήνιο: 

! Στο µενού Process, επιλέξτε το στοιχείο Start Background Recognition 
(Εκκίνηση Αναγνώρισης στο Παρασκήνιο). 

Στη γραµµή κατάστασης, στο κάτω µέρος του βασικού παραθύρου του 
FineReader, εµφανίζεται το σύµβολο . Εάν το παράθυρο της ∆εσµίδας 
Αρχείων βρίσκεται σε λειτουργία εµφάνισης λεπτοµερειών (ενεργοποιήστε τη 
λειτουργία Details κάνοντας δεξί κλικ µέσα στο παράθυρο της δεσµίδας και 
επιλέγοντας View>Details από το µενού συντόµευσης), στη στήλη Opened by  
θα εµφανίζεται το εικονίδιο  δίπλα στη σελίδα που αναγνωρίζεται στο 
παρασκήνιο. 

Όταν είναι ενεργοποιηµένη η λειτουργία αναγνώρισης κειµένου στο παρασκήνιο και 
προστεθεί µια νέα, µη αναγνωρισµένη σελίδα στην ∆εσµίδα Αρχείων, τότε η 
διαδικασία αναγνώρισης θα αναλάβει να την επεξεργαστεί µόλις προστεθεί στη 
δεσµίδα. 

Σηµείωση: Η αύξηση της ταχύτητας αναγνώρισης στο παρασκήνιο, σε συστήµατα µε 
περισσότερους από έναν επεξεργαστές γίνεται ιδιαίτερα αισθητή σε δεσµίδες µε πολλές 
σελίδες. 



 54

Για να απενεργοποιήσετε τη λειτουργία Αναγνώρισης στο Παρασκήνιο: 

! Στο µενού Process, επιλέξτε το στοιχείο Stop Background Recognition 
(Τερµατισµός Αναγνώρισης στο Παρασκήνιο). 

Σηµείωση: Η λειτουργία της αναγνώρισης στο παρασκήνιο, χρησιµοποιεί τις 
ρυθµίσεις που ήταν ενεργές όταν ενεργοποιήθηκε αυτή η λειτουργία. 

Αναγνώριση Κειµένου µε Εκπαίδευση 
Όπως αναφέραµε και νωρίτερα, το FineReader µπορεί να αναγνωρίσει κείµενα κάθε 
είδους ποιότητας, τυπωµένα µε οποιαδήποτε γραµµατοσειρά, µε αποτέλεσµα να 
µπορείτε, συνήθως, να αναγνωρίσετε οποιοδήποτε κείµενο χωρίς προηγούµενη 
εκπαίδευση. Παρ� όλα αυτά, το FineReader παρέχει εργαλεία για την εκπαίδευση 
υποδειγµάτων γραµµατοσειρών από το χρήστη.  

Μπορείτε να χρησιµοποιήσετε ένα Υπόδειγµα Γραµµατοσειράς (User Pattern) για: 

1. να αναγνωρίσετε κείµενα που περιέχουν ασυνήθιστες γραµµατοσειρές. 

2. να αναγνωρίσετε κείµενα που περιλαµβάνουν ειδικούς χαρακτήρες (π.χ. 
µαθηµατικά σύµβολα). 

3. να αναγνωρίσετε µεγάλο όγκο κειµένων (πάνω από 100 σελίδες) κακής ποιότητας. 

Συµβουλή: Χρησιµοποιήστε τη λειτουργία Train User Pattern µόνο για τις 
προαναφερθείσες περιπτώσεις. Στις άλλες περιπτώσεις µπορεί να έχετε µια µικρή 
πιθανότητα βελτίωσης της ποιότητας των αποτελεσµάτων της αναγνώρισης, τόση όµως, 
ώστε δεν αξίζει τον κόπο να ασχοληθείτε µε την εκπαίδευση του προγράµµατος. 

Η διαδικασία εκπαίδευσης ενός υποδείγµατος γραµµατοσειράς γίνεται αναγνωρίζοντας 
µία ή δύο σελίδες µε την ειδική λειτουργία εκπαίδευσης. Έτσι δηµιουργείται ένα 
υπόδειγµα, το οποίο στη συνέχεια µπορείτε να χρησιµοποιήσετε για την αναγνώριση 
του υπόλοιπου κειµένου. 

Μερικές φορές, δύο ή τρεις χαρακτήρες µπορεί να είναι «κολληµένοι» µεταξύ τους. 
Τότε, είναι αρκετά δύσκολο να ξεχωρίσετε τους χαρακτήρες � το FineReader δεν 
µπορεί να τους περικλείσει σε πλαίσια, ούτως ώστε κάθε πλαίσιο να περιλαµβάνει µόνο 
ένα χαρακτήρα. Στην περίπτωση αυτή (π.χ. εάν δεν µπορείτε να µετακινήσετε το 
πλαίσιο ώστε να περικλείει ένα µοναδικό χαρακτήρα και καθόλου µέρη των γειτονικών 
συµβόλων), µπορείτε να εκπαιδεύσετε το FineReader στην αναγνώριση ολόκληρου 
αυτού του «συνδυασµού» χαρακτήρων, θεωρώντας το σαν ένα µοναδικό χαρακτήρα. 
Τυπικά παραδείγµατα τέτοιων συνδυασµών χαρακτήρων, είναι τα: ff, fi, fl, κ.ά. Τέτοιοι 
συνδυασµοί χαρακτήρων, οι οποίοι δεν είναι δυνατόν να κατατµηθούν, ονοµάζονται 
συµπλέγµατα.  

Σηµείωση:    

1. Το υπόδειγµα που δηµιουργήσατε µπορεί να χρησιµοποιηθεί µόνο για την 
αναγνώριση κειµένων µε το ίδιο µέγεθος γραµµατοσειράς µε την οποία 
εκπαιδεύτηκε το υπόδειγµα.  

2. Κάθε υπόδειγµα δηµιουργείται για µια συγκεκριµένη δεσµίδα αρχείων. Έτσι, εάν 
αποφασίσετε να διαγράψετε µια δεσµίδα αρχείων, διαγράφεται ταυτόχρονα και το 
υπόδειγµα. Για να µπορέσετε να χρησιµοποιήσετε ένα συγκεκριµένο υπόδειγµα 
και σε άλλες δεσµίδες αρχείων, αποθηκεύστε τις ρυθµίσεις της δεσµίδας σε 
κάποιο αρχείο που περιέχει πρότυπα δεσµίδων αρχείων.  
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3. Εάν θελήσετε να αναγνωρίσετε κείµενα τυπωµένα σε διαφορετική 
γραµµατοσειρά, απενεργοποιήστε το υπόδειγµα � στο µενού Tools>Options, 
κάντε κλικ στην επιλογή Do not use user pattern στην καρτέλα Recognition. 

Εάν θέλετε να εκπαιδεύσετε ένα υπόδειγµα: 

1. Ενεργοποιήστε τη λειτουργία Train user pattern (Εκπαίδευση υποδείγµατος 
γραµµατοσειράς) � στην  καρτέλα Recognition του διαλόγου Options (µενού 
Tools>Options) και συγκεκριµένα στην οµάδα επιλογών Training, επιλέξτε το 
Train user pattern. Στη γραµµή κατάστασης εµφανίζεται η προεπιλεγµένη 
ονοµασία του υποδείγµατος (�Default�). 

2. Κάντε κλικ στο κουµπί 2-Read. 

3. Εκπαιδεύστε το υπόδειγµά σας � ενεργοποιήστε τη λειτουργία Train user pattern 
και αναγνωρίστε µια έως δύο σελίδες. Η χαρακτήρες στους οποίους εκπαιδεύτηκε 
το πρότυπο, αποθηκεύονται στο προεπιλεγµένο υπόδειγµα. Το FineReader θα 
αποθηκεύσει το υπόδειγµα που δηµιουργήσατε (Default.pat) στον ενεργό 
κατάλογο της δεσµίδας αρχείων. 

4. ∆ιορθώστε το υπόδειγµά σας. 

5. Απενεργοποιήστε τη λειτουργία εκπαίδευσης (στην καρτέλα Recognition, 
επιλέξτε Use user pattern). 

6. Αναγνωρίστε και το υπόλοιπο κείµενο � κάντε κλικ στο κουµπί 2-Read. 

Σηµείωση:    

1. Για να δηµιουργήσετε µερικά υποδείγµατα που θα αφορούν την ίδια δεσµίδα 
αρχείων, χρησιµοποιήστε το παράθυρο διαλόγου Pattern Editor (στην καρτέλα 
Recognition, κάντε κλικ στο κουµπί Pattern Editor ή επιλέξτε από το µενού 
Tools>Pattern Editor). ∆ηµιουργήστε ένα νέο υπόδειγµα (στο παράθυρο 
διαλόγου, κάντε κλικ στο κουµπί New) και στη συνέχεια, επιλέξτε το (κάντε κλικ 
στο κουµπί Set Active). ∆ουλεύοντας µε ένα υπόδειγµα που έχετε δηµιουργήσει 
εσείς οι ίδιοι, είναι σαν να δουλεύετε µε το προεπιλεγµένο υπόδειγµα (δείτε τα 
βήµατα 1-5). Λάβετε υπόψη σας πως µόνο ένα υπόδειγµα µπορεί να είναι ενεργό 
την ίδια στιγµή.  

2. Εάν έχετε δηµιουργήσει µερικά υποδείγµατα στην ίδια δεσµίδα αρχείων, το 
τελευταίο που δηµιουργήσατε θα παραµείνει ενεργό. Η ονοµασία του 
ενεργοποιηµένου υποδείγµατος εµφανίζεται στη γραµµή κατάστασης. Για να 
ενεργοποιήσετε κάποιο άλλο υπόδειγµα, στο παράθυρο διαλόγου Pattern editor 
(µενού Tools>Pattern Editor) επιλέξτε το από τη λίστα υποδειγµάτων που 
εµφανίζεται, και κάντε κλικ στο κουµπί Set Active. Στη συνέχεια, από τη λίστα 
επιλογών Training, ενεργοποιήστε το µενού Tools>Options και στην καρτέλα 
Recognition κάντε κλικ στο Use user pattern.  

3. Εάν η επιλογή Use built-in patterns (Χρήση ενσωµατωµένων υποδειγµάτων) 
είναι ήδη ενεργοποιηµένη, το FineReader προσπαθεί να αναγνωρίσει το κείµενο, 
χρησιµοποιώντας τα ενσωµατωµένα υποδείγµατα του προγράµµατος  και σταµατά 
µόνο σε χαρακτήρες για τους οποίους έχει κάποια αµφιβολία. Στη περίπτωση που 
εκπαιδεύετε το πρόγραµµα στην αναγνώριση γραµµατοσειρών διακοσµητικού 
χαρακτήρα και/ή ασυνήθιστων γραµµατοσειρών (για παράδειγµα, τη Θιβετιανή 
γραµµατοσειρά), το FineReader µπορεί να αναγνωρίσει λανθασµένα χαρακτήρες, 
χρησιµοποιώντας τα ενσωµατωµένα υποδείγµατα. Στην περίπτωση αυτή, 
απενεργοποιήστε τη λειτουργία Use built-in patterns από το παράθυρο διαλόγου 
Recognition και εκπαιδεύστε το σύστηµα στην αναγνώριση κάθε χαρακτήρα 
ξεχωριστά. 
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Πώς γίνεται η Εκπαίδευση ενός Υποδείγµατος 
Γραµµατοσειράς (User Pattern) 

1. Σιγουρευτείτε πως η επιλογή Train user pattern στο παράθυρο διαλόγου 
Recognition (µενού Tools>Options) από τη οµάδα επιλογών Training, είναι 
ενεργή.  

2. Κάντε κλικ στο κουµπί 2-Read. Στη συνέχεια, το FineReader ξεκινάει την ανα-
γνώριση. Όταν φτάσει στην αναγνώριση ενός χαρακτήρα για τον οποίο έχει 
κάποια αµφιβολία, ενεργοποιείται το παράθυρο διαλόγου Pattern Training, όπου 
εµφανίζεται η εικόνα του χαρακτήρα αυτού. 

 

Εκπαίδευση του συστήµατος στην αναγνώριση ενός χαρακτήρα: 

Το πλαίσιο που βρίσκεται στο επάνω µέρος του παραθύρου διαλόγου, θα πρέπει να 
περιλαµβάνει ένα µοναδικό χαρακτήρα, ο οποίος θα πρέπει να περικλείεται πλήρως από 
το πλαίσιο αυτό. Εάν, όµως, το πλαίσιο περιλαµβάνει µόνο ένα µέρος του χαρακτήρα ή 
παραπάνω από ένα χαρακτήρα, κάντε κλικ πάνω στα περιθώρια του πλαισίου και 
µετακινήστε τα, έτσι ώστε το πλαίσιο να καλύπτει ολόκληρο το χαρακτήρα. Η 
µετακίνηση του πλαισίου µπορεί να γίνει και µε τα κουµπιά  και  (θα τα βρείτε 
πολύ χρήσιµα κατά τη διαδικασία εκπαίδευσης συµβόλων τυπωµένων µε πλάγια 
γραφή). Τελειώνοντας, πληκτρολογήστε τον χαρακτήρα και κάντε κλικ στο κουµπί 
Train. 

Σηµείωση:    

1. Το σύστηµα µπορεί να εκπαιδευτεί µόνο στην αναγνώριση χαρακτήρων που 
περιλαµβάνονται στα αλφάβητα των γλωσσών για τις οποίες γίνεται αναγνώριση.  
Για εκπαιδεύσετε το FineReader στην αναγνώριση χαρακτήρων που δεν µπορούν 
να εισαχθούν µέσω πληκτρολογίου, µπορείτε να χρησιµοποιήσετε ένα συνδυασµό 
δύο χαρακτήρων, υποδηλώνοντας ότι αυτοί οι χαρακτήρες δεν υπάρχουν στο 
πληκτρολόγιο ή ακόµα, µπορείτε να αντιγράψετε τους χαρακτήρες αυτούς από τον 
Πίνακα Συµβόλων (Character Table), που εµφανίζεται αν κάνετε κλικ στο 
κουµπί  στο παράθυρο διαλόγου Pattern Training. 

2. Εάν επιθυµείτε να εκπαιδεύσετε το σύστηµα στη διατήρηση της µορφοποίησης, 
πριν ενεργοποιήσετε το κουµπί Train, στο παράθυρο  διαλόγου Pattern 
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Training, ενεργοποιήστε την αντίστοιχη επιλογή Bold (Έντονη γραφή) ή Italic 
(Πλάγια γραφή).  

3. Όταν εκπαιδεύετε το υπόδειγµα, προσέξτε ώστε οι εικόνες των κεφαλαίων 
γραµµάτων να πληκτρολογούνται µε κεφαλαίους χαρακτήρες και οι εικόνες των 
πεζών µε πεζούς.  

Εάν έχει γίνει κάποιο λάθος κατά τη διάρκεια της εκπαίδευσης, κάντε κλικ στο κουµπί 
Back (Επιστροφή) και τότε το πλαίσιο θα επιστρέψει στην προηγούµενή του 
κατάσταση και το τελευταίο ζευγάρι εικόνα-χαρακτήρα που εκπαιδεύτηκε θα αφαιρεθεί 
από το υπόδειγµα. Αυτή η λειτουργία "Αναίρεσης", είναι περιορισµένη: µπορείτε µόνο 
να αναιρέσετε την εκπαίδευση σε χαρακτήρες της τελευταίας λέξης. 

Εκπαίδευση του συστήµατος στην αναγνώριση συµπλεγµάτων 

Σύµπλεγµα θεωρείται ένας συνδυασµός δύο ή τριών κολληµένων χαρακτήρων, όπως 
είναι για παράδειγµα, τα fi, fl, ffi κ.λπ. Είναι πολύ δύσκολο να διαχωρίσουµε αυτούς 
τους χαρακτήρες και να τους αποµονώσουµε, επειδή είναι κολληµένοι έτσι, λόγω της 
µορφής τους. Έτσι, είναι πολύ πιο εύκολο να θεωρήσουµε αυτό το συνδυασµό 
χαρακτήρων ως ένα και µοναδικό χαρακτήρα. 

Η εκπαίδευση του συστήµατος στην αναγνώριση συµπλεγµάτων είναι η αντίστοιχη 
διαδικασία εκπαίδευσης του συστήµατος στην αναγνώριση ενός χαρακτήρα: 

1. Πληκτρολογήστε τον συνδυασµό χαρακτήρων που επιθυµείτε και στη συνέχεια, 
κάντε κλικ στο κουµπί Train. 

2. Το πλαίσιο που βρίσκεται στο παράθυρο του διαλόγου θα πρέπει να περικλείει 
ολόκληρο το σύµπλεγµα. Μπορείτε να µετακινήσετε τα περιθώρια του πλαισίου, 
είτε µε το ποντίκι σας, είτε κάνοντας κλικ στα κουµπιά  και . 

Κάθε υπόδειγµα µπορεί να περιλαµβάνει µέχρι και 1000 νέους χαρακτήρες. Παρ' όλα 
αυτά, θα ήταν προτιµότερο να µη δηµιουργήσετε πάρα πολλά συµπλέγµατα, διότι αυτό 
µπορεί να επηρεάσει αρνητικά την ποιότητα των αποτελεσµάτων της αναγνώρισης. 

Κατά τη διάρκεια της εκπαίδευσης του ABBYY FineReader, θα πρέπει να λάβετε 
υπόψη σας τους ακόλουθους περιορισµούς: 

1. Μερικές φορές το FineReader δεν µπορεί να ξεχωρίσει ορισµένους χαρακτήρες 
και συσχετίζει τις εικόνες τους µε ένα και µοναδικό χαρακτήρα. Έτσι, για 
παράδειγµα, εικόνες µε απλή ('), δεξιά (�) και αριστερή (�) απόστροφο 
αποθηκεύονται στο υπόδειγµα σαν εικόνες µε απλή απόστροφο. Για το λόγο αυτό, 
δεν θα δείτε ποτέ δεξιά ή αριστερή απόστροφο στο αναγνωρισµένο κείµενο, 
ακόµα και αν προσπαθήσετε να τους εκπαιδεύσετε. 

2. Μερικές φορές µια συγκεκριµένη εικόνα αναγνωρίζεται ως ένας συγκεκριµένος 
χαρακτήρας, ανάλογα το περιβάλλον του. 

Πώς γίνεται η Επεξεργασία ενός Υποδείγµατος 
Γραµµατοσειράς (User Pattern) 

Πριν θέσετε σε λειτουργία τη διαδικασία αναγνώρισης χρησιµοποιώντας το νέο 
υπόδειγµα, εάν χρειαστεί, θα πρέπει να το επαληθεύσετε και να το διορθώσετε. Αυτό 
θα ελαχιστοποιήσει τα λάθη που πιθανώς προκύψουν από την αναγνώριση, εξαιτίας της 
λανθασµένης εκπαίδευσης του υποδείγµατος. 
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Το υπόδειγµα θα πρέπει να περιλαµβάνει µόνο µεµονωµένους χαρακτήρες ή 
συµπλέγµατα. Όλοι οι κατεστραµµένοι χαρακτήρες και οι χαρακτήρες που έχουν 
καταχωρηθεί λανθασµένα, θα πρέπει να αφαιρεθούν από το υπόδειγµα. 

Για να διορθώσετε ένα υπόδειγµα χρήσης:   

1. Στο µενού Tools, ενεργοποιείστε το στοιχείο Pattern Editor. Εµφανίζεται το 
παράθυρο διαλόγου Pattern Editor. 

2. Επιλέξτε το επιθυµητό υπόδειγµα και στο πλαίσιο διαλόγου, κάντε κλικ στο 
κουµπί Edit. Εµφανίζεται το παράθυρο διαλόγου User Pattern. 

3. Επιλέξτε ένα χαρακτήρα και κάντε κλικ στο κουµπί Properties για να διορθώσετε 
το χαρακτήρα που εισάγατε και να ορίσετε το επιθυµητό τύπο γραµµατοσειράς: 
italic (πλάγια), bold (έντονη), subscript (δείκτης) ή superscript (εκθέτης). 
Επιπλέον, µπορείτε να κάνετε κλικ στο κουµπί Delete για να αφαιρέσετε τους 
χαρακτήρες της δεσµίδας αρχείων, οι οποίοι έχουν εκπαιδευτεί λανθασµένα. 

Γλώσσες Οριζόµενες από τον Χρήστη (User Languages) 
& Οµάδες Γλωσσών (Language Groups) 

Εκτός από τις υποστηριζόµενες γλώσσες και τις οµάδες γλωσσών του προγράµµατος, 
µπορείτε να δηµιουργήσετε µια νέα γλώσσα ή µια νέα οµάδα γλωσσών (από τη λίστα 
υποστηριζόµενων γλωσσών του FineReader) και να τη χρησιµοποιήσετε στην 
αναγνώριση κειµένων. 

Μπορεί να θέλετε να δηµιουργήσετε µια νέα γλώσσα: 

1. Για να συνδέσετε ένα λεξικό χρήστη. 

! Για παράδειγµα, πρέπει να αναγνωρίσετε ένα αγγλικό κείµενο, το οποίο 
περιλαµβάνει συντοµογραφίες. Στην περίπτωση αυτή, θα µπορούσατε να 
δηµιουργήσετε ένα λεξικό συντοµογραφιών, να δηµιουργήσετε µια νέα 
γλώσσα και να συνδέσετε το λεξικό στη γλώσσα αυτή. Στη συνέχεια, θα 
µπορούσατε να δηµιουργήσετε µια οµάδα γλωσσών που να περιλαµβάνει την 
αγγλική γλώσσα (µε το λεξικό που περιλαµβάνεται στο FineReader) και τη 
νέα σας γλώσσα (µε το λεξικό συντοµογραφιών που δηµιουργήσατε) και να 
χρησιµοποιήσετε τη συγκεκριµένη οµάδα γλωσσών για την αναγνώριση των 
κειµένων σας. 

2. Για να αναγνωρίσετε έγγραφα ειδικών τύπων, όπως για παράδειγµα: 

! λίστες προϊόντων ενός πολυκαταστήµατος τροφίµων, όπου εκεί υπάρχουν 
µόνο κωδικοί προϊόντων. Συνήθως, τέτοιοι κωδικοί περιλαµβάνουν µόνο 
αριθµούς και ορισµένες φορές και µερικά γράµµατα. Στην περίπτωση αυτή, 
θα µπορούσατε να δηµιουργήσετε µια γλώσσα που θα περιελάµβανε µόνο 
τους απαραίτητους χαρακτήρες για την αναγνώριση αυτών των εγγράφων. 

! Έγγραφα τυπωµένα µόνο µε κεφαλαίους χαρακτήρες. Τότε, θα µπορούσατε 
να δηµιουργήσετε µια γλώσσα, στην οποία δεν θα υπήρχαν καθόλου πεζοί 
χαρακτήρες. Έτσι, θα αυξανόταν σηµαντικά η ποιότητα των αποτελεσµάτων 
της αναγνώρισης. 

Στην περίπτωση που χρησιµοποιείτε συχνά ένα συγκεκριµένο συνδυασµό γλωσσών, θα 
σας φανεί χρήσιµο αν δηµιουργήσετε να δηµιουργήσετε µια οµάδα γλωσσών µε τις 
γλώσσες αυτές. 

Για να δηµιουργήσετε µια νέα γλώσσα ή µια οµάδα γλωσσών, ενεργοποιήστε το 
παράθυρο διαλόγου Language Editor (µενού Tools>Language Editor). 
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Πώς να ∆ηµιουργήσετε µια Νέα Γλώσσα  
Για να δηµιουργήσετε µια νέα γλώσσα αναγνώρισης: 

1. Στο µενού Tools, επιλέξτε το στοιχείο Language Editor. 

2. Κάντε κλικ στο κουµπί New και στο παράθυρο διαλόγου που εµφανίζεται 
επιλέξτε το Create a copy of the language, και στη συνέχεια, επιλέξτε µια από τις 
γλώσσες προέλευσης και ορίστε την ως νέα γλώσσα. 

3. Εµφανίζεται το παράθυρο διαλόγου Simple Language Properties. 

 
Ορίστε τις ακόλουθες παραµέτρους για τη νέα γλώσσα: 

1. Την ονοµασία της νέας γλώσσας. 

2. Το βασικό αλφάβητο που θα χρησιµοποιηθεί από τη νέα σας γλώσσα. Η 
συγκεκριµένη παράµετρος ορίζεται στο πεδίο Alphabet. Εάν τυχόν χρειαστεί, 
µπορείτε να διορθώσετε το αλφάβητο, κάνοντας κλικ στο κουµπί . 

3. Το λεξικό που θα χρησιµοποιηθεί από το σύστηµα (για την αναγνώριση και για 
τον ορθογραφικό έλεγχο). Μπορείτε να επιλέξετε µια από τις ακόλουθες 
εναλλακτικές λύσεις: 

! None (να µη χρησιµοποιηθεί κανένα λεξικό για τη νέα γλώσσα). 

! Built-in (το λεξικό που παρέχεται µε το FineReader). 

! User dictionary (το λεξικό που δηµιουργήθηκε από το χρήστη) 

Για να προσθέσετε νέες λέξεις στο λεξικό ή για να συνδέσετε ένα λεξικό που 
δηµιουργήσατε παλιότερα ή ένα αρχείο κειµένου των Windows σε ANSI ή 
Unicode κωδικοποίηση (ο µόνος περιορισµός είναι ότι οι λέξεις θα πρέπει να 
είναι διαχωρισµένες µε κενά ή µε κάποιους χαρακτήρες που δεν περιέχονται 
στο αλφάβητο), κάντε κλικ στο κουµπί Edit Dictionary.  
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Σηµείωση: Ο ορθογραφικός έλεγχος θεωρεί σωστές τις λέξεις που 
περιέχονται στο λεξικό που δηµιουργήσατε, εάν και εφόσον τις συναντήσει 
µέσα στο κείµενο σε µια από τις ακόλουθες µορφές: κεφαλαία γράµµατα 
ορισµένα στο λεξικό, όλα τα γράµµατα πεζά, όλα κεφαλαία, το πρώτο 
γράµµα κεφαλαίο, τα υπόλοιπα πεζά. Μερικά παραδείγµατα είναι τα 
ακόλουθα: 

Λέξεις που έχουν ορισθεί  Μορφές λέξεων που  
στο λεξικό θεωρούνται σωστές 
abc abc, Abc, ABC 
Abc abc, Abc, ABC 
ABC abc, Abc, ABC 
aBc aBc, abc, Abc, ABC 

! Regular expression (ορίζει την µορφή των λέξεων της νέας γλώσσας. Για 
αναλυτικότερες πληροφορίες ανατρέξτε στην ενότητα Regular Expressions 
της ηλεκτρονικής βοήθειας του ABBYY FineReader).  

Σηµείωση:  

1. Στο παράθυρο διαλόγου Simple Language Properties, κάντε κλικ στο κουµπί 
Advanced για να ορίσετε µερικές εξελιγµένες ιδιότητες που αφορούν στη νέα 
γλώσσα � για παράδειγµα, χαρακτήρες που αγνοούνται από το σύστηµα όταν 
βρίσκονται µέσα σε λέξεις, απαγορευµένοι χαρακτήρες, κ.λπ.). 

2. Οι γλώσσες που δηµιουργείτε αποθηκεύονται στον ίδιο κατάλογο όπου είναι 
αποθηκευµένη η αντίστοιχη δεσµίδα αρχείων. Το FineReader Corporate Edition 
σας δίνει την δυνατότητα να αποθηκεύσετε τον ορισµό µιας νέας γλώσσας σε 
κάποιον άλλο κατάλογο. Για περισσότερες λεπτοµέρειες µπορείτε να ανατρέξετε 
στο κεφάλαιο «Οµαδική εργασία µε από κοινού χρήση γλωσσών και λεξικών» 

Πώς να ∆ηµιουργήσετε µια νέα Οµάδα Γλωσσών 
Στη περίπτωση που, αρκετά συχνά, έχετε να αναγνωρίσετε κείµενα µε ένα 
συγκεκριµένο συνδυασµό γλωσσών, για παράδειγµα Ελληνικά-Αγγλικά, µπορείτε να 
δηµιουργήστε µια οµάδα γλωσσών που θα συνδυάζει τις γλώσσες αυτές. Η οµάδα αυτή 
που δηµιουργήσατε θα εµφανίζεται στη λίστα γλωσσών, στη βασική γραµµή 
εργαλείων. 

Σηµείωση: Μπορείτε να ορίσετε τις γλώσσες αναγνώρισης, ώστε να ενσωµατωθούν 
στη λίστα γλωσσών που βρίσκεται στη βασική γραµµή εργαλείων. Για να γίνει αυτό, 
επιλέξτε το στοιχείο Select multiple languages από τη λίστα. Εµφανίζεται το 
παράθυρο διαλόγου Recognition language, από το οποίο µπορείτε να επιλέξετε τις 
γλώσσες που επιθυµείτε.  

Για να δηµιουργήσετε µια οµάδα γλωσσών: 

1. Στο µενού Tools, επιλέξτε το στοιχείο Language Editor και κάντε κλικ στο 
κουµπί New. Εµφανίζεται ένα παράθυρο διαλόγου. Εκεί, επιλέξτε το στοιχείο 
Create a new group of languages. 
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2. Στη συνέχεια, εµφανίζεται το παράθυρο διαλόγου Language Group Properties. 

 
Ορίστε τις ακόλουθες παραµέτρους για τη δηµιουργία της νέας οµάδας γλωσσών: 

1. Την ονοµασία της οµάδας. 

2. Τις γλώσσες που περιλαµβάνονται στην οµάδα. 

Σηµείωση:  

1. Σε µερικές περιπτώσεις γνωρίζετε στα σίγουρα, πως µερικοί χαρακτήρες δεν 
εµφανίζονται ποτέ στα κείµενα τα οποία αναγνωρίζετε. Εποµένως, µπορείτε να 
ορίσετε το σύνολο αυτών των χαρακτήρων (ονοµάζονται «απαγορευµένοι» 
χαρακτήρες) µέσα στις ιδιότητες της οµάδας γλωσσών. Αποκλείοντας τους 
χαρακτήρες αυτούς, αυξάνεται σηµαντικά την ταχύτητα και την ποιότητα της 
αναγνώρισης. Για να ορίσετε το σύνολο αυτών των χαρακτήρων, στο παράθυρο 
διαλόγου Language Group Properties, κάντε κλικ στο κουµπί Advanced. 
Εµφανίζεται το παράθυρο διαλόγου Advanced Language Group Properties. Στο 
πεδίο Prohibited characters, ορίστε το σύνολο των χαρακτήρων που δεν θα 
χρησιµοποιηθούν ποτέ.  

2. Οι οµάδες γλωσσών που δηµιουργείτε αποθηκεύονται στον ίδιο κατάλογο όπου 
είναι αποθηκευµένη η αντίστοιχη δεσµίδα αρχείων. Το FineReader Premium 
Corporate Edition σας δίνει την δυνατότητα να αποθηκεύσετε τον ορισµό µιας 
νέας γλώσσας σε κάποιον άλλο κατάλογο. Για περισσότερες λεπτοµέρειες 
µπορείτε να ανατρέξετε στο κεφάλαιο «Οµαδική εργασία µε από κοινού χρήση 
γλωσσών και λεξικών» 
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Κεφάλαιο 7  
Έλεγχος και Επεξεργασία Κειµένου 

Μετά τη διαδικασία αναγνώρισης, τα αποτελέσµατα εµφανίζονται στο παράθυρο 
Κειµένου. Το παράθυρο Κειµένου είναι το παράθυρο εργασίας του ενσωµατωµένου 
επεξεργαστή κειµένου του ABBYY FineReader, µέσω του οποίου µπορείτε να ελέγξετε 
τα αποτελέσµατα της αναγνώρισης και να διορθώσετε το αναγνωρισµένο κείµενο. 

Ο επεξεργαστής κειµένου του FineReader διαθέτει δύο βασικά 
χαρακτηριστικά: 

1. Ένα ενσωµατωµένο σύστηµα ορθογραφικού ελέγχου (δείτε τη λίστα γλωσσών µε 
υποστήριξη ορθογραφικού ελέγχου στην ενότητα της ηλεκτρονικής Βοήθειας του 
ABBYY FineReader, «Υποστηριζόµενες Γλώσσες»). 

2. Ένα χρήσιµο οπτικό βοήθηµα: η πρωτότυπη εικόνα που αντιστοιχεί στο κείµενο 
που διορθώνετε κάθε φορά, εµφανίζεται στο παράθυρο Μεγέθυνσης. 

Τα χαρακτηριστικά του ενσωµατωµένου συστήµατος 
ορθογραφικού ελέγχου: 

1. Εργαλεία για την ανίχνευση λέξεων για τις οποίες το πρόγραµµα έχει κάποια 
αµφιβολία (λέξεις που περιέχουν αβέβαιους χαρακτήρες). 

2. Εργαλεία για την εύρεση ανορθόγραφων λέξεων. 

3. Εργαλεία για τη προσθήκη άγνωστων λέξεων στο λεξικό του ABBYY 
FineReader. Η προσθήκη νέων λέξεων αυξάνει σηµαντικά την ποιότητα της 
αναγνώρισης. 

Περιεχόµενα κεφαλαίου: 

! Έλεγχος κειµένου στο ABBYY FineReader 

! Ρυθµίσεις για τον έλεγχο και την επεξεργασία κειµένου 

! Προσθήκη και διαγραφή λέξεων στο λεξικό 

! Επεξεργασία κειµένου στο ABBYY FineReader 

! Επεξεργασία πινάκων 

 



 63

Έλεγχος Κειµένου στο ABBYY FineReader 
Οι αναγνωρισµένοι χαρακτήρες για τους οποίους το σύστηµα έχει κάποια αµφιβολία 
και οι λέξεις που δεν υπάρχουν στο λεξικό, επισηµαίνονται από το πρόγραµµα µε τη 
χρήση διαφορετικών χρωµάτων. Το ανοιχτό µπλε χρώµα, ως προεπιλογή,  
χρησιµοποιείται για την επισήµανση των ακαθόριστων χαρακτήρων και το ροζ χρώµα, 
για την επισήµανση των λέξεων που δεν υπάρχουν µέσα στο λεξικό. Για να 
τροποποιήσετε τα χρώµατα αυτά: 

1. Επιλέξετε το στοιχείο Uncertain Character (Αβέβαιος χαρακτήρας) ή Not in 
Dictionary Word (Λέξη εκτός λεξικού) και το χρώµα που επιθυµείτε στο 
πλαίσιο Color, µέσα από την οµάδα επιλογών Appearance του παράθυρου 
διαλόγου View (µενού Tools>Options). 

Για να ελέγξετε τα αποτελέσµατα της αναγνώρισης: 

1. Στη γραµµή εργαλείων WizardBar, κάντε κλικ στο κουµπί 3-Check Spelling (ή 
στο µενού Tools,  επιλέξτε το στοιχείο Check Spelling). 

2. Θα εµφανιστεί το παράθυρο διαλόγου Check Spelling. 

 
3. Στο παράθυρο διαλόγου Check Spelling υπάρχουν τρία επιµέρους παράθυρα. Το 

ένα, στο επάνω µέρος του διαλόγου, είναι το αντίστοιχο παράθυρο Μεγέθυνσης 
του FineReader, το οποίο προβάλει την πρωτότυπη εικόνα της τυχόν 
ανορθόγραφης λέξης. Το µεσαίο παράθυρο προβάλει την ίδια την ανορθόγραφη 
λέξη, ενώ στην γραµµή πάνω από το παράθυρο αυτό αναφέρεται το είδος του 
προβλήµατος στην αναγνώριση της λέξης. Το παράθυρο επιλογών Suggestions 
που βρίσκεται στο κάτω µέρος του διαλόγου σας προτείνει επιλογές 
αντικατάστασης (εφόσον υπάρχουν). Οι επιλογές αυτές βασίζονται στο λεξικό που 
έχετε επιλέξει στην εµφανιζόµενη λίστα Dictionary language. 

Σηµείωση: Για δική σας διευκόλυνση κατά τη διάρκεια του ελέγχου και της 
διόρθωσης των αποτελεσµάτων της αναγνώρισης, µπορείτε να µεγεθύνετε το παράθυρο 
διαλόγου. Για να γίνει αυτό, κάντε κλικ µε το ποντίκι σας πάνω στα περιθώρια του 
παραθύρου. Τότε, ο δείκτης του ποντικιού θα γίνει ένα διπλό τόξο. Σύρετε τα 
περιθώρια για να µεγεθύνετε  ή να µικρύνετε το παράθυρο διαλόγου.  
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4. Αν υπάρχουν ανορθόγραφες µπορείτε: 

! Να κάνετε κλικ στο κουµπί Ignore (Παράβλεψη) για να παραµείνει η λέξη 
ως έχει. 

! Να κάνετε κλικ στο κουµπί Ignore All (Παράβλεψη όλων) προκειµένου να 
αγνοηθεί η λέξη σε όλες τις περιπτώσεις που εµφανίζεται. 

Σηµείωση: Όταν πατήσετε το πλήκτρο Ignore ή Ignore All κατά τον 
έλεγχο µιας λέξης, το FineReader παύει να θεωρεί "αβέβαιη" την λέξη αυτή. 
Το σύστηµα θεωρεί ότι η λέξη αυτή δεν περιέχει µη αναγνωρισµένους ή 
αµφίβολα αναγνωρισµένους χαρακτήρες. Κατά συνέπεια δεν τους 
χρωµατίζει ανάλογα στο παράθυρο κειµένου, ούτε τους αντικαθιστά από τις 
εικόνες τους σε περίπτωση που αποθηκεύσετε το κείµενο σε µορφή PDF µε 
ενεργοποιηµένη την επιλογή Replace uncertain characters with images. 

! Να επιλέξετε µια από τις προτεινόµενες λέξεις προς αντικατάσταση και στη 
συνέχεια, κάντε κλικ στο κουµπί Replace (Αντικατάσταση) ή Replace All 
(Αντικατάσταση όλων) για να αντικαταστήσετε την ενεργή λέξη ή όλες τις 
εµφανίσεις της λέξης µέσα στο κείµενο. Στην περίπτωση που δεν υπάρχει 
καµία εναλλακτική λύση αντικατάστασης για τη λέξη που εµφανίζεται στο 
παράθυρο Suggestions, πληκτρολογήστε τη σωστή µέσα στο µεσαίο 
παράθυρο του διαλόγου και κάντε κλικ στο κουµπί Confirm (Επιβεβαίωση) 
ή Confirm All (Επιβεβαίωση Ολων) για να αντικαταστήσετε την τρέχουσα 
λέξη ή όλες τις λέξεις που είναι σαν αυτή. 

! Να κάνετε κλικ στο Add� (Προσθήκη) για να καταχωρηθεί η λέξη στο 
λεξικό. Μετά την προσθήκη της λέξεως, το πρόγραµµα θα θεωρήσει σωστές 
όλες τις παράγωγες µορφές της λέξεως αυτής.  

! Να κάνετε κλικ στο Options� (Ρυθµίσεις) για να ορίσετε τις ρυθµίσεις του 
συστήµατος ορθογραφικού ελέγχου. 

! Να κάνετε κλικ στο Close (Τερµατισµός) για να κλείσετε το παράθυρο 
διαλόγου. 

Μετακίνηση ανάµεσα σε αµφίβολες λέξεις 

Μπορείτε να επιταχύνετε τον έλεγχο των αποτελεσµάτων της αναγνώρισης 
χρησιµοποιώντας τα πλήκτρα  και  για µεταφερθείτε αυτοµάτως στην 
προηγούµενη ή την επόµενη αµφίβολη λέξη. 

Το ίδιο αποτέλεσµα µπορείτε να επιτύχετε χρησιµοποιώντας τα πλήκτρα F4 και 
Shift+F4 αντίστοιχα. 

Ρυθµίσεις για τον Έλεγχο και την Επεξεργασία Κειµένου 
Στην καρτέλα Check Spelling (µενού Tools>Options), µπορείτε να ορίσετε τις 
ακόλουθες ρυθµίσεις. 

1. Επίπεδο εµφάνισης λαθών.  

Σηµείωση: Η ρύθµιση αυτή θα πρέπει να οριστεί πριν από την έναρξη της 
αναγνώρισης. 

2. Ο έλεγχος να σταµατά στις λέξεις που περιέχουν αβέβαιους χαρακτήρες 

3. Ο έλεγχος να σταµατά στις λέξεις που δεν περιέχονται στο λεξικό 
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4. Ο έλεγχος να σταµατά στις σύνθετες λέξεις 

5. Ο έλεγχος να αγνοεί τις λέξεις που περιέχουν ψηφία και τους χαρακτήρες που δεν 
περιέχονται στην αλφάβητο 

6. Ο έλεγχος να διορθώνει τα κενά πριν και µετά τα σηµεία στίξεως  

Επίπεδο εµφάνισης λαθών  

Στη λίστα επιλογών Error display level (Επίπεδο εµφάνισης λαθών), µπορείτε να 
επιλέξετε τις ακόλουθες επιλογές: 

1. None (κανένα) � να µην επισηµαίνονται από το πρόγραµµα τα λάθη που 
προκύπτουν από την αναγνώριση. 

2. Standard (βασικό) � να επισηµαίνονται οι µη αναγνωρισµένοι χαρακτήρες και 
αυτοί που αναγνωρίστηκαν µε κάποια αµφιβολία από το πρόγραµµα. 

3. Thorough (εκτενές) � περιλαµβάνει τα χαρακτηριστικά της Standard επιλογής 
και επιπλέον, επισηµαίνονται από το πρόγραµµα οι λέξεις που δεν περιέχονται στο 
λεξικό. 

Σηµείωση: Ο αριθµός λαθών που εµφανίζονται στο παράθυρο κειµένου, θα αλλάξει, 
αφού η σελίδα αναγνωρισθεί εκ νέου µετά την αλλαγή των ρυθµίσεων. 

Ο έλεγχος να σταµατά στις λέξεις που περιέχουν αβέβαιους 
χαρακτήρες 

Με την ενεργοποίηση αυτής της επιλογής (Stop at words with uncertain characters), 
ο ορθογραφικός έλεγχος σταµατά στις λέξεις που περιέχουν χαρακτήρες, οι οποίοι δεν 
έχουν αναγνωριστεί µε µεγάλη εµπιστοσύνη από το σύστηµα. 

Ο έλεγχος να σταµατά στις λέξεις που δεν περιέχονται στο λεξικό 

Με την ενεργοποίηση αυτής της επιλογής (Stop at words not found in the 
dictionary), το σύστηµα ορθογραφικού ελέγχου σταµατά στις λέξεις που δεν 
περιέχονται στο λεξικό. Εάν κάποια λέξη δεν υπάρχει στο λεξικό σηµαίνει πως, ίσως, η 
αναγνώριση της συγκεκριµένης λέξης έγινε λανθασµένα. 

Ο έλεγχος να σταµατά στις σύνθετες λέξεις 

Με την ενεργοποίηση αυτής της επιλογής (Stop at compound words), το σύστηµα 
ορθογραφικού ελέγχου σταµατά στις λέξεις εκείνες, οι οποίες δεν υπάρχουν στο λεξικό, 
αλλά µπορούν να προκύψουν είτε µε βάση τα εκάστοτε διαθέσιµα µορφολογικά 
µοντέλα, είτε από λέξεις  που περιέχονται στο λεξικό. 

Ο έλεγχος να αγνοεί τις λέξεις που περιέχουν ψηφία και άλλους 
χαρακτήρες που δεν περιέχονται στην αλφάβητο 

Με την ενεργοποίηση αυτής της επιλογής (Ignore words with digits and other non-
alphabetic characters), το σύστηµα ορθογραφικού ελέγχου θα θεωρεί τις λέξεις, που 
περιέχουν ψηφία και άλλους χαρακτήρες που δεν συµπεριλαµβάνονται στη γλώσσα 
αναγνώρισης, ως σωστές, εκτός κι αν µέσα στις λέξεις αυτές περιέχονται αβέβαιοι 
χαρακτήρες. 
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Ο έλεγχος να διορθώνει τα κενά πριν και µετά τα σηµεία στίξεως 

Με την ενεργοποίηση αυτής της επιλογής (Correct spaces before and after 
(punctuation marks), το σύστηµα ορθογραφικού ελέγχου δεν θα σταµατήσει εάν βρει 
κενά που έχουν τοποθετηθεί λανθασµένα πριν ή µετά τα σηµεία στίξεως, απλά θα τα 
διορθώσει αυτόµατα. 

Προσθήκη και ∆ιαγραφή Λέξεων στο Λεξικό 

Προσθήκη µιας λέξεως στο λεξικό 

Ο εµπλουτισµός του λεξικού βοηθά σηµαντικά στην βελτιστοποίηση της ακρίβειας των 
αποτελεσµάτων της αναγνώρισης. Κατά τη διάρκεια της αναγνώρισης, το FineReader 
ελέγχει τις λέξεις που αναγνωρίζονται και τις συγκρίνει µε αυτές που υπάρχουν µέσα 
στο ορθογραφικό λεξικό. Για το λόγο αυτό, θα µπορούσατε να προσθέσετε στο λεξικό 
άγνωστες λέξεις που εµφανίζονται συχνά µέσα στο κείµενό σας (π.χ., ορολογία, 
συντοµογραφίες, κύρια ονόµατα, κ.ά.).  

Ένα βασικό πλεονέκτηµα του συστήµατος ορθογραφικού ελέγχου που παρέχει το 
FineReader, είναι πως δεν προσθέτει απλά τη λέξη µε τη µορφή που υπάρχει µέσα στο 
κείµενο, αλλά επιπλέον, δηµιουργεί ένα µορφολογικό υπόδειγµα της λέξης (µια 
συστηµατική παρουσίαση όλων των µορφών µιας λέξης), π.χ. το σύνολο όλων των 
µορφών της λέξεως. Η συγκεκριµένη λειτουργία, διευκολύνει το FineReader στην 
άµεση «εκµάθηση» της µορφολογικής ανάλυσης της λέξης, βάσει της πρωτότυπης 
µορφής της µέσα από το κείµενο. Έτσι στη συνέχεια, µπορεί να αναγνωρίσει τη λέξη µε 
οποιαδήποτε µορφή και αν παρουσιαστεί.  

Για να προσθέσετε µια λέξη στο λεξικό κατά τη διάρκεια του ορθογραφικού 
ελέγχου: 

! Στο παράθυρο διαλόγου Check Spelling, κάντε κλικ στο κουµπί Add 
(Προσθήκη). 

Ορίστε τις ακόλουθες παραµέτρους µέσα στο παράθυρο διαλόγου Primary Form: 

1. Part of speech (Μέρος του λόγου): Noun (Ουσιαστικό), Adjective (Επίθετο), 
Verb (Ρήµα), Uninflected (Άκλιτη λέξη). 

2. Όταν η λέξη γράφεται πάντα µε κεφαλαίο το αρχικό γράµµα, επιλέξτε το στοιχείο 
Proper name. Αν η λέξη αποτελεί µια συντοµογραφία, ενεργοποιήστε την 
επιλογή Abbreviation.  

3. Την κύρια µορφή της λέξης. 

Κάντε κλικ στο ΟΚ για να εµφανιστεί το παράθυρο διαλόγου Create Paradigm.  
Μέσα σε αυτό το παράθυρο διαλόγου, το FineReader κάνει µερικές ερωτήσεις σχετικά 
µε τις µορφές της συγκεκριµένης λέξης. Οι απαντήσεις που θα δώσετε διευκολύνουν το 
FineReader στη δηµιουργία ενός µορφολογικού υποδείγµατος της λέξης που θέλετε να 
προσθέσετε. Κάντε κλικ στο Yes ή στο No αντίστοιχα, για να  απαντήσετε στις 
ερωτήσεις του FineReader. Στην περίπτωση που απαντήσετε λανθασµένα σε κάποια 
ερώτηση, κάντε κλικ στο κουµπί Anew για να δώσετε τη σωστή απάντηση. Στο 
παράθυρο διαλόγου Paradigm, εµφανίζεται το µορφολογικό υπόδειγµα της λέξης που 
δηµιουργήθηκε. 
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Σηµείωση:  

1. Στην περίπτωση που δε θέλετε να σχηµατίσετε το µορφολογικό υπόδειγµα και 
πάντα προσθέτετε ή θέλετε να προσθέσετε λέξεις άκλιτες, τότε ενεργοποιήστε την 
επιλογή Add without prompting for word forms (Προσθήκη χωρίς να 
προταθούν οι υπόλοιπες µορφές της λέξης) στην καρτέλα Check Spelling 
(µενού Tools>Options). Η επιλογή αυτή είναι διαθέσιµη µόνο στο αγγλικό 
λεξικό. 

2. Επιπλέον, µπορεί αν θέλετε να προσθέσετε λέξεις όταν εµφανίζεται η λίστα µε τις 
λέξεις που έχουν προστεθεί στο λεξικό. Για να γίνει αυτό, στο µενού Tools, 
ενεργοποιήστε την επιλογή View Dictionaries (Εµφάνιση Λεξικών). Στο 
παράθυρο διαλόγου Select Language (Επιλογή Γλώσσας) που εµφανίζεται, 
κάντε κλικ στο κουµπί View. Εµφανίζεται το λεξικό µε τη λίστα των λέξεων που 
έχουν προστεθεί σ� αυτό. Για να προσθέσετε τη λέξη που θέλετε, κάντε κλικ στο 
κουµπί Add (Προσθήκη). 

3. Η δυνατότητα δηµιουργίας µορφολογικού υποδείγµατος για τις λέξεις που 
προστίθενται στο λεξικό υπάρχει για τις εξής γλώσσες: Αγγλικά, Αρµένικα, 
Γαλλικά, Γερµανικά, Ισπανικά, Ιταλικά, Ουκρανικά και Ρώσικα 

Εάν η λέξη που θέλετε να προσθέσετε υπάρχει ήδη στο λεξικό, το σύστηµα θα σας 
ενηµερώσει για αυτό. Στην περίπτωση αυτή, µπορείτε να εµφανίσετε το µορφολογικό 
υπόδειγµα της συγκεκριµένης λέξης. Εάν πιστεύετε πως το µορφολογικό υπόδειγµα 
είναι λανθασµένο (το οποίο είναι σύνηθες φαινόµενο όταν προσθέτετε µια οµώνυµη 
λέξη, η οποία ανήκει σε κάποιο άλλο µέρος του λόγου), µπορείτε να ορίσετε ένα 
διαφορετικό (στο παράθυρο διαλόγου Add Word, κάντε κλικ στο κουµπί Add).  

Συµβουλή:  

1. Το FineReader σας επιτρέπει να εισάγετε λεξικά, τα οποία έχουν δηµιουργηθεί 
από προγενέστερες εκδόσεις (3.0, 4.0 και 5.0).  

2. Επιπλέον, το FineReader σας επιτρέπει να εισάγετε το λεξικό (*.dic) που 
χρησιµοποιείτε στο Microsoft Word 6.0, 7.0, 97 και 2000. 

Για να εισάγετε ένα λεξικό: 

1. Στο µενού Tools, επιλέξτε την εντολή View Dictionaries (Εµφάνιση Λεξικών) 
και στη συνέχεια, επιλέξτε τη γλώσσα του λεξικού και κάντε κλικ στο κουµπί 
View.  

2. Στο παράθυρο διαλόγου View Dictionaries, κάντε κλικ στο κουµπί Import και 
επιλέξτε τα αρχεία µε επέκταση *.pmd, *.txt ή *.dic. 

Για να διαγράψετε µια λέξη από το λεξικό: 

1. Στο µενού Tools, επιλέξτε την εντολή View Dictionaries. Στη συνέχεια, επιλέξτε 
τη γλώσσα που θέλετε και κάντε κλικ στο κουµπί OK. Εµφανίζεται ένα παράθυρο 
διαλόγου. 

2. Επιλέξτε τη λέξη που θέλετε να διαγράψετε και κάντε κλικ στο κουµπί Delete 
(∆ιαγραφή). 

Επεξεργασία Κειµένου στο ABBYY FineReader 
Σηµείωση: Εάν στο παράθυρο Κειµένου του FineReader δεν εµφανίζονται σωστά οι 
χαρακτήρες (π.χ. εάν υπάρχουν σύµβολα τύπου �?� ή ��� στη θέση µερικών ή όλων 
των γραµµάτων µιας λέξης), σηµαίνει ότι η ενεργή γραµµατοσειρά δεν υποστηρίζει 
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πλήρως την αλφάβητο της γλώσσας που επιλέξατε για την αναγνώριση. Στην 
κατηγορία επιλογών Fonts (Γραµµατοσειρές) της καρτέλας Formatting 
(Μορφοποίηση) (µενού Tools>Options), επιλέξτε µια γραµµατοσειρά που 
υποστηρίζει στο σύνολό της την αναγνώριση (για παράδειγµα, Arial Unicode ή 
Bitstream Cyberbit) και αναγνωρίστε το έγγραφο ξανά.  

Όταν αναγνωρισθεί µια σελίδα, το κείµενό της εµφανίζεται στο παράθυρο Κειµένου. 
Όταν εξάγετε το αναγνωρισµένο κείµενο σε κάποια εφαρµογή, η πρωτότυπη µορφή του 
κειµένου διατηρείται ανάλογα µε το ποιες επιλογές διατήρησης της µορφής του 
κειµένου έχετε ορίσει. Στην καρτέλα Formatting (µενού Tools>Options) και στα 
παράθυρα διαλόγων των αντίστοιχων µορφοποιήσεων, µπορείτε να ορίσετε τις 
ρυθµίσεις αυτές. 

Το πρόγραµµα επισηµαίνει τους χαρακτήρες που αναγνωρίσθηκαν µε κάποια 
αµφιβολία. Εάν θέλετε, µπορείτε να ακυρώσετε την επισήµανση τέτοιων χαρακτήρων, 
αναιρώντας την επιλογή του στοιχείου Highlight uncertain characters, στην καρτέλα 
View (µενού Tools>Options).  

Το FineReader προσφέρει δύο καταστάσεις εµφάνισης του αναγνωρισµένου εγγράφου: 
Full (πλήρης µορφοποίηση) και Draft (πρόχειρη)  

Η κατάσταση Full εµφανίζει τα µπλοκ του αναγνωρισµένου κειµένου, πινάκων και 
εικόνων ακριβώς όπως εµφανίζονται στην πρωτότυπη σελίδα. Στην κατάσταση αυτή 
διατηρείται πλήρως η διάταξη του πρωτότυπου εγγράφου: στήλες, πίνακες, εικόνες και 
αρχιγράµµατα (µεγάλα γράµµατα που καταλαµβάνουν περισσότερες από µια γραµµές 
της παραγράφου). Το µπλοκ στο οποίο βρίσκεται ο δροµέας είναι το ενεργό (τρέχον) 
µπλοκ. Μετακινώντας τον δροµέα µε τα βελάκια, ο δροµέας µετακινείται από µπλοκ σε 
µπλοκ σύµφωνα µε την αρίθµησή τους στην εικόνα. Αν ένα µπλοκ κειµένου είναι πολύ 
µεγάλο για να χωρέσει µέσα στα όρια του πλαισίου του (π.χ. τροποποιήσατε το κείµενό 
του µε αποτέλεσµα να µεγαλώσει) τότε κάποιο µέρος του κειµένου του µπορεί να µην 
είναι ορατό, εφόσον το µπλοκ δεν είναι ενεργό. Σε αυτήν την περίπτωση εµφανίζονται 
κόκκινα σηµεία στο πλαίσιο που περιβάλει το µπλοκ. Μόλις το µπλοκ γίνει ενεργό το 
πλαίσιό του διευρύνεται έτσι ώστε να εµφανίζεται όλο το κείµενό του. 

Στην κατάσταση Draft δεν εµφανίζονται τα παρακάτω χαρακτηριστικά µορφοποίησης: 
αριστερό περιθώριο, στοίχιση παραγράφου (όλες οι παράγραφοι εµφανίζονται 
στοιχισµένες αριστερά). Επίσης χρησιµοποιείται ένα µέγεθος γραµµατοσειράς 
(συνήθως 12pt) για όλο το κείµενο, όµως ο τύπος της γραµµατοσειράς (Times, Arial, 
Courier) και παραλλαγές της (έντονα, πλάγια, υπογραµµισµένα, εκθέτες και δείκτες) 
εξακολουθούν να εµφανίζονται. 

Μπορείτε να επιλέξετε την επιθυµητή κατάσταση εµφάνισης του κειµένου µε τα 
πλήκτρα  (για την ενεργοποίηση του full mode) και  (για την ενεργοποίηση του 
draft mode) που βρίσκονται στο παράθυρο κειµένου. 

Μπορείτε να αλλάξετε το µέγεθος της γραµµατοσειράς που χρησιµοποιείται για την 
πρόχειρη εµφάνιση του κειµένου, ως εξής:  

1. Στο µενού Tools, επιλέξτε το στοιχείο Options. 

2. Στην καρτέλα View, επιλέξτε Draft editor font size και ορίστε το µέγεθος 
γραµµατοσειράς που επιθυµείτε. 

Γραµµατοσειρά 

Μέγεθος γραµµατοσειράς 

Έντονα 

Πλάγια

Υπογράµµιση

Εκθέτης

∆είκτης

Αριστερή στοίχ.

Στοίχ. στο 
κέντρο 

∆εξιά στοίχ. 

Πλήρης 
στοίχ. 

Επώµενο λάθος

Προηγούµενο λάθος

Εµφάνιση µη εκτυπώσιµων χαρακτήρων 
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Το ενσωµατωµένο σύστηµα επεξεργασίας του FineReader παρέχει τις ακόλουθες 
λειτουργίες επεξεργασίας κειµένου: 

! Αντιγραφή, αποκοπή, και επικόλληση  

! Εύρεση και αντικατάσταση 

! Στυλ γραµµατοσειράς 

! Στοίχιση κειµένου 

! Αναίρεση και ακύρωση αναίρεσης 

Αντιγραφή, αποκοπή, επικόλληση 

1. Προτού χρησιµοποιήσετε τις εντολές αντιγραφής, αποκοπής και επικόλλησης, θα 
πρέπει να επιλέξετε το κείµενο που θέλετε να επεξεργασθείτε. 

2. Ανάλογα µε το τι θέλετε να κάνετε, µπορείτε να ακολουθήσετε τις παρακάτω 
οδηγίες: 

Για να αντιγράψετε την επιλογή σας: 

! Στη βασική γραµµή εργαλείων, κάντε κλικ στο κουµπί Copy ή  

! Στο µενού Edit (Επεξεργασία) ή στο µενού συντόµευσης, επιλέξτε την 
εντολή Copy (Αντιγραφή) ή 

! Πατήστε σε συνδυασµό τα λειτουργικά πλήκτρα CTRL+C 

Για να γίνει η αποκοπή της επιλογής σας: 

! Στη βασική γραµµή εργαλείων, κάντε κλικ στο κουµπί Cut ή 

! Στο µενού Edit (Επεξεργασία) ή στο µενού συντόµευσης, επιλέξτε την 
εντολή Cut (Αποκοπή) ή 

! Πατήστε συνδυαστικά τα λειτουργικά πλήκτρα CTRL+Χ 

Για να επικολλήσετε το κείµενο που αντιγράψατε: 

! Στη βασική γραµµή εργαλείων, κάντε κλικ στο κουµπί Paste ή 

! Στο µενού Edit (Επεξεργασία) ή στο µενού συντόµευσης, επιλέξτε την 
εντολή Paste (Επικόλληση) ή 

! Πατήστε συνδυαστικά τα λειτουργικά πλήκτρα CTRL+V 

Εύρεση και αντικατάσταση 

Για να βρείτε µια λέξη ή φράση µέσα από το κείµενο που επεξεργάζεστε: 

1. Εκτελέστε µια από τις ακόλουθες ενέργειες: 

! Στο µενού Edit, επιλέξτε το στοιχείο Find (Εύρεση), ή 

! Πατήστε τα πλήκτρα CTRL+F 

2. Εµφανίζεται το παράθυρο διαλόγου Find (Εύρεση). Στη γραµµή Find what 
(Εύρεση του) που βρίσκεται στο παράθυρο διαλόγου, πληκτρολογήστε τη λέξη ή 
τη φράση που επιθυµείτε να βρείτε και ορίστε τις παραµέτρους αναζήτησης. 

Σηµείωση: Για να επαναλάβετε την αναζήτηση της ίδιας λέξης µε τις ίδιες 
παραµέτρους, πατήστε απλά το πλήκτρο F3. 

 
Κουµπί 

Αντιγραφής 

 
Κουµπί 
Αποκοπής 

 
Κουµπί 

Επικόλλησης 
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Για να βρείτε και να αντικαταστήσετε µια λέξη ή φράση µέσα στο το κείµενο που 
επεξεργάζεστε: 

1. Εκτελέστε µια από τις ακόλουθες ενέργειες: 

! Στο µενού Edit, επιλέξτε το στοιχείο Replace (Αντικατάσταση), ή 

! Πατήστε τα πλήκτρα CTRL+H 

2. Εµφανίζεται το παράθυρο διαλόγου Replace (Αντικατάσταση). Στη γραµµή Find 
what (Εύρεση του) που βρίσκεται στο παράθυρο διαλόγου, πληκτρολογήστε τη 
λέξη ή τη φράση που επιθυµείτε να βρείτε και αντίστοιχα τη λέξη ή φράση µε την 
οποία θέλετε να την αντικαταστήσετε στη γραµµή Replace with (Αντικατάσταση 
µε) και ορίστε τις παραµέτρους αναζήτησης. 

Στυλ γραµµατοσειράς 

1. Κάντε κλικ πάνω στη λέξη ή επιλέξτε το κείµενο που επιθυµείτε να γίνει η αλλαγή 
γραµµατοσειράς. 

2. Εκτελέστε µια από τις ακόλουθες ενέργειες: 

! Στη γραµµή εργαλείων Μορφοποίησης (Formatting), κάντε κλικ στο  
κουµπί που χρειάζεστε (π.χ. ), ή  

! Κάντε δεξί κλικ στο παράθυρο Text και από το µενού συντόµευσης, επιλέξτε 
το στοιχείο Character Properties (Ιδιότητες Χαρακτήρων). Εµφανίζεται 
το παράθυρο διαλόγου Character (Χαρακτήρας). Στο παράθυρο διαλόγου, 
επιλέξτε τον τύπο γραµµατοσειράς που επιθυµείτε και ορίστε τις 
απαραίτητες παραµέτρους γραµµατοσειράς, ή 

! Πατήστε CTRL+B � για να εφαρµόσετε την έντονη γραφή, CTRL+I � για 
να εφαρµόσετε την πλάγια γραφή, CTRL+U � για την υπογράµµιση της 
λέξεως ή του κειµένου.  

Σηµείωση:   Το φόντο του µπλοκ, καθώς και ορισµένες παράµετροι µορφοποίησης, 
τις οποίες µπορείτε να ορίσετε στο παράθυρο διαλόγου Font (Γραµµατοσειρά), : 
(όπως η χρήση µικρών κεφαλαίων χαρακτήρων στην θέση πεζών  δεν εµφανίζονται 
µέσω του ενσωµατωµένου συστήµατος επεξεργασίας του FineReader. Μπορείτε να 
δείτε τα χαρακτηριστικά αυτά εφόσον αποθηκεύσετε το έγγραφό σας σε µια εφαρµογή 
που υποστηρίζει αυτές τις ρυθµίσεις µορφοποίησης (π.χ. MS Word).  

Στοίχιση κειµένου 

1. Επιλέξτε το κείµενο που θέλετε να στοιχίσετε 

2. Κάντε ένα από τα ακόλουθα: 

! Πατήστε το κατάλληλο πλήκτρο (π.χ. ) από την γραµµή εργαλείων 
Μορφοποίησης, ή 

! Κάντε δεξί κλικ στο παράθυρο κειµένου και επιλέξτε Character properties 
(Ιδιότητες χαρακτήρων) από το µενού συντόµευσης. Στο παράθυρο 
διαλόγου Character, που θα εµφανιστεί επιλέξτε την κατάλληλη επιλογή 
στο πεδίο Alignment (Στοίχιση). 

 Αναίρεση και ακύρωση αναίρεσης 

Εκτελέστε µια από τις ακόλουθες ενέργειες: 
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Για να αναιρέσετε µια ενέργεια: 

! Στη γραµµή εργαλείων Standard, κάντε κλικ στο κουµπί Undo, ή 

! Στο µενού Edit, επιλέξτε το στοιχείο Undo (Αναίρεση), ή 

! Πατήστε CTRL+Z 

Για να ακυρώσετε την αναίρεση µιας ενέργειας: 

! Στη γραµµή εργαλείων Standard, κάντε κλικ στο κουµπί Redo, ή 

! Στο µενού Edit, επιλέξτε το στοιχείο Redo (Ακύρωση αναίρεσης), ή 

! Πατήστε CTRL+Y 

Επεξεργασία Πινάκων 

Το σύστηµα επεξεργασίας πινάκων παρέχει εργαλεία µε τα οποία 
µπορείτε να εκτελέσετε τα ακόλουθα: 

! Συγχώνευση κελιών ή γραµµών 

! ∆ιαίρεση κελιών 

! ∆ιαίρεση γραµµών ή στηλών 

! ∆ιαγραφή κελιών 

Για την συγχώνευση κελιών ή γραµµών: 

! Κρατήστε πατηµένο το λειτουργικό κουµπί CTRL και επιλέξτε τα κελιά ή τις 
γραµµές που επιθυµείτε να συγχωνεύσετε. Στη συνέχεια, στο µενού Edit, επιλέξτε 
το στοιχείο Merge Table Cells (Συγχώνευση Κελιών του Πίνακα) ή Merge 
Table Rows (Συγχώνευση Γραµµών του Πίνακα). 

Για τη διαίρεση κελιών: 

! Στο µενού Edit, επιλέξτε το στοιχείο Split Table Cells (∆ιαχωρισµός Κελιών 
του Πίνακα). 

Σηµείωση: Η εντολή αυτή µπορεί να εφαρµοστεί µόνο στα κελιά όπου έχει γίνει 
προηγούµενα συγχώνευση. 

Για την διαίρεση γραµµών ή στηλών: 

! Στη γραµµή εργαλείων του παράθυρου Εικόνας (Image), επιλέξτε, είτε το 
εργαλείο , είτε το . Στη συνέχεια, κάντε κλικ στη γραµµή/στήλη που 
επιθυµείτε να διαιρέσετε, για να προσθέσετε µια οριζόντια/κάθετη διαχωριστική 
γραµµή. 

Σηµείωση: Για να συγχωνεύσετε τις γραµµές ενός πίνακα, µπορείτε ακόµα να 
χρησιµοποιήσετε το εργαλείο , ή την εντολή Merge Table Rows (µενού Edit). 

 
Κουµπί 
Αναίρεσης 

 
Κουµπί 

Επανάληψης 
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Για τη διαγραφή κελιών: 

! Στο παράθυρο κειµένου, επιλέξτε ένα ή περισσότερα κελιά που θέλετε να 
διαγράψετε και πατήστε DEL. 
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Κεφάλαιο 8  
Αποθήκευση σε συνεργαζόµενες 
εφαρµογές και αρχεία 

Μπορείτε να αποθηκεύσετε τα αποτελέσµατα της αναγνώρισης σε ένα αρχείο, να τα 
στείλετε σε κάποια άλλη εφαρµογή χωρίς να τα αποθηκεύσετε, να τα αντιγράψετε στο 
πρόχειρο ή ακόµα και να τα στείλετε µέσω ηλεκτρονικού ταχυδροµείου (e-mail). 
Επιπλέον µπορείτε να επιλέξετε αν θα αποθηκεύσετε όλες τις σελίδες ή µόνο µερικές 
επιλεγµένες σελίδες. 

Για την αποθήκευση των αποτελεσµάτων αναγνώρισης, το ABBYY 
FineReader συνεργάζεται µε τις ακόλουθες εφαρµογές: 

Microsoft Word 6.0, 7.0, 97 (8.0), 2000 (9.0), 2002 (10.0) και 2003 (11.0). Microsoft 
Excel 6.0, 7.0, 97 (8.0), 2000 (9.0), 2002 (10.0) και 2003 (11.0). Microsoft PowerPoint 
2002 (10.0), 2003 (11.0),  Corel Word Perfect 7.0, 8.0, 9.0, 2002 (10.0) και 11. Lotus 
Word Pro 9.5, 97 και Millennium Edition. StarWriter 4.x και 5.x, PROMT 98 καθώς 
και οποιαδήποτε άλλη εφαρµογή υποστηρίζει το πρότυπο ODMA. 

Περιεχόµενα κεφαλαίου: 

! Γενικά για την αποθήκευση του αναγνωρισµένου κειµένου 

! Ρυθµίσεις αποθήκευσης κειµένου 

! Αποθήκευση του αναγνωρισµένου κειµένου σε αρχεία RTF και DOC και αρχεία 
Word XML 

! Αποθήκευση του αναγνωρισµένου κειµένου σε αρχεία PDF 

! Αποθήκευση του αναγνωρισµένου κειµένου σε αρχεία HTML 

! Αποθήκευση του αναγνωρισµένου κειµένου σε αρχεία PPT 

! Αποθήκευση της εικόνας µιας σελίδας 
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Γενικά για την Αποθήκευση του Αναγνωρισµένου 
Κειµένου 

Μπορείτε: 

! Να αποθηκεύσετε το αναγνωρισµένο κείµενο µε τη βοήθεια του οδηγού 
αποθήκευσης Save Wizard, 

! Να αποθηκεύσετε τις ανοιχτές ή επιλεγµένες σελίδες σε κάποιο φάκελο ή να τις 
στείλετε σε κάποια άλλη εφαρµογή, 

! Να αποθηκεύσετε όλες τις σελίδες της δεσµίδας αρχείων σε κάποιο φάκελό ή να 
τις εξάγετε σε κάποια άλλη εφαρµογή, 

! Να αποθηκεύσετε την εικόνα της σελίδας. 

Κάντε κλικ στο κουµπί 4-Save για να εξάγετε τα αποτελέσµατα της αναγνώρισης στην 
εφαρµογή που επιθυµείτε ή να τα αποθηκεύσετε σε ένα φάκελο. Η εµφάνιση του 
εικονιδίου εξαρτάται από την τρέχουσα λειτουργία αποθήκευσης. Έτσι, κάθε φορά το 
κουµπί Save εµφανίζει τον τίτλο της ενεργής εφαρµογής που έχετε επιλέξει για να 
αποθηκευθούν τα αποτελέσµατα της αναγνώρισης. 

Για να αποθηκεύσετε το αναγνωρισµένο κείµενο:  

! Κάντε κλικ στο βέλος που βρίσκεται δεξιά από το κουµπί 4-Save και στο µενού 
συντόµευσης επιλέξτε το στοιχείο που επιθυµείτε. 

Σηµείωση: Εάν θέλετε να αποθηκεύσετε µόνο µερικές από τις σελίδες, θα πρέπει να 
τις επιλέξτε τις πριν ενεργοποιήσετε το κουµπί 4-Save. 

Αφού τελειώσετε µε την εξαγωγή των αναγνωρισµένων σελίδων, το εικονίδιο του 
κουµπιού 4-Save θα λάβει τη µορφή της ενέργειας που έχετε επιλέξει � π.χ. εάν έχετε 
εξάγει το αναγνωρισµένο κείµενο σε κάποια εφαρµογή, το έχετε στείλει µε 
ηλεκτρονικό ταχυδροµείο, το έχετε αντιγράψει στο πρόχειρο ή το έχετε αποθηκεύσει σε 
κάποιο φάκελο. Το εικονίδιο του κουµπιού 4-Save υιοθετεί πάντα το εικονίδιο της 
εφαρµογής που έχετε χρησιµοποιήσει την τελευταία φορά για να εξάγετε τα 
αποτελέσµατα της αναγνώρισης. Εποµένως, εάν επιθυµείτε να εξάγετε κάποια άλλη 
εικόνα (ή εικόνες) χρησιµοποιώντας την ίδια εφαρµογή, µπορείτε απλά να κάνετε κλικ 
πάνω στο εικονίδιο, χωρίς να χρειαστεί να την ενεργοποιήσετε από το µενού 
συντόµευσης του κουµπιού. 

Ρυθµίσεις Αποθήκευσης Κειµένου 
Για να δείτε τις ρυθµίσεις για την αποθήκευση κειµένου, ενεργοποιήστε την καρτέλα 
Formatting (Μορφοποίηση) στο µενού Tools>Options. Επιπλέον, µερικές ρυθµίσεις 
αποθήκευσης µπορούν να ορισθούν και στα παράθυρα διαλόγου Save Wizard και Save 
Text as. 

! Επιλογές µορφοποίησης και διατήρησης της µορφής του κειµένου 

! ∆ιατήρηση εικόνων (φωτογραφιών) 

! Ανάλυση των εικόνων (κατά την αποθήκευση σε RTF κλπ) 

! Ποιότητα JPEG 
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! Επιλογή των γραµµατοσειρών που θα χρησιµοποιηθούν 

! Επιλογή αν θα αποθηκευτούν όλες οι σελίδες της δεσµίδας αρχείων ή µόνο οι 
επιλεγµένες 

! Επιλογές του τρόπου αποθήκευσης του αναγνωρισµένου κειµένου 

Επιλογές µορφοποίησης και διατήρησης της  
πρωτότυπης µορφής του κειµένου  
(αποθήκευση σε RTF/DOC/Word XML, PPT και HTML) 

! Retain full page � ∆ιατηρείται πλήρως η µορφή του κειµένου: η στοίχιση σε 
παραγράφους, η γραµµατοσειρά και το µέγεθος γραµµατοσειράς, οι στήλες, η 
κατεύθυνση κειµένου, το χρώµα κειµένου, η δοµή των πινάκων. 

! Retain font and font size � ∆ιατήρηση της γραµµατοσειράς και του µεγέθους 
της: διατηρείται η δοµή των πινάκων, η στοίχιση σε παραγράφους, η 
γραµµατοσειρά και το µέγεθός της. 

! Remove all formating � Αφαιρείται όλη η µορφοποίηση. ∆ιατηρείται µόνο η 
δοµή των πινάκων και ο χωρισµός σε παραγράφους. 

Σηµείωση: Ανάλογα µε την εφαρµογή προς την οποία θα επιλέξετε να εξάγετε τα 
αποτελέσµατα της αναγνώρισης, υπάρχουν επιπλέον ρυθµίσεις που µπορείτε να 
ορίσετε. Για παράδειγµα, στην περίπτωση που χρησιµοποιήσετε για την αποθήκευση 
αρχεία RTF/DOC/Word XML, µπορείτε να ορίσετε το µέγεθος των σελίδων και τον 
τρόπο επισήµανσης των χαρακτήρων που αναγνωρίσθηκαν µε κάποια αµφιβολία από 
το πρόγραµµα. Εάν επιλέξετε την αποθήκευση σε αρχείο HTML µπορείτε να ορίσετε 
την ανάλυση των φωτογραφιών και την κωδικοσελίδα της σελίδας. Στην περίπτωση 
που επιλέξετε PDF αρχεία, µπορείτε να ορίσετε τη χρήση γραµµατοσειρών Type 1 (εάν 
χρησιµοποιείτε µια άλλη κωδικοσελίδα διαφορετική από τα Λατινικά, για παράδειγµα, 
Κυριλλικά, Ελληνικά, κ.ά). Οι ρυθµίσεις αυτές µπορούν να ορισθούν στο παράθυρο 
διαλόγου Formats Settings (µενού Tools>Formats Settings). Το παράθυρο διαλόγου 
περιλαµβάνει διαφορετικές καρτέλες όπου κάθε µια από αυτές αντιστοιχεί σε ένα τύπο 
αρχείου. Έτσι, µπορείτε να κάνετε κλικ στην καρτέλα που σας ενδιαφέρει και να ορίστε 
τις ρυθµίσεις που επιθυµείτε. 

∆ιατήρηση Εικόνων 

Με την επιλογή αυτή (Keep pictures), τα µπλοκ εικόνας θα αποθηκευθούν µαζί µε το 
αναγνωρισµένο κείµενο. Η ρύθµιση αυτή είναι διαθέσιµη µόνο όταν η αποθήκευση 
γίνεται σε αρχεία RTF/DOC/Word XML, PPT ή HTML. 

Ανάλυση των εικόνων  
(αποθήκευση σε RTF/DOC/Word XML, PDF, PPT και HTML) 

Σε κάποιες περιστάσεις είναι χρήσιµο οι εικόνες που περιλαµβάνονται στο τελικό 
αρχείο να είναι σε χαµηλή ανάλυση. Για παράδειγµα στα αρχεία HTML, τα οποία 
εµφανίζονται στην οθόνη, οι εικόνες δεν χρειάζεται να είναι υψηλής ανάλυσης. Σε 
τέτοιες περιπτώσεις µπορείτε να µειώσετε την ανάλυση των εικόνων κατά την 
αποθήκευση (επιτυγχάνοντας µικρότερα µεγέθη αρχείων) χωρίς να έχετε ουσιαστικά 
απώλεια στην ποιότητα της εικόνας.. Απλά βάλτε την κατάλληλη τιµή στο πεδίο 
Reduce picture resolution to (Μείωση της ανάλυσης των εικόνων) στο παράθυρο 
διαλόγου που ανοίγει από το µενού Tools>Format settings (καρτέλες 
RTF/DOC/Word XML, PDF, PPT,  HTML)  
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Σηµείωση: Αν βάλετε µια τιµή, η οποία είναι µεγαλύτερη από την ανάλυσης της 
πρωτότυπης εικόνας στο πεδίο Reduce picture resolution to, η τιµή αυτή θα αγνοηθεί 
και οι εικόνες θα αποθηκευτούν στην ανάλυση της πρωτότυπης εικόνας. 

Ποιότητα JPEG  
(αποθήκευση σε RTF/DOC/Word XML, PDF, PPT και HTML) 

Κατά την αποθήκευση σε αρχεία µορφής RTF, DOC, Word XML, PDF και HTML, οι 
εικόνες αποθηκεύονται χρησιµοποιώντας τον αλγόριθµο JPEG 

Ο αλγόριθµος αυτός "θυσιάζει" την ποιότητα της εικόνας προς όφελος της 
εξοικονόµησης χώρου. Ο συγκεκριµένος αλγόριθµος επιτρέπει να γίνει "συµβιβασµός" 
ανάµεσα στην ποιότητα και το µέγεθος της εικόνας. Η τιµή του πεδίου JPEG quality 
(Ποιότητα JPEG) (µενού Tools>Format settings καρτέλες RTF/DOC/Word XML, 
PDF, PPT και HTML) σας δίνει την δυνατότητα να καθορίσετε το επίπεδο ποιότητας 
που επιθυµείτε . Στο πεδίο αυτό µπορείτε να βάλετε τιµές µεταξύ 1 και 100.  

Όσο µεγαλύτερη τιµή βάλετε στο παραπάνω πεδίο, τόσο καλύτερη θα είναι και η 
ποιότητα των εικόνων στα έγγραφα που θα αποθηκεύσετε. Ταυτόχρονα όµως 
επηρεάζεται και το µέγεθος των αποθηκευµένων εικόνων: όσο µεγαλύτερη είναι η τιµή 
του πεδίου, τόσο µεγαλύτερο θα είναι και το αρχείο jpg που θα δηµιουργηθεί. Για να 
πετύχετε την βέλτιστη σχέση µεταξύ ποιότητας και µεγέθους αρχείου, δοκιµάστε να 
αποθηκεύσετε την ίδια εικόνα χρησιµοποιώντας διαφορετικές τιµές και στην συνέχεια 
ανοίξτε την µε την κατάλληλη εφαρµογή. 

Επιλογή των γραµµατοσειρών που θα χρησιµοποιηθούν (αφορά 
την αποθήκευση σε αρχεία RTF, DOC ή HTML) 

Οι γραµµατοσειρές, που αναφέρονται στην καρτέλα Formatting, είναι αυτές που 
χρησιµοποιούνται από το FineReader κατά την αποθήκευση σε αρχεία RTF/DOC/Word 
XML, PPT ή HTML. Μπορείτε να καθορίσετε τις γραµµατοσειρές που θέλετε να 
χρησιµοποιηθούν. Μπορείτε να αλλάξετε γραµµατοσειρά είτε µέσα στο παράθυρο 
Κειµένου είτε ορίζοντας κάποιες άλλες γραµµατοσειρές µέσα από την κατηγορία 
επιλογών Fonts, στη καρτέλα Formatting και να αναγνωρίσετε ξανά το κείµενο. 

Επιλογή αν θα αποθηκευτούν όλες οι σελίδες της δεσµίδας 
αρχείων ή µόνο οι επιλεγµένες 

Έχετε την δυνατότητα να αποθηκεύσετε όλες τις αναγνωρισµένες σελίδες της δεσµίδας 
αρχείων ή µόνο αυτές που έχετε επιλέξει. Εάν επιθυµείτε να αποθηκεύσετε µόνο 
µερικές από τις σελίδες της δεσµίδας, θα πρέπει να τις επιλέξτε πριν ξεκινήσετε την 
διαδικασία της αποθήκευσης. 

Τρόπος αποθήκευσης του αναγνωρισµένου κειµένου  
(διαθέσιµο µόνο στην περίπτωση που αποθηκεύετε περισσότερες 
από µια σελίδες της δεσµίδας αρχείων) 

! Create a separate file for each page � Kάθε σελίδα της δεσµίδας αρχείων αποθη-
κεύεται σε ένα ξεχωριστό αρχείο. Ο αριθµός της κάθε σελίδας της δεσµίδας 
αρχείων προστίθεται αυτόµατα στο τέλος του ονόµατος του αρχείου που έχετε 
δώσει. 
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! Name files as source images � Κάθε σελίδα της δεσµίδας αρχείων αποθηκεύεται 
σε ένα ξεχωριστό αρχείο, του οποίου το όνοµα προκύπτει από το όνοµα αρχείου 
απ' όπου προήρθε η πρωτότυπη σελίδα. 

Σηµείωση:  

1. Οι σελίδες της δεσµίδας, για τις οποίες δεν υπάρχει πληροφορία για το 
όνοµα αρχείου της πρωτότυπης σελίδας (π.χ. σελίδες που εισήχθηκαν στην 
δεσµίδα µέσω σαρωτή) δεν πρόκειται να αποθηκευτούν κατ' αυτόν τον 
τρόπο. Θα εµφανιστεί ένα ενηµερωτικό µήνυµα στην περίπτωση που 
τέτοιες σελίδες περιλαµβάνονται σε αυτές που θελήσατε να αποθηκεύσετε. 

2. Αν µια οµάδα διαδοχικών σελίδων έχει το ίδιο όνοµα πρωτοτύπου, το 
FineReader τις αντιµετωπίζει σαν σελίδες ενός πολυσέλιδου (multipage) 
αρχείου TIFF και σώζει το κείµενό τους σε ένα αρχείο. Αν οι σελίδες της 
δεσµίδας µε το κοινό όνοµα αρχείου πρωτοτύπου δεν είναι διαδοχικές, 
τότε το FineReader τις αντιµετωπίζει σαν χωριστά αρχεία και σώζει το 
κείµενό τους σε ξεχωριστά αρχεία, το όνοµα των οποίων προκύπτει από το 
κοινό όνοµα της πρωτότυπης εικόνας µε την προσθήκη ενός αύξοντα 
αριθµού (_1, _2 κ.λπ.) 

! Create a new file at each blank page � Η δεσµίδα χωρίζεται σε οµάδες, που κάθε 
µία αποθηκεύεται σε ένα ξεχωριστό αρχείο. Οι οµάδες αυτές, διαχωρίζονται από 
κενές σελίδες που υπάρχουν στην δεσµίδα αρχείων. Τα ονόµατα των αρχείων 
προκύπτουν από ένα όνοµα που ορίζει ο χρήστης, µε την προσθήκη ενός αύξοντα 
αριθµού (-1, -2, -3 κ.λπ.) 

! Create a single file for all pages � όλες (ή όλες οι επιλεγµένες) σελίδες της 
δεσµίδας αρχείων αποθηκεύονται σε ένα και µοναδικό αρχείο. 

Αποθήκευση σε Αρχεία RTF, DOC και Word XML 
Σηµαντικό: Η ρύθµιση για αποθήκευση σε αρχεία Word XML είναι διαθέσιµη µόνο 
στο MS Word 2003. 

Στο παράθυρο διαλόγου Options (µενού Tools>Options), κάντε κλικ στην καρτέλα 
Formatting από την οποία µπορείτε να ορίσετε τις λειτουργίες διατήρησης της 
µορφοποίησης της σελίδας. 

Σηµείωση: Όταν αποθηκεύετε το αναγνωρισµένο κείµενο σε αρχεία RTF ή DOC ή 
Word XML, οι γραµµατοσειρές που χρησιµοποιούνται είναι εκείνες που έχουν ορισθεί 
εκ των προτέρων στο παράθυρο διαλόγου Options (µενού Tools>Options) στην 
καρτέλα Formatting ή εκείνες που ορίσατε στο παράθυρο Κειµένου κατά τη διάρκεια 
της επεξεργασίας του. 
 

Συµβουλή:  

! Εάν προτιµάτε να επεξεργαστείτε και να διορθώσετε το αναγνωρισµένο κείµενο 
απ� ευθείας στο Microsoft Word αντί µέσω του παραθύρου Κειµένου του 
FineReader, το πρόγραµµα µπορεί κι εκεί να επισηµάνει τους αµφίβολα αναγνωρι-
σµένους χαρακτήρες. Για να γίνει αυτό, στην καρτέλα RTF/DOC/Word XML, 
ορίστε στην οµάδα επιλογών Highlight uncertain characters (Επισήµανση 
αβέβαιων χαρακτήρων), τα στοιχεία With background color (Με χρώµα 
φόντου) ή/και With text color (Με το χρώµα κειµένου). Έτσι, µέσα στο 
αποθηκευµένο αρχείο, οι αµφίβολα αναγνωρισµένοι χαρακτήρες θα εµφανίζονται 
µε το χρώµα που έχετε ορίσει εσείς.  
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! Αν έχετε σώσει τα αποτελέσµατα της αναγνώρισης σε µορφή Word XML, έχετε 
την δυνατότητα να δείτε την εικόνα του πρωτότυπου εγγράφου σε παράθυρο 
Μεγέθυνσης, µέσα στο παράθυρο του MS Word. Στο παράθυρο αυτό εµφανίζεται 
σε µεγέθυνση η εικόνα που αντιστοιχεί στο σηµείο του εγγράφου, όπου βρίσκεται 
ο δροµέας. Η επιλογή Open FineReader�s Zoom window in MS Word 2003 
(Άνοιγµα το παραθύρου Μεγέθυνσης του FineReader στο MS Word 2003) 
είναι ενεργοποιηµένη ως προεπιλογή στην καρτέλα RTF/DOC/Word XML. 

Αποθήκευση σε Αρχεία PDF 

Επιλογές διατήρησης της µορφοποίησης του εγγράφου: 

1. Text and pictures only � αποθηκεύονται µόνο το κείµενο και οι φωτογραφίες του 
αναγνωρισµένου κειµένου. 

2. Image only � το αρχείο PDF που δηµιουργείται περιέχει µόνο τις πρωτότυπες 
εικόνες των σελίδων. 

3. Text over the page image � Το κείµενο επικαλύπτει την εικόνα της σελίδας. 
Oλόκληρη η εικόνα της σελίδας αποθηκεύεται σαν φωτογραφία. Οι περιοχές 
κειµένου αποθηκεύονται σαν κείµενο πάνω από τη φωτογραφία. 

4. Text under the page image � Το κείµενο επικαλύπτεται από την εικόνα της 
σελίδας. Oλόκληρη η εικόνα της σελίδας αποθηκεύεται σαν φωτογραφία. Το 
αναγνωρισµένο κείµενο αποθηκεύεται κάτω από αυτή. Η επιλογή αυτή είναι πολύ 
χρήσιµη όταν επιθυµείτε να εξάγετε το κείµενό σας σε συστήµατα ηλεκτρονικής 
αρχειοθέτησης εγγράφων. Με τον τρόπο αυτό διατηρείται πλήρως η εµφάνιση 
όλης της σελίδας και επιπλέον, σας δίνεται η δυνατότητα full-text αναζήτησης 
(αναζήτηση βάσει λέξεων µέσα από το κείµενο). 

Για να ορίσετε τις επιλογές αυτές:  

1. Στο µενού Tools, επιλέξτε το στοιχείο Formats Settings. Εµφανίζεται το 
παράθυρο διαλόγου Formats Settings. 

2. Στην καρτέλα PDF του διαλόγου, ορίστε τις ρυθµίσεις που επιθυµείτε. 

Σηµείωση:  

1. Ενεργοποιώντας τις λειτουργίες Text and pictures only ή Text over the page 
image, θα έχετε στη διάθεσή σας την επιλογή ειδικής ρύθµισης Replace 
uncertain words with images (Αντικατάσταση αβέβαιων λέξεων µε εικόνες). 
Ορίζοντας την επιλογή αυτή, όλες οι αµφίβολα αναγνωρισµένες λέξεις θα 
αντικατασταθούν µε τις εικόνες τους. Η ρύθµιση αυτή βρίσκεται στο παράθυρο 
διαλόγου Formats Settings, στην καρτέλα PDF. 

2. Αν πρέπει να επεξεργαστείτε το αναγνωρισµένο κείµενο πριν το αποθηκεύσετε σε 
µορφή PDF, σας συνιστούµε να φροντίσετε να διατηρήσετε τον χωρισµό του 
κειµένου σε γραµµές (δηλ. µην διαγράψετε γραµµές κειµένου και µην προσθέσετε 
νέες). Σε αντίθετη περίπτωση, το PDF που θα δηµιουργηθεί δεν θα εµφανίζεται 
σωστά στην οθόνη (π.χ. κάποιες γραµµές µπορεί να επικαλύπτονται. 

3. Αν το κείµενο που αποθηκεύετε περιλαµβάνει χαρακτήρες από µη λατινικές 
κωδικοσελίδες (π.χ. Κυριλλικά, Ελληνικά, κ.λπ) το FineReader θα χρησιµοποιήσει 
γραµµατοσειρές της εταιρείας ParaType (www.paratype.com/shop) 

4. Αν, κατά την διάρκεια της αποθήκευσης σε µορφή PDF, σας εµφανιστεί ένα 
µήνυµα, το οποίο θα σας ενηµερώνει ότι το κείµενό σας περιέχει χαρακτήρες που 
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δεν περιλαµβάνονται στα standerd fonts, τότε θα πρέπει να επιλέξετε την χρήση 
γραµµατοσειρών Type 1 και να ορίσετε τις γραµµατοσειρές Type 1 που θέλετε να 
χρησιµοποιηθούν. Οι γραµµατοσειρές αυτές θα πρέπει να είναι διαθέσιµες µέσω 
του Adobe Type Manager ή µέσω του Postscript Font Installer (Windows 2000)  

5. Προτού τροποποιήσετε ένα αρχείο PDF, το οποίο περιλαµβάνει χαρακτήρες από 
µη λατινικές κωδικοσελίδες (π.χ. Κυριλλικά, Ελληνικά, Τσέχικα κ.λπ) στο Adobe 
Acrobat, θα χρειαστεί να αλλάξετε την γραµµατοσειρά του κειµένου που θέλετε 
να επεξεργαστείτε σε µια γραµµατοσειρά, που να είναι εγκατεστηµένη στον 
υπολογιστή σας. 

Αποθήκευση σε Αρχεία HTML 
Τις επιλογές διατήρησης της µορφοποίησης του κειµένου, κατά την αποθήκευση σε 
αρχεία HTML, µπορείτε να τις ορίσετε στο παράθυρο διαλόγου Options (µενού 
Tools>Options), ενεργοποιώντας την καρτέλα Formatting. 

Σηµείωση: Όταν αποθηκεύσετε το αναγνωρισµένο κείµενο σε αρχεία HTML, θα 
χρησιµοποιηθούν οι γραµµατοσειρές που έχουν ορισθεί στην καρτέλα Formatting, στο 
παράθυρο διαλόγου Options (µενού Tools>Options) ή εκείνες που ορίσατε κατά τη 
διάρκεια της επεξεργασίας του αναγνωρισµένου κειµένου στο παράθυρο Κειµένου. 

Για να διατηρήσετε εικόνες σε ένα αρχείο HTML: 

! Στο παράθυρο διαλόγου Options, ενεργοποιείστε την καρτέλα Formatting και 
στη συνέχεια, ορίστε την επιλογή Keep pictures (∆ιατήρηση φωτογραφιών). 

Σηµείωση: Οι εικόνες αποθηκεύονται σε ξεχωριστά αρχεία *.jpg. Η ανάλυση των 
εικόνων καθώς και η ποιότητα τους µπορεί να οριστούν από την καρτέλα HTML του 
παραθύρου διαλόγου Formats settings (µενού Tools>Formats settings). 

∆ιαθέσιµες µορφές αρχείων HTML 

1. Full (πλήρης � χρησιµοποιεί CSS, απαιτεί Internet Explorer 4.0 ή µεταγενέστερο) 
� µε την ενεργοποίηση αυτής της επιλογής, χρησιµοποιούνται οι νεότερες 
προδιαγραφές για αρχεία HTML (HTML 4). Υποστηρίζει οποιοδήποτε επίπεδο 
διατήρησης της µορφοποίησης του πρωτότυπου εγγράφου (το πραγµατικό επίπεδο 
διατήρησης της µορφοποίησης του εγγράφου εξαρτάται από τις ρυθµίσεις που 
έχουν ορισθεί στην καρτέλα Formatting από την κατηγορία επιλογών Retain 
layout). 

2. Simple (απλή � είναι συµβατή µε όλους τους Internet browser) � µε την 
ενεργοποίηση αυτής της επιλογής το αρχείο αποθηκεύεται σύµφωνα µε τις 
προδιαγραφές HTML 3. Η µορφοποίησης του εγγράφου διατηρείται κατά 
προσέγγιση: δεν διατηρείται η εσοχή της πρώτης γραµµή της παραγράφου και το 
µέγεθος της γραµµατοσειράς διατηρείται κατά προσέγγιση (οι προδιαγραφές του 
HTML 3 προβλέπουν ένα περιορισµένο αριθµό µεγέθους γραµµατοσειρών· κατά 
συνέπεια, το FineReader θα αναγκαστεί να επιλέξει εκείνο το µέγεθος γραµµα-
τοσειράς, που προσεγγίζει καλύτερα το πραγµατικό µέγεθος της γραµµατοσειράς 
του κειµένου σας). Το συγκεκριµένο αρχείο HTML υποστηρίζεται από όλους τους 
browser (Netscape Navigator, Internet Explorer 3.0 ή µεταγενέστερη έκδοση). 

3. Auto (αυτόµατη � αποθηκεύει το κείµενο τόσο πλήρη όσο και σε απλή µορφή σε 
ένα αρχείο µε αυτόµατη επιλογή της κατάλληλης, ανάλογα µε τον τύπο του 
browser) � και οι δύο µορφές (Simple και Full) αποθηκεύονται στο ίδιο αρχείο, 
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µαζί µε κώδικα ο οποίος ελέγχει τις δυνατότητες που υποστηρίζει ο browser που 
χρησιµοποιείται, και επιλέγει αυτόµατα την κατάλληλη. 

Για να ορίσετε τη µορφή αρχείου HTML που επιθυµείτε: 

! Στη καρτέλα HTML (οµάδα επιλογών Formats του παράθυρο διαλόγου Formats 
Settings (µενού Tools>Options)) κάντε κλικ στην επιλογή που επιθυµείτε. 

Σηµείωση: Το πρόγραµµα ανιχνεύει αυτόµατα την κωδικοσελίδα. Για να αλλάξετε 
την κωδικοσελίδα, στο παράθυρο διαλόγου Formats Settings, ενεργοποιήστε την 
καρτέλα HTML και επιλέξτε εκείνη που θέλετε µέσα από το πεδίο Code page.  

Αποθήκευση σε αρχεία PPT 
Ορίστε το επίπεδο διατήρησης της µορφοποίησης στην καρτέλα Formatting στο 
παράθυρο διαλόγου Options (µενού Tools>Options) 

Σηµείωση: Όταν αποθηκεύσετε το αναγνωρισµένο κείµενο σε αρχεία HTML, θα 
χρησιµοποιηθούν οι γραµµατοσειρές που έχουν ορισθεί στην καρτέλα Formatting, στο 
παράθυρο διαλόγου Options (µενού Tools>Options) ή εκείνες που ορίσατε κατά τη 
διάρκεια της επεξεργασίας του αναγνωρισµένου κειµένου στο παράθυρο Κειµένου. 

Προσοχή: Όταν το FineReader αποθηκεύει τα αποτελέσµατα της αναγνώρισης σε 
αρχεία .PPT, στην πραγµατικότητα δηµιουργεί ειδικού τύπου αρχεία HTML, τα οποία 
περιέχουν τα διάφορα µέρη της παρουσίασης. Για να σώσετε την παρουσίαση σαν ένα 
ενιαίο αρχείο θα πρέπει να την ανοίξετε µε το PowerPoint και να την ξανασώσετε 
(επιλέξτε File>Save As από το µενού του PowerPoint και διαλέξτε ως µορφή αρχείου 
την PPT). 

Αποθήκευση της Εικόνας µιας Σελίδας 
1. Επιλέξτε µια σελίδα από τη δεσµίδα αρχείων. 

2. Στο µενού File, επιλέξτε Save Image As (Αποθήκευση εικόνας ως). Εµφανίζεται 
το παράθυρο διαλόγου Save as. 

3. Επιλέξτε το δίσκο και το φάκελο, µέσα στον οποίο θέλετε να αποθηκεύσετε το 
αρχείο και στη συνέχεια, επιλέξτε τη µορφή του αρχείου που επιθυµείτε. 

Σηµείωση: Εάν θέλετε, µπορείτε να αποθηκεύσετε µόνο µερικές περιοχές της 
εικόνας, οι οποίες αντιστοιχούν σε κάποια από τα µπλοκ. Για να γίνει αυτό, θα πρέπει 
να επιλέξετε τα επιθυµητά µπλοκ και, στη συνέχεια, στο παράθυρο διαλόγου Save 
Image as, να επιλέξτε το στοιχείο Save only selected blocks (Αποθήκευση µόνο των 
επιλεγµένων µπλοκ). Αυτή η δυνατότητα είναι διαθέσιµη µόνο στην περίπτωση 
αποθήκευσης µιας µεµονωµένης σελίδας. 

4. Ορίστε το όνοµα του αρχείου. 

5. Κάντε κλικ στο ΟΚ.  
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Σηµείωση: Μπορείτε να αποθηκεύσετε περισσότερες από µια εικόνες σε ένα αρχείο 
(ένα πολυσέλιδο αρχείο TIFF). Για να το επιτύχετε αυτό: 

1. Στο παράθυρο της δεσµίδας αρχείων, επιλέξτε τις εικόνες που επιθυµείτε.  

2. Στο µενού File, επιλέξτε το στοιχείο Save Image As. Στη συνέχεια, επιλέξτε ως 
µορφή αποθήκευσης, τη µορφή αρχείων TIFF και ενεργοποιήστε την επιλογή 
Save as multipage image file (Αποθήκευση ως πολυσέλιδο αρχείο εικόνας). 

Σηµείωση: Στην περίπτωση που αποθηκεύσετε τις εικόνες περισσότερων από µιας 
σελίδων σαν ξεχωριστά αρχεία (δηλ. δεν ενεργοποιήστε την επιλογή Save as 
multipage image file) τα ονόµατα των αρχείων θα προκύψουν από το όνοµα το οποίο 
θα δώσετε στο παράθυρο διαλόγου µε την προσθήκη ενός τετραψήφιου αριθµού, 
οποίος θα αντιστοιχεί στον αριθµό της σελίδας στην δεσµίδα. 
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Κεφάλαιο 9  
Εργασία µε ∆εσµίδες Αρχείων (Batches) 

Μια δεσµίδα αρχείων αποτελεί το βασική µονάδα οργάνωσης των δεδοµένων του 
ABBYY FineReader: όλες οι ψηφιοποιηµένες εικόνες, το αναγνωρισµένο κείµενο, 
όπως και άλλα δεδοµένα, φυλάγονται µέσα στη δεσµίδα αρχείων. Στην πλειοψηφία 
τους οι ρυθµίσεις του FineReader, ορίζονται για µια δεσµίδα αρχείων: η ψηφιοποίηση, 
η αναγνώριση, οι ρυθµίσεις αποθήκευσης, κ.λπ. Τα υποδείγµατα γραµµατοσειρών, οι 
γλώσσες, καθώς και οι οµάδες γλωσσών, «ανήκουν» και αυτά στην δεσµίδα αρχείων, 
όπου ορίζονται. Για τη δηµιουργία µιας νέας δεσµίδας αρχείων µπορείτε, είτε να 
χρησιµοποιήσετε τις προεπιλεγµένες ρυθµίσεις, είτε τις ρυθµίσεις της τρέχουσας 
δεσµίδας είτε ακόµα ρυθµίσεις που έχετε προηγουµένως αποθηκεύσει σ� ένα αρχείο 
*.fbt. 

Περιεχόµενα κεφαλαίου: 

! Γενικά για την εργασία µε δεσµίδες αρχείων 

! ∆ηµιουργία νέας δεσµίδας αρχείων 

! Άνοιγµα δεσµίδας αρχείων 

! Προσθήκη εικόνων σε µια δεσµίδα αρχείων 

! Αρίθµηση σελίδων σε µια δεσµίδα αρχείων 

! Αποθήκευση µιας δεσµίδας αρχείων 

! Κλείσιµο µιας δεσµίδας αρχείων 

! ∆ιαγραφή µιας δεσµίδας αρχείων 

! Παράµετροι µιας δεσµίδας αρχείων 

! Αναζήτηση full-text στις αναγνωρισµένες σελίδες της δεσµίδας αρχείων 
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Γενικά για την Εργασία µε ∆εσµίδες Αρχείων (Batches) 
Με την εκκίνηση του το FineReader δηµιουργεί µια νέα δεσµίδα αρχείων που 
βρίσκεται στο φάκελο του FineReader. Μια δεσµίδα αρχείων µπορεί να περιέχει µέχρι 
και  9999 σελίδες. 

Συµβουλή: Συχνά είναι προτιµότερο να αποθηκεύετε σελίδες του ιδίου τύπου σε µια 
δεσµίδα αρχείων. Αυτό µπορεί να γίνει για παράδειγµα, όταν εργάζεσθε µε σελίδες από 
ένα συγκεκριµένο βιβλίο ή µε κείµενα που είναι γραµµένα στην ίδια γλώσσα ή ακόµα 
και µε εικόνες που περιέχουν την ίδια µορφοποίηση, κ.ο.κ.. Έτσι, θα είναι πιο εύκολο 
να εντοπίσετε και να οργανώσετε την εργασία σας. 

Στο παράθυρο της δεσµίδας αρχείων εµφανίζεται το σύνολο των σελίδων της 
ενεργοποιηµένης δεσµίδας αρχείων. Για να δείτε µια σελίδα από αυτές, κάντε απλά 
κλικ στο εικονίδιο ή διπλό κλικ στον αριθµό που αντιστοιχεί στη σελίδα. Όλα τα αρχεία 
που συσχετίζονται µε τη συγκεκριµένη σελίδα της δεσµίδας αρχείων, θα ανοίξουν στα 
αντίστοιχα παράθυρά τους, π.χ. το αρχείο κειµένου (αν η σελίδα έχει αναγνωρισθεί) θα 
εµφανιστεί στο παράθυρο κειµένου και το αρχείο εικόνας θα εµφανισθεί στο παράθυρο 
εικόνας. 

Υπάρχουν δύο βασικοί τρόποι, µε τους οποίους εµφανίζονται οι σελίδες στο 
παράθυρο Batch: 

Προβολή ∆εσµίδας Περιγραφή 

Thumbnails 
(Εικονίδια) 

Στη συγκεκριµένη κατάσταση προβολής, οι σελίδες της 
δεσµίδας αρχείων εµφανίζονται σε µικρογραφία. Κατά την 
επεξεργασία της εικόνας, εµφανίζονται πάνω στη µικρογραφία 
και άλλα εικονίδια, τα οποία σας ενηµερώνουν για την 
πραγµατοποίηση µιας ενέργειας πάνω στην εικόνα (π.χ. 
αναγνώριση, αποθήκευση, κ.ά). Η προβολής αυτή, διευκολύνει 
τον εντοπισµό µιας συγκεκριµένης σελίδας από τη δεσµίδα: 
βλέποντας την εικόνα της σελίδας σε µικρογραφία στο 
παράθυρο της δεσµίδας, µπορείτε εύκολα να εντοπίσετε τη 
σελίδα που θέλετε. Για να ανοίξετε µια εικόνα, απλά κάντε 
κλικ πάνω στη µικρογραφία της. 

Details 
(Λεπτοµέρειες) 

Επιλέγοντας τη συγκεκριµένη προβολή, στο παράθυρο της 
δεσµίδας αρχείων εµφανίζονται λεπτοµερείς πληροφορίες για 
κάθε σελίδα της δεσµίδας αρχείων. η ταξινόµηση της λίστας 
των σελίδων, µπορεί να γίνει βάσει οποιουδήποτε 
χαρακτηριστικού της. Η προβολή Details είναι πολύ εύχρηστη 
στην περίπτωση που εργάζεσθε µε µια µεγάλη δεσµίδα 
αρχείων, διότι έτσι στο παράθυρο της δεσµίδας εµφανίζεται 
µεγαλύτερος αριθµός σελίδων από ότι στην προβολή 
Thumbnail. Για να ανοίξετε µια σελίδα κάντε διπλό κλικ πάνω 
σε αυτή. 

Για να επιλέξετε την κατάσταση προβολής στο παράθυρο της 
δεσµίδας αρχείων (Batch): 

! Κάντε κλικ σε ένα από τα εικονίδια  ή  στην Βασική γραµµή εργαλείων. 
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! Κάντε δεξί κλικ µέσα στο παράθυρο της δεσµίδας, και στη συνέχεια, επιλέξτε το 
στοιχείο View>� από το µενού συντόµευσης που εµφανίζεται. 

Επιπλέον, µπορείτε να ρυθµίσετε την προβολή του παραθύρου δεσµίδας, π.χ. µπορείτε 
να επιλέξετε τα χαρακτηριστικά που θα εµφανίζονται, τον τρόπο ταξινόµησης των 
σελίδων, κ.ο.κ. Για να γίνει αυτό: 

! Κάντε δεξί κλικ µέσα στο παράθυρο δεσµίδας και στη συνέχεια, επιλέξτε το 
στοιχείο Batch View>Customize από το µενού συντόµευσης που εµφανίζεται. 
Εµφανίζεται ένα παράθυρο διαλόγου. Στις καρτέλες Thumbnails και Details του 
διαλόγου, ορίστε τις ρυθµίσεις που επιθυµείτε. 

Μπορείτε να επιλέξετε αρκετές σελίδες ή ένα συνεχόµενο αριθµό σελίδων: 

! Για να επιλέξετε ένα αριθµό συνεχόµενων σελίδων, επιλέξτε την πρώτη και, 
κρατώντας πατηµένο το πλήκτρο Shift, κάντε κλικ την τελευταία σελίδα από το 
σύνολο σελίδων που θέλετε να επιλέξετε. 

! Για να επιλέξετε ορισµένες σελίδες, κρατήστε πατηµένο το πλήκτρο CTRL και 
κάντε κλικ στις σελίδες που επιθυµείτε. 

! Για να επιλέξετε όλες τις σελίδες της δεσµίδας αρχείων, ενεργοποιείστε το 
παράθυρο δεσµίδας και στο µενού Edit, επιλέξτε το στοιχείο Select All (Επιλογή 
όλων) ή πατήστε τα πλήκτρα CTRL+A. 

∆ηµιουργία Νέας ∆εσµίδας Αρχείων 

Για να δηµιουργήσετε µια νέα δεσµίδα αρχείων: 

• Στο µενού File, επιλέξτε το στοιχείο New Batch.  

• Κάντε κλικ στο κουµπί New Batch ( ). 

 

Άνοιγµα ∆εσµίδας Αρχείων 
Ξεκινώντας το FineReader δηµιουργεί αυτόµατα µια νέα δεσµίδα. 

Σηµείωση: Αν θέλετε το FineReader να ανοίγει ξεκινώντας την τελευταία ενεργή 
δεσµίδα αρχείων, θα πρέπει να ενεργοποιήσετε την επιλογή Open the last batch at 
startup, στην καρτέλα General στο παράθυρο διαλόγου Options. 

1. Στο µενού File επιλέξτε το στοιχείο Open Batch (Άνοιγµα δεσµίδας) ή κάντε 
κλικ στο κουµπί ( ). Εµφανίζεται το παράθυρο διαλόγου Open Batch. 

2. Στο παράθυρο διαλόγου Open Batch, επιλέξτε τον κατάλογο που περιέχει τη 
δεσµίδα αρχείων που χρειάζεστε. Όταν ανοίξετε µια δεσµίδα αρχείων, η 
προηγούµενη δεσµίδα µε την οποία εργαζόσασταν κλείνει και αποθηκεύεται 
αυτόµατα. 

Μπορείτε να ανοίξετε µια δεσµίδα απευθείας µέσα από την Εξερεύνηση των Windows 
(Windows Explorer): 

! Κάντε δεξί κλικ στον κατάλογο όπου είναι αποθηκευµένη η δεσµίδα των αρχείων 
(ο κατάλογος δηλώνεται µε το εικονίδιο ) και, από το µενού συντόµευσης, 
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επιλέξτε το Open with FineReader. Το FineReader θα ξεκινήσει ανοίγοντας την 
δεσµίδα αρχείων που επιλέξατε. 

Προσθήκη Εικόνων σε µια ∆εσµίδα Αρχείων 
! Στο µενού File, επιλέξτε το στοιχείο Open Image ή πατήστε CTRL+O. 

! Στο παράθυρο διαλόγου Open Image, επιλέξτε την εικόνα ή τις εικόνες που 
θέλετε να ενεργοποιήσετε. Το FineReader θα προσθέσει τις εικόνες στην ενεργή 
δεσµίδα αρχείων και θα αντιγράψει τα αρχεία των εικόνων στον κατάλογο της 
δεσµίδας αρχείων. 

Σηµείωση: Μπορείτε να προσθέσετε εικόνες σε µια δεσµίδα απευθείας µέσα από την 
Εξερεύνηση των Windows (Windows Explorer): 

1. Επιλέξτε µία ή περισσότερες εικόνες µέσα από την Εξερεύνηση των Windows. 

2. Κάντε δεξί κλικ στην επιλογή σας και επιλέξτε το Open with FineReader από το 
µενού συντόµευσης. Αν το FineReader εκτελείται ήδη οι εικόνες θα προστεθούν 
στη τρέχουσα δεσµίδα, αλλιώς το FineReader θα ξεκινήσει ανοίγοντας την 
τελευταία ενεργή ή µια νέα δεσµίδα αρχείων (ανάλογα µε την ρύθµιση Open last 
batch on startup) και θα προσθέσει τις εικόνες σε αυτήν. 
Η προαναφερθείσα επιλογή στο µενού συντόµευσης είναι διαθέσιµη µόνο σε 
αρχεία των υποστηριζόµενων µορφών εικόνων. 

Αρίθµηση Σελίδων σε µια ∆εσµίδα Αρχείων 
Όλες οι σελίδες της δεσµίδας αρχείων είναι αριθµηµένες. Μια δεσµίδα αρχείων µπορεί 
να περιλαµβάνει µέχρι και 9999 σελίδες. Ο αριθµός της σελίδας εµφανίζεται µέσα στη 
δεσµίδα αρχείων. 

Μπορείτε να αλλάξετε την αρίθµηση των σελίδων είτε µέσα στο παράθυρο Εµφάνισης 
∆εσµίδας είτε µέσα από το παράθυρο διαλόγου Renumber pages. 

Για την αλλαγή του αριθµού µιας σελίδας στο παράθυρο 
Εµφάνισης ∆εσµίδας: 

1. Κάντε κλικ σε µια σελίδα στο παράθυρο Εµφάνισης ∆εσµίδας και πατήστε το 
πλήκτρο F2. 

2. Πληκτρολογήστε το νέο αριθµό σελίδας. 

Μόλις αλλάξετε τον αριθµό σελίδας, η σελίδα θα εµφανιστεί µέσα στην δεσµίδα στην 
θέση που δηλώνει ο νέος αριθµός. 

Σηµείωση: Αν κάνετε διπλό κλικ στην σελίδα, θα την ανοίξετε. 

Για την επαναρίθµηση των σελίδων µέσω του παραθύρου  
διαλόγου Renumber pages: 

1. Επιλέξτε µια ή περισσότερες σελίδες. 

2. Στο µενού Batch, επιλέξτε το στοιχείο Renumber Pages (Επαναρίθµηση 
σελίδων). 
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3. Ορίστε το νέο αριθµό σελίδας για την πρώτη από τις επιλεγµένες σελίδες (τη 
σελίδα µε τον µικρότερο αριθµό). 

Σηµείωση:    

1. Εάν θέλετε να αριθµήσετε ξανά όλες τις σελίδες της δεσµίδας αρχείων, στο 
παράθυρο διαλόγου Renumber Pages, επιλέξτε το στοιχείο All Pages.  

2. Εάν θέλετε να αριθµήσετε ξανά µόνο ένα µέρος της δεσµίδας αρχείων:  

! Στο παράθυρο δεσµίδας επιλέξτε τις σελίδες που θέλετε να αριθµήσετε.  

! Στο παράθυρο διαλόγου Renumber Pages, επιλέξτε το στοιχείο Selected pages.   

3. Εάν θέλετε µια συνεχή αρίθµηση για τις επιλεγµένες σελίδες, επιλέξτε τη ρύθµιση 
Continuous page numbering (Συνεχόµενη αρίθµηση). Για παράδειγµα: αν οι 
αριθµοί των σελίδων είχαν την αρίθµηση 2,5,6, και η εκκίνηση της αρίθµησης είχε 
ορισθεί από το 1. µετά την επαναρίθµηση, οι αριθµοί των σελίδων θα γίνουν 1,2,3. 
Στην περίπτωση που δεν έχετε ορίσει τη ρύθµιση Continuous page numbering, η 
αρίθµηση των σελίδων θα γίνει 1, 4, 5, δηλαδή η πρώτη σελίδα θα πάρει τον 
αριθµό σελίδας που δώσατε, ενώ οι υπόλοιπες θα αριθµηθούν µε τέτοιο τρόπο 
ώστε να διατηρηθούν οι αρχικές διαφορές µεταξύ των αριθµών των σελίδων. 

        Σηµείωση: Αν θελήσετε να αλλάξετε την αρίθµηση σε µερικές µόνο από τις 
σελίδες της δεσµίδας, υπάρχει η πιθανότητα κάποια σελίδα να πρέπει να πάρει 
έναν αριθµό σελίδας το οποίο έχει µια από τις σελίδες που δεν επαναριθµούνται. 
Στην περίπτωση αυτή το FineReader θα εµφανίσει ένα σχετικό µήνυµα και δεν θα 
προβεί στη αλλαγή των αριθµών καµιάς από τις επιλεγµένες σελίδες.  

Αποθήκευση µιας ∆εσµίδας Αρχείων 
Για να σώσετε µια δεσµίδα: 

! Επιλέξτε Save Batch As (Aποθήκευση ∆εσµίδας ως) από το µενού File. 

! Στο παράθυρο διαλόγου Save Batch as ορίστε το όνοµα της δεσµίδας και την 
επιθυµητή θέση στον δίσκο. 

Κλείσιµο µιας Σελίδας ή µιας ∆εσµίδας Αρχείων 

Για να κλείσετε την τρέχουσα σελίδα 

1. Στο µενού Batch, επιλέξτε το στοιχείο Close Current Page (Κλείσιµο της 
Τρέχουσας Σελίδας). 

Για να κλείσετε την ενεργή ∆εσµίδα 

2. Στο µενού File, επιλέξτε το στοιχείο Close Batch (Κλείσιµο ∆εσµίδας). 

Σηµείωση: Η δεσµίδα αρχείων αποθηκεύεται αυτόµατα κατά το κλείσιµο. 
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∆ιαγραφή µιας ∆εσµίδας Αρχείων 
Σηµείωση: Με τη διαγραφή µιας δεσµίδας αρχείων, διαγράφονται όλα τα 
περιεχόµενά της, δηλαδή όλες οι σελίδες (εικόνες και κείµενο) µαζί µε όλα τα 
επιπρόσθετα αρχεία που δηµιουργήσατε κατά τη διάρκεια της εργασίας σας µε τη 
συγκεκριµένη δεσµίδα αρχείων: γλώσσες, υποδείγµατα χρήσης, κ.λπ.. 

Για να διαγράψετε µια ∆εσµίδα: 

!   Στο µενού Batch, επιλέξτε το στοιχείο Delete Batch (∆ιαγραφή ∆εσµίδας) 

Για να διαγράψετε σελίδες µιας ∆ισµίδας: 

1. Στο παράθυρο ∆εσµίδας, επιλέξτε την/τις σελίδα(ες) που επιθυµείτε να 
διαγράψετε. 

2. Στο µενού Batch, επιλέξτε το στοιχείο Delete Page (∆ιαγραφή σελίδων) ή απλά 
πατήστε το πλήκτρο DEL. 

Ρυθµίσεις ∆εσµίδας Αρχείων 
Για να αποθηκεύσετε τις ρυθµίσεις µιας ∆εσµίδας: 

! Κάντε κλικ στο κουµπί Save της καρτέλας General (µενού Tools>Options). Θα 
εµφανιστεί το παράθυρο διαλόγου Save Batch Template As (Αποθήκευση 
Υποδείγµατος ∆εσµίδας ως). 

! ∆ώστε όνοµα αρχείου και πατείστε Save. 

Στο αρχείο που θα δηµιουργηθεί, θα αποθηκευτούν οι ρυθµίσεις απο τις καρτέλες 
Recognition, Scan/Open Image, Formatting και Check Spelling, καθώς και εκείνες 
από το παράθυρο διαλόγου Formats Settings. Στο ίδιο αρχείο θα σωθούν οι ορισµένες 
από τον χρήστη γλώσσες και οµάδες γλωσσών, καθώς και τα υποδείγµατα 
γραµµατοσειρών. Αν ενεργοποιήσετε την επιλογή Apply this template to new batches 
(Εφαρµογή του υποδείγµατος στις νέες δεσµίδες) οι ρυθµίσεις αυτές θα 
εφαρµόζονται αυτόµατα σε κάθε νέα δεσµίδα. 

Για να επιστρέψετε στις προεπιλεγµένες ρυθµίσεις: 

! Κάντε κλικ στο κουµπί Use defaults (Χρήση προεπιλογών) της καρτέλας 
General 

Για να φοτρώσετε τις ρυθµίσεις που αποθηκεύσατε: 

! Κάντε κλικ στο κουµπί Load της καρτέλας General και επιλέξτε το αρχείο τύπου 
FineReader batch template (*.fbt) που περιέχει τις επιθυµητές ρυθµίσεις. 

Αναζήτηση full-text στις αναγνωρισµένες σελίδες της 
∆εσµίδας Αρχείων 

Προσοχή: Χρειάζεστε Internet Explorer 4.0 ή νεότερο για να εκµεταλλευτείτε αυτήν 
την δυνατότητα. 

Το FineReader σας δίνει την δυνατότητα να αναζητήσετε µέσα στο αναγνωρισµένο 
κείµενο για µία ή περισσότερες λέξεις, ανεξάρτητα από την γραµµατική τους µορφή. 
Το αναζητούµενο κείµενο µπορεί να αποτελείται από µία ή περισσότερες λέξεις. Οι 
λέξεις αυτές µπορεί να είναι σε οποιαδήποτε γραµµατική µορφή (για τις 
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προκαθορισµένες γλώσσες που υποστηρίζονται από λεξικό) και µπορεί να εµφανίζονται 
στο αναγνωρισµένο κείµενο µε οποιαδήποτε σειρά και απόσταση µεταξύ τους. 

Για να πραγµατοποιήσετε µια τέτοια αναζήτηση: 

1. Επιλέξτε Advanced search από το µενού Edit ή πατήστε ALT+F3. 

2. Το παράθυρο Αναζήτησης (Search) θα ανοίξει κάτω από το παράθυρο 
Μεγέθυνσης. 

3. Εισάγετε το κείµενο που θέλετε να βρείτε στο πεδίο Find what. Μπορείτε επίσης 
να επικολλήσετε τα περιεχόµενα του Προχείρου ή να επιλέξετε το κείµενο µιας 
προηγούµενης αναζήτησης από την λίστα. 

4. πατήστε το πλήκτρο Find. 

Το παράθυρο Αποτελεσµάτων Αναζήτησης (Search results) θα εµφανιστεί περιέχοντας 
µια λίστα των αριθµών των σελίδων της δεσµίδας, στις οποίες εµφανίζονται ΟΛΕΣ οι 
λέξεις από το πεδίο Find what. Για κάθε µια από τις σελίδες αυτές στο παράθυρο 
εµφανίζονται τα στοιχεία της τελευταίας αλλαγής και το πρώτο τµήµα του κειµένου στο 
οποίο εµφανίζονται οι αναζητούµενες λέξεις (τονισµένες). Κάνοντας κλικ σε έναν 
αριθµό σελίδας, µπορείτε να την ανοίξετε στα παράθυρα Εικόνας, Κειµένου και 
Μεγέθυνσης. Οι αναζητούµενες λέξεις θα εµφανίζονται στα παράθυρα αυτά µε 
διαφορετικό χρώµα φόντου, έτσι ώστε να ξεχωρίζουν. 

Σηµείωση: Όταν κάνετε αναζητήσεις µε τον τρόπο αυτό δεν έχετε την δυνατότητα να 
ψάξετε για ειδικούς χαρακτήρες (όπως η αλλαγή γραµµής ή το τέλος της παραγράφου). 



 89

Κεφάλαιο 10  
∆ικτυακή Επεξεργασία Εγγράφου  

Το ABBYY FineReader Corporate Edition έχει σχεδιαστεί ειδικά για να επιτρέπει την 
δικτυακή συνεργασία για την επεξεργασία των εγγράφων. Ένα ξεχωριστό αντίγραφο 
FineReader θα πρέπει να έχει εγκατεστηµένο σε κάθε υπολογιστή που λαµβάνει µέρος 
στην δικτυακή επεξεργασία. (Το Εγχειρίδιο ∆ιαχειριστή Συστηµάτων (System 
Administrator�s Guide), το οποίο µπορείτε να βρείτε στον σχετικό κατάλογο του 
εξυπηρετητή, όπου έχει εγκατασταθεί το FineReader, παριλαµβάνει πρόσθετες 
πληροφορίες σχετικά µε την εγκατάσταση του FineReader σε σταθµούς εργασίας, την 
χρήση του ∆ιαχειριστή Αδειών (License Manager) καθώς και την χρήση της εφαρµογής 
σε περιβάλλον τοπικού δικτύου). 

Το ΑΒΒΥΥ FineReader Corporate Edition επιτρέπει: 

5. Την ταυτόχρονη εργασία µε την ίδια δεσµίδα µέσω δικτύου 

Η µέθοδος αυτή προσφέρει αυξηµένη απόδοση για µαζική αναγνώριση εγγράφων. 
Είναι δυνατή η παρακολούθηση της διαδικασίας αναγνώρισης (π.χ. ποιος χρήσης 
(user name και computer name) έχει ανοιχτή µια σελίδα, ποιος έκανε την σάρωση 
της σελίδας, ποιος την αναγνώρισε, την διόρθωσε κ.λπ). Οι αλλαγές που κάνει 
ένας χρήστης σε µια σελίδα, είναι διαθέσιµες σε όλους τους χρήστες της δεσµίδας. 

6. Την από κοινού χρήση γλωσσών και λεξικών οριζόµενων από τον χρήστη 

Το ΑΒΒΥΥ FineReader Corporate Edition επιτρέπει στους χρήστες να 
χρησιµοποιούν τις ορισµένες από τον χρήστη γλώσσες και τα λεξικά από κοινού. 
Οι διάφοροι χρήστες µπορούν να προσθέτουν λέξεις στα λεξικά ταυτόχρονα. 

7. Την από κοινού χρήση λεξικών για τις προκαθορισµένες γλώσσες  

Το ΑΒΒΥΥ FineReader παρέχει υποστήριξη λεξικού σε ορισµένες από τις 
γλώσσες που αναγνωρίζει. Τα λεξικά αυτά περιλαµβάνουν τις πιο συχνά χρησιµο-
ποιούµενες λέξεις της εκάστοτε γλώσσας, όµως µπορεί να µην περιλαµβάνουν 
κύρια ονόµατα, τεχνική ορολογία, ακρωνύµια κ.λπ. Για να αυξήσετε την ακρίβεια 
της αναγνώρισης (το FineReader χρησιµοποιεί τα λεξικά για να ελέγχει τις λέξεις 
που αναγνωρίζει) και να επιταχύνετε την διόρθωση του αναγνωρισµένου κειµέ-
νου, µπορείτε να προσθέτετε τις λέξεις αυτές στα αντίστοιχα λεξικά χρήστη των 
προκαθορισµένων γλωσσών. Στο FineReader Corporate Edition είναι δυνατόν 
πολλοί χρήστες να χρησιµοποιούν το ίδιο λεξικό ταυτόχρονα. 

Περιεχόµενα κεφαλαίου: 

! Εργασία µε την ίδια δεσµίδα µέσω δικτύου 

! Οµαδική εργασία µε κοινή χρήση γλωσσών και λεξικών χρήστη 

! Οµαδική εργασία µε κοινή χρήση λεξικών για τις προκαθορισµένες γλώσσες 
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Εργασία µε την ίδια δεσµίδα µέσω δικτύου 
(µονό στο FineReader Corporate Edition) 

1. ∆ηµιουργήστε ή ανοίξτε µια δεσµίδα και ορίστε τις κατάλληλες ρυθµίσεις για την 
σάρωση και την αναγνώριση του κειµένου. 

2. Τρέξτε το FineReader και ανοίξτε τη δεσµίδα αυτή σε όλους τους υπολογιστές 
που θα συµµετάσχουν στην δικτυακή επεξεργασία. 

3. Ενεργοποιήστε την Αναγνώριση στο παρασκήνιο (µενού Process>Start 
background recognition) σε όλους τους σταθµούς που θέλετε να προβαίνουν σε 
αναγνώριση σελίδων. 

4. Ξεκινήστε την σάρωση στον υπολογιστή, ο οποίος διαθέτει σαρωτή µε αυτόµατο 
τροφοδότη. 

Συµβουλή: Αν χρησιµοποιείτε κάποιον σαρωτή υψηλής ταχύτητας, ο οποίος δεν 
υποστηρίζει το πρωτόκολλο TWAIN, µπορείτε να αποθηκεύσετε τις εικόνες των 
σαρωµένων σελίδων, κατευθείαν στον κατάλογο της δεσµίδας του FineReader. Για να 
το επιτύχετε αυτό χρησιµοποιείστε οποιαδήποτε εφαρµογή συνεργάζεται µε τον 
σαρωτή σας και ορίστε τον κατάλογο της δεσµίδας του FineReader ως τον κατάλογο 
αποθήκευσης των εικόνων. Θα πρέπει να φροντίσετε να ονοµατίσετε τις σαρωµένες 
σελίδες µε βάση τον ακόλουθο κανόνα: Τα αρχεία που θα δηµιουργηθούν (µε την σειρά 
που θα σαρωθούν οι σελίδες) να ονοµάζονται 0001.tif, 0002.tif, 
0003.tif… κ.ο.κ. 
Το FineReader θα αντιληφθεί την ύπαρξη των νέων σελίδων και θα τις επεξεργαστεί 
αυτόµατα. 

5. Μπορείτε να επεξεργαστείτε το αναγνωρισµένο κείµενο και να το σώσετε σε 
αρχείο ή να το στείλετε σε κάποια συνεργαζόµενη εφαρµογή από οποιονδήποτε 
υπολογιστή συµµετέχει στην δικτυακή επεξεργασία. 

Μπορείτε να παρακολουθείτε την κατάσταση της κάθε σελίδας της δεσµίδας στο 
αντίστοιχο παράθυρο (π.χ. αν και πότε µια δεδοµένη σελίδα σαρώθηκε, αναγνωρίστηκε, 
διορθώθηκε ή αποθηκεύτηκε και από ποιον χρήστη κ.λπ.). Ολες αυτές οι πληροφορίες 
εµφανίζονται στις αντίστοιχες στήλες στο παράθυρο της δεσµίδας στην κατάσταση 
Details. Για να εµφανίσετε τις λεπτοµέρειες αυτές: 

! Κάντε κλικ στο κουµπί  της Βασικής γραµµής εργαλείων ή 

! Κάντε δεξί κλικ στο παράθυρο δεσµίδας και επιλέξτε View>Details από το µενού 
συντόµευσης. 

Μπορείτε να προσαρµόσετε την εµφάνιση του παραθύρου δεσµίδας, επιλέγοντας τις 
στήλες πληροφοριών που θέλετε να εµφανίζονται και την στήλη µε βάση την οποία θα 
γίνεται η ταξινόµηση των σελίδων. Για να προσαρµόσετε το παράθυρο δεσµίδας: 

! Κάντε δεξί κλικ στο παράθυρο δεσµίδας και επιλέξτε View>Customize από το 
µενού συντόµευσης. Κάντε τις επιθυµητές ρυθµίσεις στην καρτέλα Details του 
παράθυρου διαλόγου Batch View Settings. 

Αν η σελίδες της δεσµίδας είναι διαθέσιµες για επεξεργασία σε πολλούς υπολογιστές, 
το FineReader θα κατανείµει τον φόρτο εργασίας αυτόµατα ανάµεσά τους. Μόλις 
εµφανιστεί  στην δεσµίδα µια νέα σελίδα, το πρώτο διαθέσιµο FineReader, στο οποίο 
τρέχει η αναγνώριση στο παρασκήνιο, θα αναλάβει να την αναγνωρίσει, κλειδώνοντάς 
την για τους υπόλοιπους σταθµούς εργασίας. Μπορείτε να ανανεώσετε τα περιεχόµενα 
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του παραθύρου δεσµίδας πατώντας το πλήκτρο F5 ή επιλέγοντας Batch>Update page 
list. Ταυτόχρονα, οποιοσδήποτε σταθµός εργασίας µπορεί να ανοίξει µια ήδη αναγνω-
ρισµένη σελίδα για έλεγχο, τροποποίηση και αποθήκευση. Οι αλλαγές που γίνονται από 
ένα χρήστη είναι ορατές σε όλους του χρήστες που δουλεύουν στη δεσµίδα. 

Σηµείωση: Η αποδοτικότητα αυτής της προσεγγισης είναι περισσότερο εµφανής σε 
δεσµίδες µε πολλές σελίδες. 

Οµαδική εργασία µε κοινή χρήση γλωσσών και  
λεξικών οριζόµενων από τον χρήστη 
(µονό στο FineReader Corporate Edition) 

∆ηµιουργείστε µια δεσµίδα και ορίστε τις κατάλληλες ρυθµίσεις για την σάρωση και 
την αναγνώριση του κειµένου. 

Οι οριζόµενες από τον χρήστη γλώσσες και τα αντίστοιχα λεξικά που θα συνδέσετε µε 
αυτή την δεσµίδα, θα αποθηκευτούν στον ίδιο κατάλογο, ο οποίος εξ ορισµού 
ταυτίζεται µε τον κατάλογο της δεσµίδας. Προτού δηµιουργήσετε γλώσσες και λεξικά 
οριζόµενα από τον χρήστη θα πρέπει να ορίσετε τον κατάλογο όπου θέλετε να 
αποθηκεύονται αυτές και τα λεξικά τους. 

! πατήστε το πλήκτρο Change στο παράθυρο διαλόγου Language Editor (µενού 
Tools>Language Editor) και επιλέξτε τον επιθυµητό κατάλογο στο παράθυρο 
διαλόγου που θα εµφανιστεί. 

Όλες οι γλώσσες και τα λεξικά που θα ορίσετε στην δεσµίδα, θα αποθηκευτούν στον 
κατάλογο αυτό. 

Αφού ολοκληρώσετε τις ρυθµίσεις, αποθηκεύστε τες σε ένα αρχείο υποδείγµατος 
δεσµίδας (batch template, *.fbt): 

! πατήστε το πλήκτρο Save στην καρτέλα General του παραθύρου διαλόγου 
Options (µενού Tools>Options). Στο παράθυρο διαλόγου Save Batch Template 
as ορίστε τον επιθυµητό κατάλογο και όνοµα αρχείου. 

Για να µπορέσουν πολλοί χρήστες να εργαστούν από κοινού µε τις γλώσσες και τα 
λεξικά τους, θα πρέπει ο καθένας από αυτούς, κατά την διάρκεια της δηµιουργίας µιας 
νέας δεσµίδας, να φορτώσει τις ρυθµίσεις από το αρχείο υποδείγµατος (*.fbt) που 
αποθηκεύσατε στο προηγούµενο βήµα. 

Αυτό γίνεται ως εξής: 

Στο πεδίο Template επιλέξτε Batch template (.fbt). Στο παράθυρο διαλόγου Open 
Batch Template (Ανοιγµα υποδείγµατος δεσµίδας) επιλέξτε το κατάλληλο αρχείο 
fbt. Από το αρχείο αυτό θα ενηµερωθούν όλες οι ρυθµίσεις της δεσµίδας και µαζί µε 
αυτές η θέση των γλωσσών και λεξικών χρήστη. Με τον τρόπο αυτό όλοι οι χρήστες θα 
χρησιµοποιούν τις ίδιες γλώσσες και λεξικά. 

Η από κοινού χρήση γλωσσών οριζόµενων από τον χρήστη για την αναγνώριση και τον 
έλεγχο των δεσµίδων, επιτρέπει την τροποποίηση (επέκταση) των λεξικών τους. Οι 
αλλαγές που γίνονται από έναν χρήστη είναι ορατές σε όλους τους χρήστες που 
εργάζονται στον ίδιο κατάλογο. Όλες οι γλώσσες, οι οποίες θα δηµιουργηθούν στον 
κατάλογο αυτό θα είναι διαθέσιµες σε όλους τους χρήστες που θα χρησιµοποιήσουν το 
ίδιο υπόδειγµα δεσµίδας. Ο κάθε χρήστης θα µπορεί να δει τις διαθέσιµες οριζόµενες 
από τον χρήστη γλώσσες και τα χαρακτηριστικά τους µέσα από τον Language editor, 
στην οµάδα User-defined languages. 
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Το εκάστοτε χρησιµοποιούµενο λεξικό κλειδώνεται προσωρινά όταν κάποιος χρήστης 
προσθέτει ή αφαιρεί µια λέξη. Το λεξικό ενηµερώνεται κάθε φορά που ο χρήστης πατά 
το κουµπί Add στο παράθυρο διαλόγου Check Spelling ή οποιοδήποτε κουµπί στο 
παράθυρο διαλόγου View dictionaries. 

Σηµείωση:  

1. Όλοι οι χρήστες που θα χρησιµοποιούν από κοινού τις γλώσσες και τα λεξικά, θα 
πρέπει να έχουν δικαίωµα πρόσβασης για ανάγνωση και εγγραφή στον κατάλογο, 
όπου οι γλώσσες και τα λεξικά θα είναι αποθηκευµένα. 

2. Όταν µια γλώσσα χρησιµοποιείται από πολλούς χρήστες ταυτόχρονα, τότε είναι 
διαθέσιµη "για ανάγνωση µόνο". ∆ηλαδή δεν είναι δυνατόν κάποιος από τους 
χρήστες να αλλάξει τα χαρακτηριστικά της. Παρόλα αυτά κάθε χρήστης έχει την 
δυνατότητα αφαιρεί ή να προσθέτει λέξεις στο λεξικό της γλώσσας αυτής. 

Οµαδική εργασία µε κοινή χρήση λεξικών  
για τις προκαθορισµένες γλώσσες  
(µονό στο FineReader Corporate Edition) 

∆ηµιουργείστε µια δεσµίδα και ορίστε τις κατάλληλες ρυθµίσεις για την σάρωση και 
την αναγνώριση του κειµένου. 

Η προκαθορισµένη θέση αποθήκευσης για τα λεξικά χρήστη για τις προκαθορισµένες 
γλώσσες, που περιλαµβάνουν υποστήριξη λεξικού, είναι ο κατάλογος στον οποίο έχει 
εγκατασταθεί η εφαρµογή (στην περίπτωση των Windows 2000 ο "Documents and 
Settings\[user profile]\Applications Data\ABBYY\FineReader\7.00\UserDictionaries"). 

Για να καταστεί δυνατή η από κοινού χρήση των λεξικών από µια οµάδα χρηστών, θα 
πρέπει τα λεξικά να είναι αποθηκευµένα σε ένα κατάλογο που να είναι προσβάσιµος 
από όλους. Ο κατάλογος αυτός µπορεί να είναι τοπικός ή προσβάσιµος µέσω δικτύου. 
Για να ορίσετε τον φάκελο που θα χρησιµοποιηθεί για την αποθήκευση των λεξικών: 

! Στην καρτέλα Check Spelling του παραθύρου διαλόγου Options (µενού 
Tools>Options) κάντε κλικ στο πλήκτρο Browse και επιλέξτε το επιθυµητό 
κατάλογο. 

Κάθε χρήστης που χρησιµοποιεί τα λεξικά από τον κοινό κατάλογο θα έχει την 
δυνατότητα να επεκτείνει τα λεξικά. Το εκάστοτε χρησιµοποιούµενο λεξικό 
κλειδώνεται προσωρινά όταν κάποιος χρήστης προσθέτει ή αφαιρεί µια λέξη. Το λεξικό 
ενηµερώνεται κάθε φορά που ο χρήστης πατά το κουµπί Add στο παράθυρο διαλόγου 
Check Spelling ή οποιοδήποτε κουµπί στο παράθυρο διαλόγου View dictionaries. Οι 
αλλαγές που γίνονται από έναν χρήστη είναι εµφανείς σε όλους τους χρήστες που 
χρησιµοποιούν από κοινού το λεξικό. 

Σηµείωση: Οι χρήστες που χρησιµοποιούν από κοινού τα λεξικά χρήστη για τις 
προκαθορισµένες γλώσσες, θα πρέπει να έχουν δικαίωµα πρόσβασης για ανάγνωση και 
εγγραφή στον κατάλογο, όπου οι λεξικά θα είναι αποθηκευµένα. 
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Παράρτηµα 1 
Συντοµεύσεις πληκτρολογίου 

 

Μενού File  
Αν θέλετε να: Πατήστε: 

Ανοίξετε µια εικόνα από αρχείο CTRL + O 

Σαρώσετε µια εικόνα CTRL + K 

Σαρώσετε πολλές εικόνες CTRL + SHIFT + K 

Σταµατήσετε την σάρωση  CTRL + T 

∆ηµιουργήσετε µια νέα ∆εσµίδα CTRL + N 

Ανοίξετε µια δεσµίδα CTRL + P 

Αποθήκευση του κειµένου σε αρχείο CTRL + F2 

Αποθήκευση µιας εικόνας σε αρχείο F12 

 

Μενού Edit  
Αν θέλετε να: Πατήστε: 

Αναιρέσετε την τελευταία σας ενέργεια CTRL + Z 

Επαναλάβετε την τελευταία ενέργεια που αναιρέσατε CTRL + Y 

Aποκόψετε την επιλογή σας και να την µεταφέρετε στο πρόχειρο CTRL + X 

Aντιγράψετε την επιλογή σας στο πρόχειρο CTRL + INS ή 
CTRL + C 

Eπικολήσετε τα περιεχόµενα του προχείρου SHIFT + INS ή 
CTRL + V 

∆ιαγράψετε το ενεργό µπλοκ, την τρέχουσα επιλογή σας ή τις 
επιλεγµένες σελίδες 

DEL 

Να επιλέξετε όλο το κείµενο στο παράθυρο Κειµένου, όλες τις 
σελίδες της ∆εσµίδας ή όλα τα µπλοκ στο παράθυρο Εικόνας 

CTRL + A 

Αναζητήσετε κάποιο κείµενο CTRL + F 

Βρείτε το επόµενο σηµείο εµφάνισης του αναζητούµενου 
κειµένου 

F3 

Αναζητήσετε κάποιο κείµενο και να το αντικαταστήσετε. CTRL + H 
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Μενού View  
Αν θέλετε να: Πατήστε: 

Μεγεθύνετε την εικόνα στο παράθυρο Εικόνας CTRL + SHIFT + NUM+ 

Σµικρύνετε την εικόνα στο παράθυρο Εικόνας CTRL + SHIFT + NUM- 

Μεγεθύνετε τα επιλεγµένα µπλοκ CTRL + SHIFT + NUM* 

Εµφανίσετε τις ιδιότητες ενός αντικειµένου  
(π.χ. εικόνα, µπλοκ) 

ATL + ENTER 

 

Μενού Batch  
Αν θέλετε να: Πατήστε: 

Ανοίξετε την επόµενη σελίδα της ∆εσµίδας ALT + Βέλος Κάτω 

Ανοίξετε την προηγούµενη σελίδα της ∆εσµίδας ALT + Βέλος Πάνω 

Ανοίξετε συγκεκριµένη σελίδα της ∆εσµίδας CTRL + G 

Κλείσετε την τρέχουσα σελίδα της ∆εσµίδας CTRL + 4 

 

Μενού Process  
Αν θέλετε να: Πατήστε: 

Σαρώσετε και να αναγνωρίσετε µια εικόνα CTRL + D 

Ανοίξετε από αρχείο και να αναγνωρίσετε µια εικόνα CTRL + SHIFT + D 

Ενεργοποιήσετε τον βοηθό Scan&Read CTRL + W 

Αναλύσετε την µορφή της τρέχουσας σελίδας CTRL + E 

Αναλύσετε την µορφή όλων των σελίδων CTRL + SHIFT + E 

Αναγνωρίσετε την τρέχουσα ή τις επιλεγµένες σελίδες CTRL + R 

Αναγνωρίσετε όλες τις σελίδες της δεσµίδας CTRL + SHIFT + R 

Αναγνωρίσετε τo τρέχον ή τα επιλεγµένα µπλοκ CTRL + SHIFT + B 

 

Μενού Tools  
Αν θέλετε να: Πατήστε: 

Κάνετε ορθογραφικό έλεγχο του αναγνωρισµένου κειµένου F7 

Να µεταβείτε στο επόµενο σφάλµα ή αβέβαιη λέξη F4 

Να µεταβείτε στο προηγούµενο σφάλµα ή αβέβαιη λέξη SHIFT + F4 

∆είτε τα λεξικά CTRL + SHIFT + V 

Εµφανίσετε το παράθυρο Language Editor, απ' όπου µπορείτε 
να δηµιουργήσετε και να επεξεργαστείτε νέες γλώσσες ή 
οµάδες γλωσσών 

CTRL + SHIFT + L 

Εµφανίσετε το παράθυρο Pattern Editor, απ' όπου µπορείτε να 
δηµιουργήσετε και να επεξεργαστείτε υποδείγµατα γραµµα-
τοσειρών. 

CTRL + SHIFT + L 
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Ορίσετε τις παραµέτρους σάρωσης CTRL + SHIFT + S 

Εµφανίσετε το παράθυρο Format Settings, απ' όπου µπορείτε 
να ορίσετε τον τρόπο αποθήκευσης του αναγνωρισµένου κει-
µένου στους υποστηριζόµενους τύπους αρχείων 

CTRL + SHIFT + X 

Εµφανίσετε το παράθυρο Options CTRL + SHIFT + O 

 

Μενού Window  
Αν θέλετε να: Πατήστε: 

Ανοίξετε το επόµενο παράθυρο CTRL + F6 

Ανοίξετε το προηγούµενο παράθυρο CTRL + SHIFT + F6 

Ανοίξετε το παράθυρο ∆εσµίδας ALT + 1 

Ανοίξετε το παράθυρο Εικόνας ALT + 2 

Ανοίξετε το παράθυρο Κειµένου ALT + 3 

Ανοίξετε το παράθυρο Μεγέθυνσης ALT + 4 

Μεταβείτε στο παράθυρο Προχωρηµένης Αναζήτησης ALT + 5 

Ανοίξετε το παράθυρο Προχωρηµένης Αναζήτησης ALT + F3 

 

Μενού Help  
Αν θέλετε να: Πατήστε: 

Εµφανίσετε την ηλεκτρονική βοήθεια F1 

 

Γενικά  
Αν θέλετε να: Πατήστε: 

Κάνετε το επιλεγµένο κείµενο να εµφανίζεται µε έντονη 
γραφή 

CTRL + B 

Κάνετε το επιλεγµένο κείµενο να εµφανίζεται µε πλάγια 
γραφή 

CTRL + I 

Κάνετε το επιλεγµένο κείµενο να εµφανίζεται 
υπογραµµισµένο 

CTRL + U 

Μετακινηθείτε σε γειτονικά κελιά ενός πίνακα Το αντίστοιχο βέλος 

 

 


